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A quick tour of what's new in ArcGIS 10
ArcGIS 10 includes a redesign of the ArcGIS Desktop interface and additional and improved functionality
throughout the ArcGIS product line.

The following sections summarize changes in the software in different functional areas. Each section includes
links to topics with more information for that specific area of the software.

Note: Click here to download a PDF version of What's new in ArcGIS 10

ArcGIS Desktop administration

It is easier to deploy and administer ArcGIS Desktop at 10:

• You can borrow ArcGIS Desktop 10 licenses for temporary use away from the office (for example,
when working in the field, working from home, or traveling for business). See Borrowing and
returning concurrent use licenses for more information.

• You can now authorize licenses through the license manager via the Web so you no longer need to
request a license file based on a hardware key or MAC address from ESRI Customer Service. See
License Manager installation and startup for more information.

• Other License Manager enhancements include the ability to install License Manager to any location
on your system and the ability to transfer licenses directly from license server to another. See
Transferring licenses from one license manager to another for more information.

Documentation

An updated ArcGIS Resource Center brings together all the online resources, such as help systems,
samples, templates, blogs, forums, and technical articles for ArcGIS, in one convenient place:
http://resources.arcgis.com.

Product documentation is reorganized and improved:

• Over 75 percent of the help has been rewritten and updated.

• Topics have been organized based on skill sets. The Essentials library contains core GIS and
ArcGIS concepts. The Professional library contains information about software functionality, how to
use it, and more advanced GIS concepts. The Administrator library contains information for people
who install software, manage licensing, and administer servers and databases.

• The ArcGIS tutorials are now presented as topics in the help instead of separate PDFs. See ArcGIS
tutorials.

• The installed help files take up less space on your computer.

Data management

Geodatabases

The following is a summary of new functionality available in geodatabases: See What's new for
geodatabases in ArcGIS 10 for more information.
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• Upgrade personal, file, and all ArcSDE geodatabases using the Upgrade Geodatabase
geoprocessing tool or Python script.

• The geodatabase schema has been restructured to consolidate the information in the
geodatabase system tables into six tables.

• New options have been added to the Create Personal GDB and Create File GDB geoprocessing
tools to allow you to create an older version geodatabase from an ArcGIS 10 client.

• Six new topology rules are available.

• The New Geometric Network wizard has been streamlined and redesigned.

• A new command has been added to load features into a geometric network in an effective way.

• New functionality in ArcMap allows you to define a spatial query against SQL spatial types in a
spatial database to create a layer (query layer) that can be viewed and queried in ArcMap.

• One-way replicas can now use archiving instead of versioning to keep track of replica changes.
When archiving is used to track replica changes, no system versions are created. This simplifies
replica management.

• Support has been added for one-way, child-to-parent replicas. This type of replica allows you to
edit the data in the child replica and synchronize it with the parent replica.

• File geodatabases have three new keywords—GEOMETRY_OUTOFLINE, BLOB_OUTOFLINE,
and GEOMETRY_AND_BLOB_OUTOFLINE— which allow more control over feature class
storage when dealing with complex geometries and large BLOB attributes. This can result in
improved performance, especially when using terrain datasets.

• The sdemon ArcSDE administration command has been augmented to disconnect or block direct
connections to the geodatabase.

• ArcGIS Desktop, ArcGIS Engine, and ArcGIS Server contain the drivers necessary to create a
direct connection to a 9.2 or 9.3 geodatabase. Note that connections from older ArcGIS clients to
ArcGIS 10 geodatabases are not supported.

• ArcGIS Desktop, ArcReader, and ArcGIS Server install the Microsoft SQL Server 2008 Native
Client to allow you to make direct connections to geodatabases in SQL Server. The SQL Server
2008 Native Client is also included on the ArcGIS Engine media as a separate executable.

• Vertical lines can be stored in z-enabled feature classes.

• A new SQL raster type (ST_Raster) can be installed in ArcSDE geodatabases in Oracle,
PostgreSQL, and SQL Server. You can use this storage type with ArcGIS and SQL clients.

• The Migrate Storage geoprocessing tool has been augmented to support moving raster data to
the ST_Raster type and binary spatial data to geometry or geography types in SQL Server.

• The ST_Geometry type in Oracle and PostgreSQL supports storage of parametric circles and
ellipses when created using SQL or the ArcSDE API.

• Support has been added through the ArcSDE API to use native XML columns in geodatabases in
IBM DB2, Oracle 11g, PostgreSQL, and SQL Server. You can also define an XML schema on
these native XML columns in DB2, Oracle, and SQL Server.
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• Support has been added for varbinary(max) and datetime2 columns in geodatabases in SQL
Server. (Datetime2 is available only in SQL Server 2008.)

Editing

The editing experience has been improved and simplified in the following ways:

• The Editor toolbar has been redesigned.

• It is easier to add new features through the use of feature templates, which define all the
information needed to create a feature.

• The Editor toolbar and new Create Features window provide centralized access to feature
templates and tools used to construct features.

• The snapping environment has been redesigned, making it easier to manage.

• New pop-up mini toolbars provide quick access to editing tools when you create and edit features.

• Starting an edit session is easier and the experience has been enhanced. You can now start
editing by right-clicking a layer or table from the table of contents. In addition, when you start
editing and ArcMap encounters errors or has performance suggestions, you see a list of the
issues with information about how to fix them.

• The Attributes, Edit Sketch Properties, and other editing windows have been redesigned. For
example, the Attributes window displays features using the layer's field properties, such as field
aliases, and respects field ordering and visibility settings.

• Selecting features and editing vertices and segments of existing features has been made easier.
You can select, add, and remove multiple vertices by drawing a box on the map.

• It is easier to create and edit annotation and dimension features.

• The parcel editing experience has been improved.

See What's new for editing in ArcGIS 10 for more information.

Parcel editing

A new Parcel Editor has been introduced with ArcGIS 10. The Parcel Editor toolbar, which is available
with an ArcEditor or ArcInfo license, replaces the Survey Analyst Cadastral Editor product.

The previous cadastral fabric dataset has also been replaced by the new parcel fabric.

Parcel fabrics have many features that make editing and maintaining parcel databases more efficient.
Parcel fabrics can be created in ArcCatalog inside any feature dataset. Existing 9.2 and 9.3 cadastral
fabrics can be upgraded to a parcel fabric through the Upgrade Parcel Fabric geoprocessing tool or a
Python script.

Some of the functionality available with Parcel Editor includes the following:

• The Parcel Editor toolbar includes a drop-down menu that integrates the Editing commands and
has some new items, including Plan Directory and Fabric Options.

• The Parcel Construction toolbar, available with Cadastral Editor in previous releases, has been
integrated into the Parcel Details window.
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• The Parcel Details window includes new features, such as Save and Join, Build Parcel and Join,
Line String, Intersection, and Parcel Editing context menu.

• The Parcel Editing context menu includes Bearing; Distance; Delta X,Y; Bearing/Distance;
Tangent Curve; Parallel to Line; Perpendicular to Line; and Deflection Off Line.

• The Parcel Details window has a new column on the Lines tab that allows you to specify different
templates for individual lines when creating a new parcel or during construction.

• The Parcel Division tool allows you to split existing parcels inside a parcel fabric into new parcels
using certain rules.

• The Parcel Remainder tool allows you to cut a new parcel into an existing parcel in the parcel
fabric. This handles legal descriptions that exclude only a portion of a larger parcel.

• Parcel Editor has a merge mechanism that allows you to use existing attributes from other parcels
for a transfer and specify certain line types for the resultant merged line.

See What's new for editing in ArcGIS 10, and scroll to the bottom for more information.

Raster data

The following is a summary of new raster data functionality. See What's new for rasters in ArcGIS 10 for
more information.

• All raster formats at 10 use the GDAL library. This GDAL support enables ArcGIS to read and
write more raster formats. There are also more TIFF compressions available when creating a TIFF
file.

• All new pyramids are saved as OVR files (with the exception of the ERDAS IMAGINE format).
OVR files are more flexible since they work with all file formats that allow pyramids. As well, the
OVR files can be compressed so that they do not take up as much disk space.

• Raster Storage environment settings have been added to ArcGIS.

• A new raster data model—mosaic datasets—has been introduced. The mosaic dataset is
supported in all types of geodatabases (personal, file, and ArcSDE). To serve a mosaic dataset
using ArcGIS Server requires the Image extension license.

• New functions allow you to perform on-the-fly processing to your mosaic datasets and on raster
dataset layers (in some cases). Functions can be chained together, allowing you to add multiple
processes to your mosaic dataset or raster dataset layer.

• New geoprocessing tools are available for raster data, including the Split Raster tool and the
Recursive Pyramids And Statistics tool.

• Two new environment settings are available for the Raster Storage options in geoprocessing
tools: pyramid compression type and more TIFF compression types.

• You can create a custom color scheme, within the Unique Values Renderer dialog box, and save
it to a CLR file. Once you have a CLR file, you can use it with the Add Colormap geoprocessing
tool to add the color scheme to your raster dataset.

• The stretched renderer now has the option to perform advanced labeling. This allows you to
specify values on the color ramp that you want to display. In addition, you can set up an advanced
color ramp between each of the specified values.
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• There are now four tabs on the Raster Options dialog box: Raster Dataset, Raster Catalog, Raster
Layer, and Mosaic Dataset.

• The Image Analysis window is a new dockable window that can be used to quickly perform many
display and processing raster tasks. It can be added to ArcMap via the Image Analysis command
on the Window menu. Many of the display options that exist in ArcMap are consolidated so they
can be accessed quickly in this window: contrast, brightness, transparency, gamma stretch,
dynamic range adjustment, ignore background value, nadir top-up, contrast stretch, display
resampling method, zoom to raster resolution, swipe layer, and flicker layer.

• A Color Correction tab has been added, which provides additional color correction options for your
raster catalogs. Some of the new parameters available to you include prestretching, more color
balancing methods, the ability to specify a color balancing target surface type, and the ability to
specify a color balancing reference target image.

• The Mosaic Color Correction window allows you to perform color correction of mosaic datasets.
Options to color balance your mosaic dataset include the Exclude Areas option, which can be
especially helpful for areas that are difficult to color balance, such as water or clouds.

• The Mosaic Color Correction window button can be added to any toolbar when in customize
mode.

Tables and attributes

In ArcGIS 10, there is a new experience for working with attribute tables and a number of new features.

• A Table window has been added that displays all open attribute tables. Click the tab for a specific
table to make it active. You can drag a tabbed table and dock it in the Table window to view
multiple tables at the same time.

• The Table window includes a toolbar that lets you interact with the attributes and map.

• You can validate a join before it is created by validating the join field names and values and
determining the count of successfully joined records.

• The field calculator has been enhanced to work with Python scripting.

• A new command has been added to the Table Options menu to restore the field order in a table to
its original ordering.

• Features now support file attachments, which provide a flexible way to store additional information
in any format related to your features. For example, if you have a feature representing a building,
you could use attachments to add multiple photographs of the building taken from several angles,
along with PDF files containing the building's deed and tax information.

• New options to highlight fields and designate fields to be read-only have been added to the Field
Properties and Layer Properties dialog boxes.

• The Layer Properties dialog box Fields tab gives you more control over how fields appear
throughout the desktop applications including the ordering of fields, field highlighting, and the
ability to set fields as read-only.
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• A new display expression property on the Layer Properties dialog box Display tab replaces the
primary display field. The display expression can include values from multiple fields, along with
static text.

• The Identify window is now dockable.

• You can use VBScript for advanced logic with fields used for hyperlinks.

See What's new for tables and attributes in ArcGIS 10 for more information.

CAD

The following is a summary of the changes in CAD functionality. See What's new for CAD integration in
ArcGIS 10 for more information.

• Context menus now enable right-click conversion of CAD feature layers to a geodatabase and
automatically add them to your map.

• A new tool—CAD To Geodatabase—allows you to bulk load CAD data from the Catalog window.
The CAD To Geodatabase tool automates a series of conversion procedures that include
importing CAD annotation and merging identical feature class names, types, and attribution. The
feature classes are automatically added to the map when running the tool from the Catalog
window in ArcMap.

• Nonessential fields (those not required for rendering or query operations) are now turned off by
default in ArcMap feature class attribute tables.

• Spline geometry is now supported.

• The CAD drawing dataset has been removed from display in the Catalog window.

• ArcGIS 10 deprecates the following CAD geoprocessing tools but will continue to support them in
existing models and scripts: Import From CAD, Set CAD Alias, and Create CAD Xdata.

Metadata

• All the items in your catalog now have a simple, standardized core set of metadata properties,
called the item description, comprising a title, a summary, a description, tags, credits, and a
preview thumbnail. You can drill into this to find out more about your data in the Catalog window
and Search window and access more detailed metadata.

• A new Metadata Editor dialog box has been introduced.

• Tasks for managing metadata can now be accomplished using new geoprocessing tools:
Importing Metadata and Exporting Metadata.

• You can now validate metadata based on a metadata standard's XML schema.

See What's new for metadata in ArcGIS 10.

Map projections and coordinate systems

New coordinate systems and transformations have been added, including the following:

• Definitions from the EPSG Geodetic Parameter Dataset versions 6.15 through 7.1, including 181
geographic (datum) transformations and over 280 coordinate systems
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• Support for the Berghaus Star projection

Mapping and visualization

There have been numerous changes in the area of mapping and visualization. The following three sections
are a summary of the general changes in ArcMap. Most of these also apply to the other desktop applications
(ArcCatalog, ArcGlobe, and ArcScene). These sections are followed by sections on specific mapping and
visualization functionality.

ArcMap basics

• The organization of menus and toolbars has been improved, and the icons have been updated.

• It's easy to access great-looking basemaps for your map via the new File > Add Data > Add
Basemap command. You no longer need to obtain a free license from Esri to use the Bing Maps
basemaps.

• New dockable window controls make it easy to arrange and organize your display. You can
arrange the various windows you work with in any way you want including stacking them together
as tabs or autohiding (unpinning) them so you can fly them out just when you need them.

• More windows are dockable in 10, including table windows, the Identify window, and the Attributes
window.

• The table of contents now has buttons along the top instead of tabs along the bottom. A
completely new view of your layers has been added: List by visibility.

See What's new in ArcMap 10 basics.

Accessing your data

• You can access and manage your data through the new Catalog window that is built into the
desktop applications (ArcMap, ArcGlobe, and ArcScene).

• It's easy to access the project workspace your map belongs to through the Catalog window and
new Home button that has been added into dialog boxes.

• You can specify the default geodatabase you want your map to use and get to that geodatabase
with one click in the Catalog window and dialog boxes.

• The new Search window in the desktop applications (ArcMap, ArcGlobe, ArcScene, and
ArcCatalog) lets you instantly search for maps, data, and tools. You can search local data,
enterprise drives and geodatabases, enterprise search services (entire catalogs served using
ArcGIS Server 10), and ArcGIS Online.

• All the items in your catalog now have a simple, standardized core set of metadata properties
called the item description. You can drill into this to find out more about your data in the Catalog
window and Search window.

See What's new for accessing your data in ArcGIS 10.
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Sharing maps and data

• ArcGIS Online has been extended so that you can access maps and data not just from Esri but
also from the GIS community at large. You can upload your data into ArcGIS Online and make it
accessible by anyone using ArcGIS Desktop or the ArcGIS Explorer desktop application or by the
members of private groups that you designate.

• You can access ArcGIS Online and manage data that you upload to it from inside ArcMap with the
new File > ArcGIS Online command. You can also work with ArcGIS Online via a Web browser
with the new ArcGIS.com Web site.

• The new File > Add Data > Add Data From ArcGIS Online command in ArcMap lets you easily
search or browse ArcGIS Online for data that can be added into your map document as a layer.

• The Create Layer Package command in ArcMap has been enhanced so that you can validate
your layer before you package it and upload the layer package directly into ArcGIS Online.

• New map packaging capability lets you share complete map documents with others. A map
package contains a map document (.mxd) file and the data referenced by the layers it contains
packaged into one convenient, portable map package (.mpk) file.

• The new ArcGIS.com Web site enables anyone to create a Web map containing one or more map
services and share the map with others as part of ArcGIS Online. These Web map mashups can
be created using the built-in map in ArcGIS.com or the new Silverlight-based ArcGIS Explorer
Online program. No ArcGIS software needs to be installed to make a Web map. ArcGIS Online
Web maps can be opened directly in ArcMap, in which they appear as new map documents.

See What's new for sharing maps and data in ArcGIS 10.

Symbols and styles

The following is a summary of new functionality for symbols and styles. See What's new for symbols and
styles in ArcGIS 10 for more information.

• Finding appropriate symbols to apply to your features and graphics is easy in ArcGIS 10 because
you can search for symbols without knowing in which style files they are stored. You can search
from within all the styles that are installed with ArcGIS, or you can limit search results by
referencing just the styles with which you want to work.

• Each symbol now has searchable tags that describe its graphic characteristics, such as its color
or type. These tags can be modified on the Style Manager dialog box.

• You can add or modify symbol tags from the report view of the Style Manager dialog box.

• The Style Manager dialog box is now accessible directly from the Customize window and is
resizable.

• The report view has an additional column when a symbol (marker, line, fill, or text) table is
selected, allowing you to view the tags of each symbol and modify them if the style is not read-
only.

• You can arrange the way that symbols are organized in the symbol selector. For example, you
can group symbols by the style file in which they are contained or by their category. You can

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 11

http://links.esri.com/arcgis
http://links.esri.com/arcgis
http://explorer.arcgis.com
http://explorer.arcgis.com


emphasize the appearance or the title of a symbol by clicking the Large Icon or List button,
respectively.

• Pausing the pointer on a symbol in the Symbol Selector window opens a pop-up that lists relevant
information for each symbol.

• You can resize the Symbol Selector window to see more symbols at once.

Map display and navigation

The following is new functionality for map display and navigation. See What's new for map display and
navigation in ArcGIS 10 for more information.

• Basemap layers have been added, which allow navigation of the map without having to wait for
the map to redraw.

• A QuickPan mode has been added, which allows continuous panning in any direction, even while
digitizing features.

• The Scale Settings dialog box now allows limiting map display to certain scale levels.

• Scale settings contain presets for common Web map schemas.

• One tab in the application Options dialog box manages the display cache for cached map
services, basemap layers, and the ArcGlobe globe cache.

• Hardware acceleration allows smoother refresh on pan and zoom operations for basemap layers.

• The Data View tab of the ArcMap Options dialog box has settings to easily enable or disable
hardware acceleration and control basemap layer drawing behavior when in remote desktop
sessions.

• You can use the modifier keys CTRL and SHIFT to change navigation speed with QuickPan and
the arrow keys.

• You can enable QuickPan mode with the Q key or by holding down the middle mouse button.

• Fewer redraws are done as you work with ArcMap because the map no longer completely
redraws to fit when you resize the display.

Representations

The following summarizes new functionality for cartographic representations. See What's new for
representations in ArcGIS 10 for more information.

• Two new geometric effects have been added:
▪ Jog Effect—Creates a dynamic line with a jog of specified angle, position, and width in the

line

▪ Arrow Effect—Creates a dynamic line along a line feature with an arrow of a specified
style and width

• User interface enhancements have been made to the representation renderer, Move tool's context
menu, and Set Size context menu in Marker Editor:

▪ The representation renderer now displays a value for the number of features assigned a
rule in the representation class. This appears in the dialog box as Show Feature Count
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and is specific to individual representation classes. This setting remains in place until the
dialog box is closed.

▪ The Move tool's context menu provides additional options for specifying a distance to
move selected feature(s). The Distance parameters are available to control a movement
that is not strictly horizontal or vertical.

▪ The Set Size context menu in Marker Editor provides more options to refine size change
of selected elements.

▪ A position property has been added to the Dashes geometric effect and the Along Line,
Randomly Along Line, Along Outline, and Randomly Along Outline marker placement
styles. The position property allows you to indicate where a pattern should begin to be
displayed for a feature. This is especially important for synchronizing the placement of
markers in relation to dashed lines.

• Warning messages have been improved for customization. The message provides the full name
of any missing components in a version 10 geodatabase, such as custom geometric effects and
marker placement styles.

• The experience for feature layers using representations has been improved. When a feature class
with representations is added to the ArcMap table of contents, the layer is automatically
symbolized with the representation renderer. The first representation of the feature class is used
by default when there are multiple representation classes available.

Page layouts and data frames

The following summarizes new functionality for page layouts and data frames. See What's new for page
layouts and data frames in ArcGIS 10 for more information.

• Data Driven Pages give you the ability to create map books and multiple page products by taking
a single layout and iterating over a set of feature extents.

• Dynamic text enhances the layout text element to automatically update using system, map, or
Data Driven Pages properties.

• Data frame property enhancements have been made to support Data Driven Pages workflows.

Automating map workflows

• Geoprocessing has been extended so that you can now manipulate maps, layouts, and layers
through Python scripting. This makes it possible to automate many of your common mapping
workflows.

• Through Python, you are also able to interact with map documents in batch, which allows you to
perform a wide variety of map and layer management tasks.

See What's new for automating map workflows in ArcGIS 10 for more information.

Temporal data

ArcGIS 10 has a new experience and tools for working with temporal data.
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• Layers have a new property page for setting the location and description of temporal information
from the source dataset.

• ArcGIS Desktop and ArcGIS Server are time aware and contain time slider user interface controls
to visualize temporal data.

• Layers authored with time information can be published using ArcGIS Server and consumed by
client applications (SOAP/REST APIs).

See What's new for temporal data in ArcGIS 10 for more information.

Animations

At ArcGIS 10, you can export animations as sequential images (a series of animation stills). Supported
output image formats are Windows bitmap (*.bmp) and JPEG (*.jpg).

The resultant sequential images can be used as input frames to create videos (AVI or QuickTime format)
using the Raster To Video geoprocessing tool. Also, you can use the output images in other video formats
(not supported in ArcGIS) in third-party video creation software.

See What's new for animation in ArcGIS 10 for more information.

Selection tools

Four new selection tools are available in ArcGIS Desktop: Select By Polygon, Select By Lasso, Select By
Circle, and Select By Line.

The selection tools also respect the new snapping environment.

See What's new for selections in ArcGIS 10 for more information.

Graphs

The following functionality is new for graphs:

• Graphs are available in ArcGlobe and ArcScene.

• Three new graph types are now supported: Bubble graph, Bar Min and Max graph, and Polar
graph.

• New geoprocessing tools, Make Graph and Save Graph, have been added. These tools allow you
to create and save graphs so you can visualize output data or analysis results of a model or
workflow.

See What's new for graphs in ArcGIS 10 for more information.

Reports

There are several new reporting tools available:

• A Reports menu, which is accessed from the View menu on the main menu bar

• The Report Wizard, which steps you through creating a report

• The Report Viewer, which allows you to preview your report

• The Report Designer, which allows you to modify the properties of an existing report
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See What's new for reports in ArcGIS 10 for more information.

Other

• ArcGIS has a preconfigured snapping environment that is used by the Editor and Measure tools.
You can snap to points, edits, intersections, midpoints, or sketches. See About snapping for more
information.

• The Measure tool in ArcMap has new options that let you specify the measurement type when you
measure distances. The options are Planar (the default when working in a projected coordinate
system), Geodesic (the default when working in a geographic coordinate system), Loxodrome,
and Great Elliptic. See Measuring distances and areas for more information.

Geoprocessing and analysis

There have been many changes in geoprocessing. The following sections provide a summary of changes
and new functionality. For more information, see the "What's new in geoprocessing" book in the help. To get
started, see What's new for geoprocessing in ArcGIS 10.

General

• Geoprocessing tools now execute in the background, letting you continue working with ArcMap
while the tool executes.

• ArcToolbox functionality has been replaced by the Search window, the Catalog window, and the
Results window. The ArcToolbox window is still available in 10 but is no longer considered your
primary method for finding and using tools.

• A new Geoprocessing menu has been introduced to the Standard toolbar. This menu contains all
the options for configuring geoprocessing as well as six tools.

• You can now add tools to any menu or toolbar.

Python and ArcPy

• ArcGIS installs Python version 2.6.

• The Python window replaces the Command Line window. You can execute tools in command line
style in the Python window, as you did in the previous Command Line window. However, you can
do much more with the Python window than you could with the Command Line window. You can
execute any Python code within the Python window, not just geoprocessing tools.

• The ArcPy site package is installed with ArcGIS. A site package is Python's term for a library that
adds additional functions to Python. The ArcPy site package replaces arcgisscripting in your
Python code.

• ArcPy contains several important modules, including the mapping module for interacting with
ArcMap and creating map books, the Spatial Analyst module for performing map algebra, and the
Geostatistical Analyst module, which contains classes for setting up complex neighborhood
searches.
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Tools

• Seven model-only tools have been added. These tools only work in ModelBuilder. They are
Calculate Value, Collect Values, Get Field Value, Merge Branch, Parse Path, Select Data, and
Stop.

• More than 50 core geoprocessing tools have been added.

• You can protect your models and scripts with a password. This prevents recipients from editing
your model and script tool while allowing them to run it and subsequently delete it. A password-
protected model cannot be viewed. When copying it, the password protection stays intact.

• You can import your *.py file into the tool (in fact, you must do this to password protect a script
tool). This means you don't have to deliver a separate *.py file for your script tool to work. Once
the *.py file is imported, you can export it again (provided you know the password, if any).

ModelBuilder

• The ModelBuilder toolbar and menu have been updated.

• Undo and redo are now supported.

• Model elements now have ToolTips.

• The default spacing between elements has changed from 30 to 15.

Iterators

• Iterators replace the series option in Model Properties.

• Twelve iterators have been added to be used for iteration or for repetitive tasks in a model. Ten of
these iterators are implemented as geoprocessing tools.

• Using an iterator in a model disables the 9.3 iteration options in Model Properties and sets a
default value of -1, which means that the model runs an unlimited number of times or based on
the number of inputs in an iterator, not on a set number.

• If a model containing an iterator is exported to a Python script, the script does not include the
iteration logic.

Desktop application development

ArcGIS Software Developer Kits

ArcGIS 10 introduces several new and innovative features that make it easier for developers to customize
and extend ArcGIS applications. The new Desktop Add‐in Model provides developers with a declaratively
based framework for creating custom functionality. These add‐in files can then be shared between users
without relying on installation programs or COM registration. Add‐in files can be installed by copying them
to a shared folder and uninstalled by deleting them from this folder. Add‐ins offer a subset of the most
common customizations: buttons, tools, combo boxes, toolbars/menus, dockable windows, and
extensions for the application and editor.

See the ArcObjects SDK for Microsoft .NET Framework and the Java platform help on the Resource
Center for details on new functionality for ArcGIS 10.
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Mobile GIS

The following sections outline new functionality in ArcGIS Mobile. See What's new in ArcGIS Mobile for
more information.

Improved usability of the handheld application

• Enhancements have been made for touch screen access with larger, more readable text and
menu options, lists that scroll using gestures, and improved workflows that are more intuitive and
flexible.

• The View Map task has been enhanced with functionality for measuring lines, areas, and features
and support for new types of connected and disconnected basemaps.

• The Collect Features task workflow has been enhanced and streamlined. The GPS data collection
user experience is simplified. It includes a push-button start and stop for averaging GPS positions
while providing the flexibility for you to view the map or GPS status while in the process of
collecting positions. There is a new GPS streaming method for constructing polylines and
polygons that can filter positions by distance or time interval and place the shape at a lateral offset
from the actual captured location.

• Using the Search task, you can now save your search criteria and store them with your project.
The next time you open the project, you can execute your saved search.

• The Synchronize task now has options for automatically posting edits to the server. You can post
changes whenever features are collected or updated, at a set time interval, or when the device is
cradled.

• A new task—View Field Crew—enables field collaboration between field-workers. Using the View
Field Crew task, you can see where other field-workers are on the map to contact them by e-mail,
SMS, or calling them directly.

Expanded application platform support to include touch screen Windows devices

• Support is added on Windows devices and has been optimized for ruggedized touch screen
devices that are often mounted in a vehicle.

• Features unique to the Windows application include an integrated touch screen keyboard, day-
and nighttime skins, and the ability to adjust the brightness of the application itself.

• You can dim basemap layers so that operational map layer content stands out from basemap
content, providing visual contrast between layers.

Open field applications for developers to provide custom workflows

Using .NET and the applications as a framework, you can create new tasks that are specific to your
business workflows for field data management, alter existing Esri tasks to provide additional capabilities,
or extend the application as a whole.
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Simplifying project management using Mobile Project Center

Mobile Project Center is a new application that focuses on creating and managing field projects. You can
do the following with Mobile Project Center:

• Create field projects that are managed within catalogs on a project server.

• Define the contents of your field map, which can contain multiple operational layers or mobile
services provided that their spatial references match.

• Create tasks and extensions using the application framework, then use them in field projects.

GIS on the Web

The following sections provide just a few highlights of new functionality in ArcGIS Server. See What's new in
ArcGIS Server 10 for a more detailed list of enhancements.

General

• The ArcGIS Server for the Microsoft .NET Framework installation has been broken into two setups
to give you more flexibility of which components you install. You can choose to install just the GIS
server and services, just the Web applications administration interface, or both.

• The Server toolbox now contains a toolset for data extraction. These tools help you expose
interactive data downloads through geoprocessing services.

• Server logging has been offloaded to the individual SOC machines for performance. You can also
set a limit on the number of logs created.

• The server can now check idle services for invalid data connections and refresh the connections if
needed. The server also periodically monitors the state of services so that it can recover more
quickly after unplanned downtime.

• ArcGIS Server for the Java Platform includes Map Path Editor for repairing data connections in
map documents (.mxd) and map service definitions (.msd). This is useful in ArcGIS Server on
UNIX/Linux.

Services

• A new feature service allows you to expose geographic features for Web editing.

• A new search service allows others within your enterprise to search and easily add GIS data.

• The geometry service contains many new methods to support Web editing scenarios.

• MSD-based services now support Maplex, cartographic representations, and various new layer
types introduced at ArcGIS 10.

• Map services expose numerous new properties and information from the map document and its
underlying data. These include feature attachments, temporal data, domains, relates, stand-alone
tables, raster fields, and symbology.

• Image services can now be published from the mosaic dataset introduced at ArcGIS 10. Image
services support many new configuration options and allowed operations.
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• Network analysis services support three new solvers: OD cost matrix solver, vehicle routing
problem solver, and location-allocation solver.

• Geocode services support a single-line address format.

• Layers in a WMS service can now be referenced using a name string.

• Various other enhancements have been made to OGC services, particularly with SLD support and
the number of information services exposed from your source GIS data.

Map caching

• Cache tiles can be stored in a compact storage format that is faster to copy and takes less space
on disk.

• A new Mixed image format allows you to put multiple image types into one cache. This makes it
easy to overlay JPEG caches on other layers; tiles with background color can be stored as
partially transparent PNGs.

• Caches can be added directly to ArcMap or ArcGlobe as a raster dataset using the Add Data
button.

• New tools allow importing and exporting cache tiles to and from the cache directory. This makes it
easier to collaboratively build a cache.

• Caching scales better on distributed installations of ArcGIS Server. The server can first create the
tiles in a local directory, then copy them to a shared cache location. Because of the new compact
cache storage format, copying occurs very quickly.

• ArcGlobe and ArcGIS Explorer have been optimized for drawing certain types of 2D caches
quickly.

REST API

• AMF is now a supported output format that can improve display of query and geoprocessing
results when working with the ArcGIS API for Flex.

• Closest facility and service area network analysis is now available through REST.

• Server object extensions (for map services only) are now supported, allowing you to expose
custom-coded ArcObjects logic through REST.

• You can use well-known text to specify coordinate systems, allowing customization of the
coordinate system parameters.

• The REST admin cache can now be cleared programmatically.

Deployment on Amazon EC2

Esri now offers an Amazon Machine Image (AMI) that can be used to deploy ArcGIS Server in the
Amazon Elastic Compute Cloud (EC2). Deploying in the cloud simplifies ArcGIS Server setup and allows
you to quickly scale to the hardware you need.
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Better SharePoint integration

The ArcGIS Server 10 release will be shortly followed by the version 2.0 release of ArcGIS Mapping for
SharePoint. Version 2.0 will include geoprocessing support, ArcGIS.com integration, geocoding
enhancements, support for SharePoint Web Part connections, theming, and GeoRSS layers.

ArcGIS extensions

The following is a summary of new functionality and changes to ArcGIS extensions:

ArcGIS 3D Analyst

The following sections summarize new functionality and changes for the ArcGIS 3D Analyst extension.
See What's new in ArcGIS 3D Analyst 10 or more information.
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General

• The standard editing environment is available inside both ArcGlobe and ArcScene, allowing for
the creation and maintenance of z-aware GIS features.

• Georeferenced, full-motion video layers can be draped on the surface of ArcGlobe.

• Point feature symbology for size and full 3D rotation can be driven directly by feature attributes.

• Three-dimensional styles have been updated to have better names and description tags, which
leads to significantly improved results when using Search from the Symbol Selection dialog box.

• The user experience for setting the two most common 3D properties—Base Heights and
Extrusion—is improved. It is now easier to complete these settings with built-in graphics that
demonstrate the effect of the property change being made.

• The navigation model has been redesigned to simplify navigating the 3D view.

• You can export large images (larger than the desktop) from ArcGlobe and ArcScene.

• Create graphs in ArcGlobe and ArcScene.

• Access layer packages, map services, and globe services directly from ArcGIS Online with the
new File > Add Data > Add Data From ArcGIS Online command in ArcGlobe. This command
launches the new ArcGIS.com Web site and lets you add the key ArcGIS Online basemaps into
your globe. You can also search for additional data published by Esri and the GIS community at
large.

• The Create Layer Package command in ArcGlobe has been enhanced so that you can validate
your layer before you package it and upload the layer package directly into ArcGIS Online. You
can manage data you have uploaded on the new ArcGIS.com Web site.

• Twenty-seven geoprocessing tools have been added:
▪ Add Z Information

▪ Raster To Multipoint

▪ Terrain To Points

▪ Feature To 3D By Attribute

▪ Locate Outliers

▪ Construct Sight Lines

▪ Add Surface Information

▪ Surface Aspect

▪ Surface Contour

▪ Surface Difference

▪ Surface Slope

▪ Difference 3D

▪ Inside 3D

▪ Intersect 3D

▪ Intersect 3D Line With Multipatch
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▪ Is Closed 3D

▪ Near 3D

▪ Union 3D

▪ Change Terrain Resolution Bounds

▪ Skyline

▪ Skyline Barrier

▪ Skyline Graph

▪ Append Terrain Points

▪ Delete Terrain Points

▪ Replace Terrain Points

▪ Copy TIN

▪ LandXML To TIN

Improved display performance

• Faster rendering of 2D map caches in ArcGlobe, reducing the need to create both 2D and 3D
caches for sharing content

• Improved display performance of 3D text through built-in conflict detection to ensure
overlapping text is not displayed

• Improved display performance of textured multipatches through automatic texture management

• Improved display performance of 3D vectors, using OpenGL stencil buffers for surface-hugging
vectors

• Memory allocation settings are stored within the ArcGlobe document, which allows you to
configure each 3D map differently, so it consumes the right amount of memory for the layers
within it.

Analysis of 3D vector features

• Three-dimensional Boolean operators have been added, such as Intersect 3D, Union 3D, and
Inside 3D, which can be used with closed multipatches.

• Geoprocessing tools, such as Skyline and Skyline Barrier, have been added that expose 3D
vector analysis specifically for virtual city workflows.

• Existing geoprocessing tools have been enhanced to work better with 3D. For example, the
Select by Location dialog box uses 3D distances, and multipatch objects can participate in the
Line Of Sight tool.

• You can interactively measure in 3D: distance along a surface, height of 3D object, distance
between two points in 3D, distance from observer (in other words, how far away an object is).

• Support for full 3D connectivity has been added to network datasets.
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Terrain datasets have been expanded

The following functionality has been added for terrain datasets:

• Tighter integration with lidar sources

• Tools for finding data errors

• The ability to run analytic operators directly against terrain datasets

• Importing layer symbology for terrain

• Terrain contour and point renderers

• Terrain point profile graph

• Elevation range classes reset based on current display extent

• Support for anchor points

• Terrain overview optimization

TIN datasets have been expanded

New functionality for TINs includes the following:

• Support has been added for constrained Delaunay, ArcGIS spatial reference, edge tag
persistence, and node source persistence.

• Import layer symbology for TINs.

• A TIN contour renderer has been added.

• Reset elevation range classes based on the current display extent.

ArcGIS Geostatistical Analyst

The following is a summary of new functionality in ArcGIS Geostatistical Analyst. See What's new in
ArcGIS Geostatistical Analyst 10 for more information.

• Eleven geoprocessing tools have been added:
▪ Diffusion Interpolation With Barriers

▪ Kernel Interpolation With Barriers

▪ Create Spatially Balanced Points

▪ Densify Sampling Network

▪ Global Polynomial Interpolation

▪ IDW

▪ Local Polynomial Interpolation

▪ Radial Basis Functions

▪ Extract Values To Table

▪ Cross Validation

▪ Subset Features
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• Improvements have been made to the Geostatistical Analyst wizard:
▪ You can resize windows.

▪ The layout is redesigned and contains new functionality.

▪ Visualization of the semivariogram is improved.

▪ You can turn on and off the dataset and surface preview.

▪ Barrier interpolation methods have been added.

▪ Local polynomial interpolation is enhanced to include a surface of condition numbers, a
surface of prediction errors, and a surface of predictions.

• A new Conditioning measurement error field is added to the Gaussian Geostatistical Simulations
tool.

• Local polynomial interpolation and IDW can now manage very large input datasets. For example,
IDW with roughly 2 billion input points (contained in more than 400,000 multipoints) produced an
output raster of 250 columns by 250 rows in 20 hours.

• All raster formats are supported.

• New at 10 SP1, Kernel Smoothing With Barriers includes the option for a surface of prediction
errors.

ArcScan for ArcGIS

ArcScan uses feature templates with interactive and automatic vectorization. Feature templates are part
of the enhanced editing experience available in ArcGIS 10.

See What's new in ArcScan for ArcGIS 10 for more information.

Maplex for ArcGIS

The following list summarizes new functionality in Maplex. See What's new in Maplex for ArcGIS 10 for
more information.

• Support has been added for read-only map documents that use Maplex. Read-only map
documents retain all the rich Maplex label properties without reverting to the Esri standard label
engine.

• Maplex labeling is supported in an optimized map service. Maps using Maplex can now benefit
from the increased performance from the drawing engine used by optimized map services.

• The Repeat Label parameter has been expanded to allow you to repeat a label within the same
polygon.

• An option has been added to the Boundary Placement style to support labeling polygons along
the side of a boundary that does not have a polygon directly opposite.

• A polygon placement option has been added to support labeling polygons that contain holes.

• Improvements have been made to the overall label placement quality for both contour placement
and river placement.
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ArcGIS Network Analyst

The following is an overview of new functionality in the ArcGIS Network Analyst extension. See What's
new in ArcGIS Network Analyst 10 for more information.

• Network datasets are now 3D enabled, which allows you to model and perform network analyses
on such things as the interior pathways of buildings.

• You can store information about historical traffic. Using historical traffic helps route and vehicle
routing problem analyses produce more accurate travel and arrival times; additionally, it helps find
the best routes based on a specific time of day and day of the week.

• You can use time-dependent restrictions on networks. Similar to historical traffic models that take
into account drive-time costs that vary with time, time-dependent restrictions permit and prohibit
certain network elements based on time of day. Thus, it is possible to model streets that become
one-way during peak travel times to accommodate the major traffic-flow direction or model turns
that are prohibited at certain times of the day.

• You can incrementally rebuild a network. When you create, edit, or delete any feature that
participates in a network dataset, the network needs to be rebuilt to capture the changes.
Previously, the entire network dataset would be rebuilt regardless of how small the changes were.
Now the rebuild process only rebuilds the network in dirty areas, which are areas immediately
surrounding the edited features. This drastically reduces the time it takes to rebuild large
networks.

• You can use the Catalog window in ArcMap to modify the properties of a network dataset.
Therefore, it is no longer necessary to open and close ArcGIS applications to modify the network.

• Two new network geoprocessing tools have been introduced: Upgrade Network and Dissolve
Network.

• A location-allocation solver has been added, which helps you choose facilities based on their
potential interaction with demand points.

• You can create point, line, and polygon barriers. You can also restrict travel through barriers or
use them to temporarily change the cost of the underlying network elements.

• A new option, No U-turn, has been added to the curb approach property. Network locations (such
as a stop on a route or an order on a vehicle routing problem), have a property for curb approach,
which specifies the direction a vehicle may arrive at and depart from the network location. When
the No U-turn option is chosen, a vehicle can approach the network location from either direction,
but when it departs, the vehicle must continue in the same direction it arrived. This is especially
useful when routing large vehicles that can approach the stop from either direction but cannot turn
around there.

• Exclude restricted portions of the network when loading locations. By checking this option, which
is a new property of network analysis layers, you can make sure that network locations are only
placed on traversable portions of the network. This prevents placing network locations on
elements that you cannot reach due to restrictions or barriers.

• The vehicle routing problem lets you add multiple breaks to each route. So instead of only
modeling a driver's lunch break, you can include a morning and afternoon break as well.
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• You no longer need to set a start and end depot for routes in a vehicle routing problem. If a route's
Start Depot property is null when a solution is generated, the route starts from the first assigned
order. Similarly, if the end depot is null, the route ends at the last assigned order. Therefore, in
ArcGIS 10, routes can both start and end at orders.

• There are now server parameter coclasses and server results coclasses, available in SOAP and
the GIS Server API, to work with the vehicle routing problem, location-allocation, and origin-
destination cost matrix.

• REST endpoints for closest facility and service area have been added.

• You can save the results of an analysis on the server and reuse the layer in subsequent requests
to build on existing solutions.

ArcGIS Schematics

At ArcGIS 10, the underlying architecture of schematics has changed. The following summarizes these
changes. See What's new in ArcGIS Schematics 10 for more information.

• Diagrams are now stored as features, which eliminates the need to configure schematic
properties for symbology and labeling.

• Schematic diagrams are locked while they are being edited. This prevents other users from
editing the diagram and possibly overwriting your changes.

• Better management has been implemented for diagrams related to versioned data.

• An UpdateStatus field has been added to diagrams, which allows you to symbolize this field to
see what updates have been made.

• The configuration tool has a new interface.

• A new algorithm is used for geo-compression.

• New standard rules have been added for attributes.

• You can set more than one node as the root of a hierarchical tree.

ArcGIS Spatial Analyst

The following list is a summary of new functionality in the ArcGIS Spatial Analyst extension. See What's
new in ArcGIS Spatial Analyst 10 for more information.

• The new Python map algebra provides a rich and integrated way for performing map algebra. The
expression syntax remains basically the same and offers you the following benefits:

▪ It can be accessed from the integrated Python interactive window or through your own
favorite Python scripting integrated development environment (IDE).

▪ It provides full autocompletion capabilities.

▪ All Spatial Analyst tools are available in the map algebra syntax.

▪ A comprehensive set of mathematical and logical operators is supported.

▪ Individual tools and operators can be strung together to create single complex statements.

▪ Local (per‐cell) expressions have been optimized to increase performance.
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• Python classes are available for certain parameter collections, enabling easier reuse as well as
easier programmatic access to individual parameters. Following is a general list of these classes:

▪ Neighborhoods

▪ Remap tables

▪ Weighted Overlay and Weighted Sum tables

▪ Vertical and Horizontal Factors

▪ Topo To Raster input

▪ Fuzzy membership

• With all the benefits provided by geoprocessing, the limited selection of functionality available on
the previous Spatial Analyst toolbar is removed at ArcGIS 10. The interactive tools (Contour,
Histogram) on the toolbar remain as before. In place of the ArcGIS 9.3 and earlier Raster
Calculator dialog box, map algebra expressions can be entered into the new Raster Calculator
tool or directly in the Python window.

• The Spatial Analyst engine now has native read/write capability. The reduction in processing time
and disk space consumption is made possible by avoiding the creation and internal management
of temporary scratch files.

• Two new interfaces—IRasterAnalysisGlobalEnvironment and IRasterOpBase—are introduced to
allow processing of raster data in Spatial Analyst using ArcObjects without the need to convert to
Esri Grid format.

• Four new Spatial Analyst geoprocessing tools have been added: Extract Multi Values To Points,
Iso Cluster Unsupervised Classification, Fuzzy Membership, and Fuzzy Overlay. In addition, the
Raster Calculator and Zonal Histogram functionality from the previous toolbar are now
implemented as geoprocessing tools.

• The Focal Statistics tool has a new algorithm that significantly improves its performance,
particularly when using large neighborhoods, such as rectangular neighborhoods of 12 x 12 or
larger and circular neighborhoods with a radius of 5 or greater.

• A new toolbar, Image Classification, has been introduced. The functionality includes the following:
▪ Interactive creation and editing of training samples

▪ A Manager dialog box to manage classes and training samples

▪ Three new displays for training sample evaluation: the histograms evaluation window,
scatterplots evaluation window, and statistics window

▪ Existing Spatial Analyst Multivariate tools are accessible through the Image Classification
toolbar

ArcGIS Tracking Analyst

The following list summarizes new functionality in the ArcGIS Tracking Analyst extension. See What's new
in ArcGIS Tracking Analyst 10 for more information.

• A new e-mail alert service action allows you to automatically send a customizable e-mail message
to selected recipients when the trigger conditions are met.
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• A new data modification service action allows you to modify data values in an incoming data
message using custom functions when the trigger conditions of the action are met.

• A new data summary service action allows you to automatically generate data summary reports
for real-time tracking data for a configurable time interval.

• Three new triggers have been added:
▪ The Arriving trigger allows you to execute an action when a tracked object arrives at a

location represented by a polygon.

▪ The Departing trigger allows you to execute an action when a tracked object departs from
a location represented by a polygon.

▪ The Track Crosses trigger allows you to execute an action when a tracked object arrives
at or departs from or appears to cross a location represented by a polygon.

• New display modes for tracking layers have been added. These allow tracking layers to be
noncached or only partially cached.

Industry solutions

Defense

At ArcGIS 10, much of the functionality in the Military Analyst and MOLE extensions is now native to
ArcGIS. Military Analyst and MOLE are still supported, but now you no longer need to download, install,
and learn a separate extension to accomplish your defense and intelligence tasks in ArcGIS.

The following is a summary of the changes in ArcGIS 10 that affect the defense and intelligence
communities. See What's new for defense and intelligence in ArcGIS 10 for more information.

• You can use feature templates to add military features and symbology to your maps.

• A new layer package, MilitaryOverlay, is available.

• Support for the Military Grid Reference System has been expanded.

• Four new geoprocessing tools have been added that can be used with defense data: Bearing
Distance To Line, Table To Ellipse, XY To Line, and Convert Coordinate Notation.

• You can choose four new raster types when loading rasters: CADRG, CIB, DTED, and NITF.

Finding routes

The following functionality is new for finding routes:

• You can now connect to ArcGIS Server and ArcGIS online routing services in the Find Route
dialog box for street routing in ArcMap.

• The free ArcGIS online routing and geocoding services are available for use by default in the Find
Route dialog box, which allows users to get driving directions in ArcMap without needing their own
street data.

• Geodatabase, shapefile, and SDC network datasets are now supported.

See What's new for finding routes in ArcGIS 10 for more information.
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Geocoding

The following are the changes and new functionality for geocoding:

• The Geocoding toolbar in ArcMap includes the new Manage Address Locator list and Address
Input box for single-line address matching.

• The Locations tab on the Find dialog box supports finding locations for addresses, places,
landmarks, or coordinates.

• Default locators are locators that are loaded automatically to a map when ArcMap is started. A
few geocode services from ArcGIS.com and the Military Grid Reference System (MGRS) locator
are available as default locators.

• The geocoding engine has been redesigned to include support for the following features:
▪ Single-line address input

▪ Fewer address locator styles. Address locators can be created with or without zones using
the same locator style.

▪ Addresses with spatial offset and locations in latitude-longitude can be searched.

▪ Customized address styles for Unicode characters can be created for international
geocoding.

• Two new geocoding tools have been added to the Geocoding toolbox: Create Composite Address
Locator and Reverse Geocode.

See What's new for geocoding in ArcGIS 10 for more information.
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What's new for geodatabases in ArcGIS 10
New functionality added to the geodatabase at ArcGIS 10 includes improved management of geodatabases,
the ability to create layers based on queries on spatial tables in spatial databases, support for new data types
in ArcSDE geodatabases, and new one-way replication scenarios.

Geodatabase management

The following improvements were made to help you manage your geodatabase and the connections to it:

Upgrade all types of geodatabases using the Upgrade Geodatabase geoprocessing
tool or Python script

Use the Upgrade Geodatabase geoprocessing tool or Python script to upgrade personal and file
geodatabases as well as ArcSDE geodatabases licensed under ArcGIS Desktop, ArcGIS Engine, ArcGIS
Server Workgroup, or ArcGIS Server Enterprise. (Do not use the ArcSDE Post Installation wizard on
Windows or sdesetup command to upgrade an existing geodatabase; these no longer perform a
geodatabase upgrade.)

The Upgrade Geodatabase tool includes an option to check that certain requirements are met before you
upgrade.

The upgrade process updates existing system tables, functions, procedures, and types and creates new
ones when needed. At ArcGIS 10, the geodatabase system tables have changed. Therefore, upgrading to
the ArcGIS 10 release creates new geodatabase system tables and moves the existing information into
them. The geodatabase upgrades in place; it does not require you to reload your data.

You can access the Upgrade Geodatabase tool from the Database Properties dialog box or directly open
it from the Data Management toolbox.

See A quick tour of geodatabase upgrades to get started.
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Geodatabase system tables have been consolidated

The geodatabase schema has been restructured for the ArcGIS 10 release, consolidating the information
previously stored in the geodatabase system tables into six tables. This is done partly by using XML
columns to store information related to the data in the geodatabase.

All new and upgraded file, personal, and ArcSDE geodatabases will have the new geodatabase schema.

To implement this new schema in an ArcSDE geodatabase, the database must be able to use XML
columns. Additionally, existing ArcSDE geodatabases must be upgraded using the new Upgrade
Geodatabase geoprocessing tool or Python script instead of the Post Installation wizard or the sdesetup
command.

Control the storage of geometry and BLOB columns in file geodatabases

When you create a feature class, raster catalog, or raster dataset in a file geodatabase, you have three
new options when specifying configuration keywords, each of which store the geometry or BLOB columns
out of line. The keywords are GEOMETRY_OUTOFLINE, BLOB_OUTOFLINE, and
GEOMETRY_AND_BLOB_OUTOFLINE.

The three configuration keywords provide control over storing data inline or out of line. Storing data inline
means all the attributes are in the same file or virtual table in the file geodatabase, while storing data out
of line means the attributes are stored in a different file or virtual table.

The new keywords are designed for use with geometry and BLOB attribute types, which have the
potential to store lots of data. For example, if your feature class will contain large BLOB attributes, you
can specify the BLOB_OUTOFLINE keyword when you create the feature class. The BLOB attribute is
only loaded when queried, resulting in better performance.

See Configuration keywords for file geodatabases for more information.

Create an earlier version of a file or personal geodatabase

The Create File GDB and Create Personal GDB geoprocessing tools in the Data Management toolbox
have been augmented to include an optional parameter that allows you to specify which version of the
geodatabase you want to create. You can create a version 10, 9.3, or 9.2 release file or personal
geodatabase. You can also create a version 9.1 release personal geodatabase.

Being able to create an older release geodatabase from an ArcGIS 10 client allows you to more easily
share data with people or agencies who are using older releases of ArcGIS.
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Additional geodatabase replication scenarios are supported

The geodatabase replication model has been improved to include one-way replication using archiving and
one-way child to parent replication.

One-way replication using archiving

The ability to use archiving instead of versioning to keep track of replica changes has been
implemented. This option is only available for one-way replication, and only if the source replica is the
DEFAULT version. When archiving is used to track replica changes, no system versions are created.
Therefore, the reconcile and post and compress processes are not affected, making version
management and replication management independent. This also allows the synchronization schedule
to be more flexible. This is a recommended option for one-way replication, since it increases the
performance of the synchronization process.

See Replica creation and versioning for more information.

One-way child to parent replication

One-way replication allows data changes to be sent multiple times from the parent replica to the child
replica and, starting at ArcGIS 10, from the child replica to the parent replica.

One-way child-to-parent replication works in a manner similar to parent-to-child replication, but in the
opposite direction. Here, the data in the child replica is editable, but the data in the parent is considered
read-only. If edits are performed on the data in the parent replica, the edits are overwritten if they
conflict with edits applied during synchronization.

See Replication types for more information.

Remove and block direct connections to an ArcSDE geodatabase

You can use the sdemon command with the kill operation to drop direct connections to an ArcSDE
geodatabase. In previous releases, the kill operation could only be used to drop ArcSDE service
connections.

In most cases, the functionality of the DBMS is used to drop the direct connection. The database requires
elevated permissions to perform this operation; therefore, the ArcSDE administrator needs additional
permissions granted to drop direct connections. See Removing direct connections from a geodatabase for
more information.

You can also use the sdemon command with the pause operation to prevent both ArcSDE service and
direct connections from being made to a geodatabase.

Situations in which you would want to block new connections to the geodatabase include when you need
to restore the database or upgrade the geodatabase, since no users can be connected when you perform
these tasks. See Preventing users from connecting to a geodatabase for more information.
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Backward-compatible, ArcSDE direct-connect drivers are included with ArcGIS client
applications

You do not have to install backward-compatible, direct-connect drivers in ArcGIS Desktop, ArcGIS
Engine, or ArcGIS Server to access 9.2 or 9.3 geodatabases; the necessary drivers are present by
default.

Connections from older clients to ArcGIS 10 geodatabases are not supported.

The Microsoft SQL Server 2008 Native Client is included with ArcGIS client
applications

To make a direct connection to an ArcSDE geodatabase in SQL Server, the client computer must have
the SQL Server Native Client (SNaC) installed. At ArcGIS 10, the SQL Server 2008 Native Client is
installed with ArcGIS Desktop, ArcReader, and ArcGIS Server to allow you to make direct connections
from these clients to a SQL Server 2005 or SQL Server 2008 database.

ArcGIS Engine includes the SNaC on its installation media so you can install it if you need it.

Data management in geodatabases

Create layers based on SQL queries

A new utility, Query Layers, is available in ArcMap that allows you to create new layers or stand-alone
tables that are defined by SQL queries. The queries you define are executed each time you use or render
the data; therefore, the query returns the data in its current state.

Note: If the query is defined on a versioned feature class in an ArcSDE
geodatabase, the query returns the data in the base table; no information
from the adds or deletes table will be returned.

You can add Query Layers to the map by defining a query against the tables and views in a database.
The result set of that query is then added to ArcMap as a layer or stand-alone table. Map documents
containing query layers can be saved and published to ArcGIS server, making Query Layer information
available to many of the ArcGIS Server APIs.

Query layers are read only; you can display the data, but editing through Query Layers is not supported.

Query layers behave like any other feature layer or stand-alone table, so they can be used to display data,
as input into a geoprocessing tool, or accessed programmatically using developer APIs.

After a Query Layer has been created, it can be saved as a layer file (.lyr) or used to create a layer
package (.lpk). This makes it easy to share Query Layers with other applications, map documents, and
other users.

Query layers can also be created on spatial data in databases that do not contain a geodatabase. See
What is a query layer? for more information.
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Six topology rules have been added

Six topology rules have been added to the collection of rules that allow you to model the spatial
relationships of your data. The rules are as follows:

• Polygon: Contains One Point

• Line: Must Not Intersect With

• Line: Must Not Intersect or Touch Interior With

• Line: Must Be Inside

• Point: Must Be Coincident With

• Point: Must Be Disjoint

See Geodatabase topology rules and topology error fixes for a description of topology rules.

The New Geometric Network Wizard is streamlined, and a new command is available
to load features into a geometric network

The New Geometric Network Wizard has been redesigned and streamlined to make creating geometric
networks easier.

A new command called the Geometric Network Incremental Loader has been added, which allows you to
load data into a geometric network easier and faster than through traditional means. The command is
designed for the addition of a large amount of features to an existing geometric network within a given
area. You can customize a toolbar by adding this command to it. See Loading new features into your
geometric network for instructions.

Vertical lines can be stored in z-enabled feature classes

You can create vertical lines in z-enabled feature classes. These lines have identical x- and y-coordinates
but different z-coordinates.

You can create vertical lines in ArcMap by specifying a z-coordinate for vertices that have identical x- and
y-coordinates. To do this, open the Edit sketch properties dialog box and type the z-coordinate.

Tip: When creating lines, be sure to specify the z-value for a vertex before you
finish the sketch. Completely coincident vertices (those that have the
same x-, y-, and z-coordinates) are removed from the sketch when you
finish it.
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This is one way to edit z-values. See Editing a vertex's z value...using the Edit Sketch Properties window
for more information. You can also use the Vertical tool or Duplicate Vertical command of the ArcGIS
3D extension to create vertical lines. See Creating a vertical line segment or Duplicating existing features
vertically for instructions on these methods.

Support is added for new data types in ArcSDE geodatabases, and existing data
types have been enhanced

ArcSDE 10 geodatabases support four new data types: ST_Raster (supported in Oracle, PostgreSQL,
and Microsoft SQL Server), native DBMS XML types (supported in IBM DB2, Oracle, PostgreSQL, and
SQL Server), and varbinary(max) and datetime2 in SQL Server.

Additionally, you can migrate raster data from binary to ST_Raster and spatial data from binary to SQL
Server geometry or geography types.

A new SQL data type for rasters is available

A new raster storage type, ST_Raster, is available in ArcSDE geodatabases in Oracle, PostgreSQL,
and SQL Server. This type allows you to alter and obtain information about raster data using SQL. For
more information on the ST_Raster type, see What is the ST_Raster storage type?.

To use ST_Raster storage, you must first install it in the geodatabase. See Installing the ST_Raster
type in Oracle, Installing the ST_Raster type in PostgreSQL, or Installing the ST_Raster type in SQL
Server for instructions.

Once installed, specify a configuration keyword that contains the RASTER_STORAGE configuration
parameter set to ST_RASTER when the raster data is created or imported to the geodatabase.

New functions have been introduced to allow you to work with the ST_Raster type using SQL. These
functions view or manipulate properties of ST_Raster or ST_PixelData values. For a list of available
SQL functions, see the ST_Raster SQL functions table in A quick tour of SQL functions used with
ST_Geometry and ST_Raster types.

You can migrate existing raster data to the ST_Raster type using the Migrate Storage geoprocessing
tool or the sderaster administration command.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 35

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00q800000090000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00q800000121000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00q8000000m6000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00q8000000m6000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//002n0000006w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z000000p7000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z000000p7000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z000000p8000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z000000p9000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z000000p9000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z0000003n000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//006z0000003n000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000000q000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//002n00000079000000


Native XML columns are supported in geodatabases in DB2, Oracle, PostgreSQL, and SQL Server

ArcSDE supports the use of native XML columns in geodatabases in DB2, Oracle 11g, PostgreSQL,
and SQL Server databases.

Twelve ArcSDE C API functions have been added to allow you to work with these columns.

You can use the functionality available in the DBMS or the ArcSDE API to create XML schemas to
validate XML documents against a set of constraints that you define. XML schemas are supported in
DB2, Oracle, and SQL Server. See XML schemas in ArcSDE geodatabases for more information.

New DBTUNE parameters have been introduced to let you control the storage of native XML columns.
See the XML sections of the following topics for details on these new parameters:

DBTUNE configuration parameters in DB2
DBTUNE configuration parameters in Oracle
DBTUNE configuration parameters in PostgreSQL
DBTUNE configuration parameters in SQL Server

Varbinary(max) and datetime2 columns are supported in geodatabases in SQL Server

Microsoft has deprecated the Image type in SQL Server. When creating new datasets in an ArcSDE
geodatabase for SQL Server, columns that would have been created as an Image type in previous
releases are now created as varbinary(max) columns. Examples of columns that will use
varbinary(max) instead of image columns include binary geometry and raster columns.

New date columns created in ArcSDE geodatabases in SQL Server 2008 use the datetime2 data type.
Datetime2 can store dates as early as 01/01/0000, whereas the earliest date you can store with a
datetime field is 01/01/1753.

Migrate binary geometry to SQL Server geometry or geography types

You can use the Migrate Storage geoprocessing tool or Python script or the sdelayer command to
change the geometry storage of a feature class from SDEBINARY or OGCWKB format to SQL Server
geometry or geography data types. To do so, you must specify a configuration keyword that contains a
GEOMETRY_STORAGE parameter set to either GEOMETRY or GEOGRAPHY.

Parametric circles and ellipses are supported with the ST_Geometry type in Oracle and PostgreSQL

The ST_Geometry storage type in geodatabases in Oracle and PostgreSQL can now store parametric
circles and ellipses.

When you create circles and ellipses through ArcSDE C or Java APIs or SQL and store them in the
ST_Geometry type, the geometries are stored as parametric representations, which are more accurate
and take up less space in the database.

The ST_Geometry SQL function also has parameters that allow you to generate a circle or ellipse.

See Parametric circles and ellipses for more information.
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What's new for editing in ArcGIS 10
At ArcGIS 10, the ArcMap editing environment gets an updated look with streamlined access to functionality, a
new feature template palette for creating features, and a more interactive snapping environment. The result is
reduced button clicks, simpler workflows, and quicker completion times for all your data compilation tasks.

Enhancements to the general editing environment and user interface

The first major difference you will notice is the redesign of the Editor toolbar. Items from the Task list have
been converted to individual tools and redeployed on the Editor toolbar, the Topology toolbar, and a few
other places where they are combined with other tools that function in a similar environment. Other items
such as the Select by Line and Select by Polygon items are now capabilities within the standard selection
functionality, so they are available outside the editing environment as well. The Target list (which was built
on a geodatabase-centric view of the data) has been replaced with a new concept, feature templates.
Templates are used to define the types of objects that you create on a map or layout.

Starting an edit session

At ArcGIS 10, there are two main ways to start an edit session: by clicking the Editor menu on the Editor
toolbar or by right-clicking a layer in the table of contents, which automatically starts an edit session on the
entire workspace containing that layer. If you use the Editor menu to start editing on a data frame that
contains data from multiple workspaces, you are prompted to choose the workspace to edit. The dialog box
that appears when you start editing with multiple workspaces in the map has been redesigned to show more
clearly the layers in the map and workspaces containing them.

When ArcMap encounters any issues when starting an edit session on the data you chose, a dialog box now
appears with a list of the specific error messages. You can double-click each problem to open a help topic
that provides more information and a solution.

Creating features using feature templates

Creating features is accomplished through the use of feature templates. Feature templates define all the
information required to create a feature: the layer where a feature will be stored, the attributes a feature is
created with, and the default tool used to create that feature. Templates also have a name, description, and
tags that can help you find and organize them. If templates are not present when you start editing, they are
automatically created for each layer in the current editing workspace. Templates are saved in the map
document (.mxd) and the layer file (.lyr).
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Editing using templates is a very map-centric user experience. Templates are displayed with a symbol and a
user-defined name. The symbol represents how objects created using the template will appear on the map
(by virtue of their target layers' symbology and their default attributes). Once created, templates can be
added, updated, copied, and deleted depending on your needs. Adding a new feature is now as simple as
clicking on the type you want from the window and defining the feature on the map. There is no need to
define the target, set the task, and activate the Sketch tool.

A new window, the Create Features window, is the central place to create and manage templates. The
Create Features window has three main components: a toolbar to manage your templates and their
properties, a list of templates used to create new features, and a set of tools used to define the features'
shape.
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Anytime you create features on the map, you start with the Create Features window. Choosing a feature
template on the Create Features window sets up the editing environment based on that feature template's
properties; this action sets the target layer in which your new features will be stored, activates a feature
construction tool, and prepares to assign the default attributes to the feature you create. To reduce clutter,
templates are hidden on the Create Features window when layers are not visible.

The top panel of the Create Features window shows the templates in the map, while the bottom panel of the
window lists the tools available to create features of that type. The availability of the feature creation tools, or
construction tools, depends on the type of template you have selected at the top of the window. For
example, when a line template is active, you can see a set of tools for creating line features. If you choose
an annotation template instead, the available tools change to those that can be used to create annotation.

The Annotation and Dimensioning toolbars have been removed in ArcGIS 10, as their tools are now
integrated into the Editor toolbar and Create Features windows. The process to create new annotation and
dimension features is similar to creating other types of features: choose a template and a construction tool
and click the map to create the feature.

Learn more about using feature templates

Creating lines and polygons

When you want to create features, you'll most commonly use the Create Features window's construction
tools and the construction methods on the Editor toolbar. With those tools, for example, you can create
lines, arcs, tangent curves, vertices at intersections or midpoints, vertices based on distances and directions
from other features, or new segments by tracing along existing ones.

To create segments in lines or polygons, you will most commonly use the Line tool (with line templates) and
the Polygon tool (with polygon templates). While these tools are used with different template types, they
behave similarly. To create segments, simply click the map where you want to place vertices.

By default, the Line and Polygon tools create straight segments between the vertices you click. These tools
have additional ways to define a feature's shape, such as creating curved lines or tracing existing features.
These are construction methods, which are located on the Editor toolbar. To create a curved segment, click
that construction type from the palette on the Editor toolbar and draw the curve on the map. You can even
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switch among construction types after each segment, allowing you to build the exact shape you want. For
example, if you are drawing a road with a bend in it, you may want some of it to be straight and some to be
curved. To do this, start with Straight Segment, digitize the straight segment, then click a curved segment
construction method and create the curve.

While many of the construction methods are used the same way as their counterpart sketch tools in
previous releases, there are a few differences. For example, to create a new feature by tracing the
segments in an existing feature, you now simply need to choose the Trace method, move your mouse
pointer near the existing feature, then click to begin tracing it. You do not need to select the feature to trace
first as you did before, which commonly restricted which edits you could perform with the Trace tool. In
addition, ArcGIS 10 also provides the ability to sketch smooth curves using the Bézier Curve Segment
method.

In addition to the Line and Polygon tool, there are other tools available to create lines and polygons. The
Freehand tool creates a hand-drawn feature and automatically smooths it into Bézier curves. The Circle and
Rectangle tools allow you to create circles and rectangles by dragging the mouse interactively or at precise
locations with keyboard shortcuts. These tools are similar to the ones on the ArcGIS 9.3 Advanced Editing
toolbar but have been enhanced at ArcGIS 10 (and removed from that toolbar). The Ellipse tool allows you
to create a new ellipse feature interactively or use shortcuts to specify the location and major or minor radii.
Previously, it was difficult to create ellipse-shaped features when editing. When creating polygons, you also
can choose the Auto-Complete Polygon tool, which is used to create adjacent polygons that do not overlap
or have gaps. This tool is similar to the Auto-Complete Polygon edit task but has been developed into its
own construction tool.

For more information about the types of segments you can create, see Segment construction methods.

Creating annotation

In ArcGIS 10, the Annotation toolbar has been removed, and the functionality for creating and editing
annotation has been integrated into the Create Features window and the Annotation Construction window.

The Create Features window and the Editor toolbar provide the tools you need to create new annotation
features. The Create Features window allows you to choose the construction method for your new
annotation—horizontal, curved, leader line, and so on. Once you choose the tool to use, the Annotation
Construction window appears, so you can enter the text of the new annotation, control how the text is
placed, and override the default annotation properties as defined by the feature template.

The default construction tool is one of the properties of a feature template. When you choose a template on
the Create Features window, the default construction tool is activated. For example, if you are creating
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annotation that identifies the names of roads or rivers, you might want to make the default construction tool
be the Follow Feature Annotation tool, which is used to create annotation that follows along the shapes of
polygons or lines. To set the properties of a feature template, double-click it in the Create Features window.

You can access the Unplaced Annotation window from the Editor toolbar > Editing Windows menu, which
allows you to open any of the dockable windows used while editing. The Unplaced Annotation window was
formerly opened from the Annotation toolbar.

Learn more about creating annotation

Creating new features with editing commands

Templates are used anytime you are creating features. When creating features with an editing command,
such as Buffer or Union, you choose a template on the dialog box that opens for those commands. If you
are editing an existing feature, you do not need to specify a template.

When creating new features with an editing command rather than sketching, you choose a template on the
dialog box for those commands. Previously, you had to set the target layer prior to accessing these
commands, which meant that the command would be disabled unless you had appropriately set the target
layer type (such as a line layer for Copy Parallel).

New snapping environment

The existing snapping environment is very flexible and powerful but is sometimes too complicated for casual
users. ArcGIS 10 provides a simplified snapping experience that uses more map-based settings, minimizing
the need to manage the snapping environment on a layer-by-layer basis. Snapping is enabled by default
and has been broadened from being within an edit session only to being available across ArcMap. For
example, the settings on the Snapping are also used when georeferencing and using the Measure tool.

All the settings you need to work with snapping are located on the Snapping toolbar. By default, snapping is
enabled in ArcMap, and the active snapping agents, or types, are points, endpoints, vertices, and edges.
You can turn on or off individual types or turn off snapping completely from the Snapping toolbar. A snap
agent is enabled when it looks "pushed in" on the toolbar or menu. To turn off snapping completely, click the
Snapping menu and remove the check mark next to Use Snapping.

When snapping is enabled, you may notice the pointer icon changes as you move around and pause on
various features on your map. Each snapping agent (vertex, edge, endpoint, intersection, and so on) has its
own feedback. For example, the cursor is a square when you are snapping to a vertex or point and becomes
a box with diagonal lines when you are snapping to an edge. By noting the cursor appearance and the
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SnapTip text that pops up, you can immediately determine the layer you are snapping to and which
snapping type is in use.

In addition, the new snapping environment allows you to customize the appearance of the cursor and pop-
up SnapTips and includes some new snap types, such as intersection, tangent to a curve, and midpoint.

If you need the customized snapping environment provided in previous releases, you can enable classic
snapping on the General tab of the Editing Options dialog box. This setting disables the Snapping toolbar for
use during editing and restores the Snapping Environment window.

Editing in the Attributes window

One area of the previous editing experience that created confusion while editing was the use of feature
class information as provided by the geodatabase rather than the view of that information exposed through a
feature layer in ArcMap. Providing a consistent layer-based editing experience alleviates this confusion and
provides a more seamless experience when using other parts of the mapping system. For example, when
working with attributes while editing, if you turn off the visibility for a field, set a field alias name, or change
how numbers display in a field, the field will also be hidden, shown with its alias, or displayed using that
number formatting when editing. You can also set a field to be read-only, which means you can view but
cannot edit that field, regardless of the file or database permissions. Respecting layer properties in the
Attributes window helps you efficiently view only the important information you need to update.

Entries in the Attributes window are shown using its display expression, which is the most useful and unique
field of an attribute table or table. A display expression is an enhanced version of the concept of the primary
display field that allows you to customize the text string. Some examples of how you might use a display
expression include entering your own text, changing the formatting of the text, or combining the contents of
multiple fields. Your expression would then show in the Attributes window in addition to the content of
MapTips and the Identify dialog box.

The Attributes window also has several other enhancements, such as the ability to change the orientation of
the window (attributes below the object list) and dock it to the ArcMap application interface. If you are
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working with date fields, a calendar pop-up appears to make it easier to enter specific dates. You can also
interact with related records, attributes tables, and Layer Properties more easily from the Attributes window.

In addition, the Fields tab on the Layer Properties dialog box has been redesigned, making it easier to
reorder fields, turn them on or off, sort them, and set other display and formatting properties. The order in
which fields are listed on the Fields tab is the default order in which they are displayed throughout ArcMap,
including in the Attributes dialog box when editing.

Learn more about the Attributes window

New way of attaching files to features

ArcGIS 10 introduces attachments, which provide a flexible way to manage additional information that is
related to your features. Attachments allow you to add files to individual features and can be images,
PDFs, text documents, or any other type of file. For example, if you have a feature representing a
building, you could use attachments to add multiple photographs of the building taken from several
angles, along with PDF files containing the building's deed and tax information.

Attachments are similar to hyperlinks but allow you to associate multiple files to a feature, store the
attached files in the geodatabase, and access the files in more ways. You can view attachments from the
Identify window, from the Attributes window (when editing), in the attribute table window, and through
HTML pop-ups.

Because ArcGIS uses a relationship class to maintain the link between the features and the file
attachments, an ArcEditor or ArcInfo license is required to add and edit attachments. You can view
attachments using ArcView.

To add attachments to an existing geodatabase, you must upgrade it to ArcGIS 10. To upgrade the
geodatabase, right-click it in the tree and click Properties. On the General tab, click Upgrade
Geodatabase.

New ways to enter exact locations

The Absolute XY dialog box, which is used to create points or vertices at an exact location, has been
redesigned. You can enter values in different units much easier now. Previously, the dialog box only
accepted map units unless you entered a units abbreviation such as ft for feet, m for meters, or dd for
decimal degrees.

You can specify locations as a longitude–latitude coordinate pair, a Military Grid Reference System (MGRS)
grid location, Universal Transverse Mercator (UTM) location, or a U.S. National Grid (USNG) location. If you
are entering a coordinate pair, you see two boxes on the dialog box, compared with one box for grid
locations.

This change is also reflected on other commands that use functionality similar to Absolute XY, including
moving vertices and topology elements to a specific location (Move To).

Easier to access functionality through mini toolbars

In many cases, some of the most powerful editing functionality was only available through keyboard
shortcuts or a right-click shortcut menu. All these shortcuts are still available, but you also can access the
functionality through new pop-up mini toolbars and windows that display many of the more common options.
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Each time you click the map with a sketch tool used to create segments, the Feature Construction toolbar
appears. The toolbar provides a shortcut to the segment construction methods on the Editor toolbar, so you
can create straight or curved segments and easily access any of the other construction methods. The
Feature Construction toolbar also contains commands to limit the next segment you create to be parallel or
perpendicular to another segment.

The Edit Vertices toolbar appears when you are editing the vertices of a feature and allows you to select
vertices and add and remove them easily. You can also drag a box around multiple vertices to select, move,
or delete them at the same time.

In addition, the Annotation Construction window appears to provide options for creating new annotation
features.

Editing existing features

Editing currently supports a number of tools and commands to manipulate existing features, such as
reshaping a features' geometry or splitting an existing feature.

To edit a feature in previous releases, you had to ensure you had the proper feature selected, choose an
edit task, then choose a tool to use. At ArcGIS 10, this process has been simplified, as the most common
edit tasks have been promoted into individual tools that prompt you to select a feature if one is not already
selected. For example, to split or reshape a polygon, you can click the Cut Polygons or Reshape Feature
tools on the Editor toolbar, select a feature, then draw the line used to perform the edit. To modify a feature,
you can select a feature and click the Edit Vertices button (similar to the former Modify Feature task) on the
Editor toolbar. You can also still double-click a feature with the Edit tool as a shortcut to editing its vertices.

Once you are in an edit session, the primary editing tools on the Editor toolbar are generally enabled. If a
tool cannot be used because certain criteria are not met, a message appears and provides information
about the tool's requirements and intended usage. This makes it easier for you to remedy the situation and
be able to use the tool successfully.

Editing vertices and segments

When you want to edit the vertices and segments of a feature, you can either select the feature and click
the Edit Vertices button or double-click the feature with the Edit tool. One of the major enhancements is
the ability to select multiple vertices on-screen and move, edit, and delete them at once. Previously, you
had to use the Edit Sketch Properties window, which is a table of the vertices, and were unable to select
multiple vertices graphically. In ArcGIS 9.3, you needed to use the Edit Sketch Properties dialog box to
select more than one vertex at a time. However, in ArcGIS 10, you can select them and delete or move
them all interactively with the Edit tool. In addition, you can right-click a segment and change it to another
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type, such as changing a straight segment to a curve or Bézier-curve segment. It is also easier to edit
curved segments—for example, you can reshape curves by clicking and dragging, setting a specific
radius, or repositioning the Bézier handles. In previous releases, editing Bézier curves was only available
with geodatabase cartographic representations, but now you can create and edit Bezier curves in any
feature class.

When the Edit tool is active and you are editing the shape of a feature, the Edit tool pointer changes from
a black arrow to a white arrow to show you can directly select vertices and modify segments. The black
arrow pointer is shown when you are working with whole features rather than the individual vertices and
segments that make up the feature.

The Edit Vertices toolbar allows you to select vertices and add and remove them easily. When you are
done modifying the vertex, finish the sketch.

• The Modify Sketch Vertices tool allows you to select vertices and edit segments.

• To add a vertex, click the Add Vertex tool and click the segment at the location where you
want to insert it.

• To delete a vertex, click the Delete Vertex tool and click the vertex to delete. To delete multiple
vertices, drag a box around them.

The ability to manipulate multiple vertices and change segment types is also built into the Topology Edit
tool. This allows you to update the shapes of features that share an edge in one edit. For example, if you
have a forest boundary that is adjacent to a lake, you can select the shared edge and use the Topology
Edit tool to modify the vertices along the border of both features at the same time. The Reshape Edge and
Modify Edge topology edit tasks have also been made into tools and are located on the Topology toolbar.
These tools update the shape of all features that share the selected edge or border, so it is ideal to be
used when you want to reshape two adjacent features. (The Reshape Feature and Modify Feature tools
on the Editor toolbar only update a single, selected line or polygon.)

Selecting features

When you use the Edit tool or Edit Annotation tool and click the map to select a feature, a small icon
appears if there are multiple selectable features underneath the location where you clicked. This

icon, known as the selection chip, allows you to refine the selection and choose the exact feature you
want to select when you have overlapping features. The N keyboard shortcut is still available for cycling
through the selectable features, but the selection chip provides a graphical method of choosing which
feature to select.
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Editing m-values and z-values

The Edit Sketch Properties window makes it easier to change the m-values and z-values of multiple
vertices at once. For example, you can sort vertices in the list by whether they are selected and promote
to the top of the list vertices that need to be updated. In addition, when working with routes, the former
edit tasks have been converted to tools on the Route Editing toolbar and utilize the new editing
environment and feature templates.

Better feedback when editing

ArcGIS 10 provides better on-screen feedback when you are digitizing features, modifying them, and
moving them. When creating or moving features, you see a symbolized WYSIWYG preview of the feature,
rather than a simple edit sketch or wireframe as you had in the past. In addition, you can easily change the
colors and symbol sizes used in the vertices and segments of an edit sketch on the General tab of the
Editing Options dialog box. Previously, you had to write code or navigate the system's registry to change
these symbols.

If you are tracing features over a dark raster image, for example, you may want to change the colors so the
sketch is easier to see. You can change the square boxes used to draw the vertices and the segment line
connecting them. The selected vertex symbol is how a vertex appears when it is selected, such as when you
draw a box around it with the Edit tool or check it in the Edit Sketch Properties window.
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You can turn off the symbolized (WSIWYG) preview so a feature displays as a wireframe when moving it or
sketching. Turning off the symbolized drawing may be useful when you are tracing over an aerial
photograph or working with large outline symbols. If you turn off this setting, the sketch symbols specified on
the Editing Options dialog box are used when working with edit sketches.

New geodatabase topology rules

ArcGIS 10 contains a set of new geodatabase topology rules. To add these rules to a topology, you must
upgrade your geodatabase to ArcGIS 10. The new rules are

• Polygon: Contains One Point

• Line: Must Not Intersect With

• Line: Must Not Intersect or Touch Interior With

• Line: Must Be Inside

• Point: Must Be Coincident With

• Point: Must Be Disjoint

For a description of these and all the other topology rules available in ArcGIS, see Geodatabase topology
rules and topology error fixes.

New commands for creating and splitting polygons

The Construct Features command on the Topology toolbar has been separated into two different commands
that are easier to use: Construct Polygons and Split Polygons. In the past, Construct Features could be hard
to use because it worked with both lines and polygons and could create new features or split existing ones.

In ArcGIS 10, the feature creation functionality is available in the new Construct Polygons command, and
the split functionality is in the new Split Polygons command. Both of these are available from the Topology
toolbar. You do not need to have a geodatabase or map topology present to use these tools, but they do
require an ArcEditor or ArcInfo license.

To create lines from existing features, you can use the Feature To Line geoprocessing tool.

New commands for creating points along a line and splitting lines into an equal number
of parts

The Divide command has been removed and replaced with the functionality available in the new Editor
menu > Construct Points command and a new option in the Editor menu > Split command.

Construct Points creates new point features at intervals along a selected line. For instance, you could use
Construct Points to place utility poles along an electric line. You can create a specific number of points that
are evenly spaced, or you can create points at an interval you choose based on distances or m-values.

The Split command on the Editor menu allows you to split a line into an equal number of new features. For
example, you can use this Split option to break a line into pieces that are the same length.
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New way to create geodetic features

ArcGIS 10 includes new tools to create features that consider geodetic measurements when being drawn.
The Construct Geodetic command on the Advanced Editing toolbar opens a window that allows you to
create several different types of features, such as a geodesic line, geodesic circle, or loxodrome.

New Editing geoprocessing toolbox

The Editing toolbox contains a set of geoprocessing tools to perform bulk edits to your data. These tools are
useful for performing data cleanup, especially on data that was imported from another source, such as CAD.

New way of editing data from ArcGIS Server

If you have data from ArcGIS Server, you can download a local copy of the service to a geodatabase so you
can edit the data in ArcMap. This workflow can be useful when your organization has disconnected
employees. In addition, it provides a common method for editing the same data using multiple clients, such
as through the Web or using desktop applications.

Once the server data has been copied to the local geodatabase, the feature classes behave like any others;
you start an edit session and add and delete features in the same manner. When you are finished editing
the local layers, you need to synchronize them so your changes are updated in the service. Access to the
server is only required when creating the local copy or applying changes from the local copy to the server,
so you can go offline while making the edits, if needed.

By default, the data is checked out to a new file geodatabase, which is created for you automatically. You
can also choose to store the data in an existing ArcSDE geodatabase. If you plan on making many updates
to the data, consider using ArcSDE since it allows you to check out the data and synchronize your updates
repeatedly.

Learn more about editing data from ArcGIS Server

Other changes

Below are some other changes to the user interface and commands.
• The Intersect command has been removed from the Editor menu but is available in the Customize

dialog box.

• The Mirror Features edit task has been converted into a tool that is available on the Customize
dialog box.

• The Validate Entire Topology button has been removed from the Topology toolbar but is available in
the Customize dialog box.

• The options for the Fillet tool and the Trace construction method are now available by right-clicking
the map, in addition to pressing the O key.

Support for existing solutions and workflows

Due to the usability benefits that feature templates provide, it is recommended that you learn to use them
when editing. However, for organizations that are unable to adopt the template-based workflow, there is an
option available to revert to the ArcGIS 9 editing environment. This allows organizations that rely on
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extensive editing customizations to transition at their own pace to the feature template workflow. You can
return to using feature templates once you are ready to migrate to that workflow.

The setting is found in the Advanced ArcMap Settings utility, located in the \Utilities directory where you
installed ArcGIS. This option prevents you from taking advantage of many of the capabilities for feature
creation, since the user interface and editing methods revert to how they appeared and were used in ArcGIS
9. Any user interface element used with feature templates is removed from ArcMap. For example, the Editor
toolbar displays the Sketch tool palette, target layer list, and task list. Edit tasks are used in conjunction with
the target layer to create and edit features. The Annotation and Dimension toolbars are used to create those
feature types rather than the tools in the Create Features window.

If you have enabled classic snapping, you must turn it off to work with the Snapping toolbar when editing.
When classic snapping is enabled, other functionality outside the editing environment, such as
georeferencing and the Measure tool, still continue to use the settings on the Snapping toolbar.

Parcel editing

ArcGIS 10 introduces new parcel editing functionality with the Parcel Editor toolbar. The Parcel Editor
toolbar, which is available with an ArcEditor or ArcInfo license, replaces the Survey Analyst Cadastral Editor
extension.

The Parcel Editor toolbar works with a parcel fabric dataset. The parcel fabric dataset replaces the cadastral
fabric dataset of the Survey Analyst Cadastral Editor extension.

A parcel fabric is a dataset for the storage, maintenance, and editing of parcels. A parcel fabric is created
under a feature dataset and inherits its spatial reference from the feature dataset.

A parcel fabric stores a continuous surface of connected parcels, or parcel network. Parcels in a fabric are
defined by polygon, line, and point features. Polygons are defined by a series of boundary lines that store
dimensions as attributes in the lines table. Dimensions on parcel lines should ideally match recorded
dimensions on the record or survey or plan.

Spatial accuracy in the parcel fabric is improved and maintained through a fabric least-squares adjustment.
Control points are processed together with recorded dimensions to derive new, more accurate coordinates
for parcel corners.
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Learn more about parcel fabrics

Learn more about the parcel fabric data model

Migrating data to the parcel fabric

The new Load A Topology To A Parcel Fabric geoprocessing tool located in the Data Migration toolset of
the new Parcel Fabric toolbox can be used to migrate existing parcel data to a parcel fabric. The tool
migrates existing parcel-based polygon and line features that participate in a validated, clean topology
that uses a required set of rules.

Learn more about migrating parcel data to a parcel fabric using topology

Parcel fabric editing environment

The following editing tools are available on a parcel fabric:

• Parcel traverse
For a single parcel on a survey plan or record of survey, dimensions for each parcel boundary are
entered in a sequence such that a closed polygon is formed.

• Parcel construction
Parcel construction lines are used to build fabric parcels. Many parcels can be built from a
network of parcel construction lines. Parcel construction lines can be traversed, digitized, or
created from COGO tools. Lines from an external data source can also be pasted as parcel
construction lines.

• COGO tools
COGO tools are available for adding and computing parcel traverse lines and parcel construction
lines.

• Basis of bearing
When subdividing a parcel in the parcel fabric, you can use the Basis Of Bearing tool to orient or
rotate the original parcel to the basis of bearing used on the new subdivision plan.

• Parcel division using parcel construction lines
A parcel or multiple selected parcels can be subdivided using parcel construction lines.

• Parcel division by area
Parcels can be divided by area to create new parcels. Parcels can be divided into equal widths or
by proportional area or into equal areas.

• Remainder parcels
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When replacing existing parcels with new parcels or when subdividing parcels, remainder parcels
can be created from areas not covered by the replacing parcels.

• Merging parcels
New parcels can be created from merging existing parcels in the fabric. Disjoint parcels can be
merged to create multipart parcels.

• Natural boundaries
In the parcel fabric, natural boundaries are referred to as line strings and are created using the
Line String tool. An existing series of line segments can also be converted to a natural boundary
using the Line String tool.

• Multipart, donut, and island parcels
Multipart, donut, and island parcels are created and maintained using part connector lines in the
parcel fabric.

See a quick tour of parcel editing in the parcel fabric.
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What's new for raster and image data in ArcGIS 10
Desktop

Improved raster format support

Starting in ArcGIS 10, all raster format support has been improved. You should not see a change in how
your data is handled; it should work as it always has. The main purpose of the improved format support is
to overcome many of the limitations of the old format library.

The improved format support enables ArcGIS to read and write out more raster formats. As well, there are
more TIFF compressions available when creating a TIFF file.

All new pyramids created are now saved as an OVR file (with the exception of the ERDAS IMAGINE®
format). The new OVR files are more flexible since they work with all file formats that allow for pyramids.
As well, the OVR files can be compressed so that they do not take up as much disk space.

New mosaic dataset data model

A mosaic dataset is a new geodatabase raster data model. The mosaic dataset is supported in all types of
geodatabases (personal, file, and ArcSDE).

A mosaic dataset is a collection of raster datasets (images) stored as a catalog and viewed as a
dynamically mosaicked image. The raster datasets can also be viewed individually. These collections can
be extremely large both in total file size and number of raster datasets. The raster data is added according
to its raster type, which identifies metadata, such as georeferencing, acquisition date, and sensor type,
along with a raster format. The raster datasets in a mosaic dataset can remain in their native format on
disk or, if required, be loaded into the geodatabase. Mosaic datasets are ideal for distributing data
because they can be directly accessed by users and easily served.

A mosaic dataset can be viewed with any license level. To create or edit a mosaic dataset requires an
ArcEditor or ArcInfo license. To serve a mosaic dataset using ArcGIS Server requires the Image
Extension license.

Learn about the mosaic dataset
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Image Analysis window

The Image Analysis window is a new dockable window that can be used to quickly perform many
display and processing raster tasks. It can be added to ArcMap from the Window menu.

Many of the display options on this window existed in ArcMap but were located on various dialog boxes;
various options can now be quickly accessed, such as contrast, brightness, transparency, gamma stretch,
dynamic range adjustment, ignore background value, contrast stretch, display resampling method, zoom
to raster resolution, swipe, and flicker.

This window also contains many processing options, some of which can also be performed using
geoprocessing tools. When accessed using this window, they are added to a new layer using functions,
including clipping, masking, combining bands, NDVI, pan-sharpening, hillshading, and mosaicking.

Learn about the Image Analysis window
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Color correction

Color Correction window for mosaic datasets

When you have a mosaic dataset that needs color correction, the Color Correction window can assist
you in performing the color correction task. This window provides many options to color balance your
mosaic dataset. The Exclude Area option can be especially helpful for areas that are difficult to color
balance, such as water or clouds. The Mosaic Color Correction window button can be added to any
toolbar in the Customize Mode.

Learn about the Color Correction window

Color correcting raster catalogs

The Color Correction tab on the raster catalog layer properties dialog box provides additional color
correction options. Some of the new parameters available to you include prestretching, more color
balancing methods, the ability to specify a color balancing target surface type, and the ability to specify
a color balancing reference target image.

Learn about color correction

Geoprocessing

There are many new geoprocessing tools available for raster data. The majority of the new tools are for
the new raster data model—mosaic dataset. The Mosaic Dataset toolset consists of geoprocessing tools
to author, edit, and optimize your mosaic dataset.
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The Split Raster tool allows you to take a large raster dataset and divide it into many equal tiles. Similarly,
the Raster to DTED tool allows you to divide up your raster dataset according to DTED level 0, 1, and 2
specifications.

The Build Pyramids And Statistics tool allows you to build pyramids and calculate statistics on an entire
workspace, using only one geoprocessing tool. The tool also gives you options to only batch build
pyramids or batch calculate statistics.

The Make Mosaic Layer tool allows you to create temporary layers, so you can work a mosaic dataset,
such as defining a subset of bands as the input for another geoprocessing tool.

There are two tools that have been improved at ArcGIS 10: Mosaic To New Raster and Add Colormap.
The Mosaic To New Raster tool is no longer a script tool but a system tool. Making the Mosaic To New
Raster a system tool solved a lot of the bugs that existed in the previous script tool. The Add Colormap
tool has been enhanced by allowing users to specify .clr and .act files for the color scheme for the raster
dataset.

There are two new Environment Settings available within the Raster Storage Options: pyramid
compression type and more TIFF compression types. Now, when you build pyramids, you have the ability
to compress your OVR files. When you create a TIFF output, you now have more compression types
available for your output.

Create a custom CLR file

One of the most requested enhancements has been the ability to create your own colormaps. ArcGIS now
allows you to create a custom color scheme within the Unique Values renderer dialog box and save it to a
CLR file. Once you have a CLR file created, you can use it with the Add Colormap geoprocessing tool to
add the color scheme to your raster dataset.

Learn more about creating a custom CLR file
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Advanced labeling with the stretched renderer

The stretched renderer has the option to perform advanced labeling. This allows you to specify values on
the color ramp that you would like to display. In addition, you can set up an advanced color ramp between
each of the specified values.

Learn more about custom labeling

Functions

Functions allow you to perform dynamic processing to your mosaic datasets and on raster dataset layers
(added using the Image Analysis window). Functions can be chained together, allowing you to add
multiple processes to your mosaic dataset or raster dataset layer. They are applied from the bottom up.
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Learn about functions

Raster Options

There are four tabs on the Raster tab of the ArcMap Options dialog box: Raster Dataset, Raster
Catalog, Raster Layer, and Mosaic Dataset.

Learn about setting default raster display options
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The Raster Dataset tab defines defaults for displaying raster datasets; this tab was previously named
General. There is a new check box on this tab, allowing you to Create tiled TIFF files. As well, the raster
attribute table limit has been moved to this location.

The Raster Catalog tab defines defaults for displaying raster catalogs. There is a new option called
Maximum number of rasters to be drawn. This option limits the number of raster catalog items that will
be drawn, so that it will not draw all the items of a large catalog. The Maximum number of rasters for
color matching text box has been moved to this tab.

The Raster Layer tab defines the symbology defaults for displaying raster datasets. This is a new tab
containing options for the default ignore background value, the NoData color, whether to display datasets
with contrast stretching, and the default resampling method.

The Mosaic Dataset tab defines the default settings for displaying mosaic datasets. This new tab
presents the option to expand the mosaic dataset in the table of contents. The expanded mode shows the
boundary, footprint, and image layers. Options for boundary, footprint, and image layer visibility are also
set in this tab.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 58



New icons

As with all other aspects of ArcGIS 10, all the raster data icons have been updated. There are new icons
for raster datasets, raster catalogs, and the mosaic dataset. Depending on where the raster resides, it will
be a specific color. File-based data is yellow, geodatabase data is gray, and data on the server is blue.

Accelerated rasters

Accelerating a raster layer greatly increases the layer's display performance. When you display a raster
layer using the accelerated renderer, you can seamlessly pan and zoom around the data in the display. A
key feature of the accelerated renderer is the ability to take advantage of graphics card processing units
to further enhance performance.

You can accelerate a raster layer via the Image Analysis window.

Learn about accelerated raster rendering

Server

Serve mosaic datasets

Mosaic datasets are a new dataset that can be served as an image service or inside a globe or map
service. There are also additional capabilities to query and interact with image services derived from
mosaic datasets.

Querying an image service layer
Previewing each raster dataset in an image service
Downloading selected raster datasets from image services

Enhanced image service parameters

The image service properties page now allows you to control a greater number of default service
parameters. This gives you more control over the amount of data a user can request, the type of
information that can be requested, and the allowable mosaic and compression methods.

• Maximum image size per request

• Maximum number of rasters per mosaic

• Default resampling method

• Allowed compressions

• Allowed mosaic methods
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• Maximum number of records returned per request

• Metadata level

• Allowed fields

• Maximum number of downloads per request

New supported operations

The image service resource has been improved to provide additional operations. Export Image has been
improved to allow you to specify mosaic rules and properties. Additionally, Query, Identify, and Download
have been added.
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What's new for tables and attributes in ArcGIS 10
In ArcGIS 10, there is a new experience for working with attribute tables and a number of new features.

Table window

The Table window is the container that displays all your open attribute tables in ArcMap. All open attribute
tables are tabbed within the Table window; simply click a tab to activate a specific table. The Table
window also has a toolbar and several menus that allow you to interact with the attributes of the table and,
in the case of spatial data, the map.

When working in the Selected view of the table, the toolbar at the top of the window expands to include
commands for working with highlighted records.
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Viewing Multiple Tables

When you open any attribute table in ArcMap, it is placed inside the Table window. The Table window acts
like a container for all open attribute tables. Within the Table window, each open table has its own tab, which
you can click to view that table. You can also drag the tab of an attribute table and dock it within the Table
window to view multiple tables at once.

Tables can also be moved within the Table window by using the following Arrange Tables commands on
the Table Options menu:

• New Horizontal Tab Group—Places the active table in a new group, horizontally aligned and below

• New Vertical Tab Group—Places the active table in a new group, vertically aligned and to the right

• Move to Previous Tab Group—Places the active table in an adjacent existing group, to the left or
above

• Move to Next Tab Group—Places the active table in an adjacent existing group, to the right or below
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Working with joins

You can analyze a join before creating it by using the Validate Join button on the Join Data dialog box.
Join validation allows you to assess any potential problems that you might encounter when creating a join.
Join validation analyzes the two participating datasets to determine if there are any common problems with
the data. The following is a list of what is checked in the data:

• Check for field names that start with an invalid character.

• Check for field names that contain an invalid character.

• Check for field names that match reserved words.

• Check for nongeodatabase MS Access tables.
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Field Calculator

In ArcGIS 10, the Field Calculator has been enhanced to work with Python scripting. You can no longer
use VBA code blocks; instead, both VB Script and Python are fully supported. The numeric, string, and date
functions are populated based on what scripting language is chosen.
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New options and commands in the Table window

From the Table Options menu, use Restore Default Field Order to apply the original ordering of fields in
the table.

From the row context menu, you can access the Attachment Manager dialog box for managing feature
attachments. For this command to be enabled, the feature class must have Attachments enabled, which can
be achieved by right-clicking a feature class in the Catalog window and choosing Attachments > Create
Attachments.

On the Field Properties dialog box, there are new options for highlighting fields or designating fields to be
read-only. These properties can be used to highlight or protect specific fields in the table. You can also set
these properties from the Layer Properties dialog box on the Fields tab.

Improved handling of the fields in layers

The improved Fields tab on the Layer Properties dialog box gives you more control over how your layer's
fields are presented throughout the system. (The properties dialog box for a stand-alone table also has this
improved Fields tab.)

Better control over how fields appear

In ArcGIS 10, the order in which fields appear is now a layer property and is reflected throughout the
system when you use a layer (or stand-alone table) in which you've reordered the fields. In previous
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releases, you could reorder fields in the Table window, but this order was not stored as a property of the
layer or reflected in other dialog boxes that showed fields. Using the new Fields tab, you can reorder the
fields in your layer (or stand-alone table) using the buttons on the tab or by dragging them up and down in
the list. You can also use the Table Options menu button to sort the fields alphabetically or revert to the
field order in the underlying data source. You can still reorder fields in the Table window by dragging
columns left or right, and any reordering you do in the table window updates the field order for the layer.

All the choices you make on the Fields tab to tailor how fields appear are now respected by the
Attributes window when you edit data. Previously, the Attributes window didn't respect these settings,
which made it hard to tailor the fields listing in that window to simplify editing tasks.

To set the alias for a field, type it into the Alias text box in the Appearance grid on the right-hand side of
the Fields tab. After you've specified an alias, you can still see the actual name of the field in the Field
Details grid along with information about the data type of the field.

You can specify that a field be read-only inside ArcMap, which means you can view but cannot edit that
field, regardless of the file or database permissions. This makes it easier to edit particular attributes in
your layer, because you can make fields that you don't want to edit be read-only. You can also choose to
highlight particular fields. Highlighted fields appear with a yellow background in the Table window,
Identify window, and Attributes window. This makes it easy to find the most important fields when you
are querying or browsing.

Learn more about using field properties, aliases, and table display options

New display expression

In previous releases, you could choose a primary display field for every layer that would be used to
identify and represent the features in the layer in various places in the system. For example, the primary
display field was used to provide the values for MapTips and in the feature listings in the Identify dialog
box and Attributes window. In ArcGIS 10, the primary display field concept is enhanced so that you can
customize the text string that is generated to include values from multiple fields and static text. It is now
the display expression, and you'll find it on the Display tab. You can specify the display expression in
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exactly the same way that you specify the label expression. The display expression defaults to being a
single field from your layer, the same way that the primary display field did in previous releases.

Learn more about using the display expression

Other

The Identify window is now dockable. In addition to being able to dock it into the display, you can also
choose to stack it with other windows, like the table of contents, or autohide (unpin) it so that it
automatically appears when you identify a feature in a layer.

Attaching files to features in a layer as attributes

ArcGIS 10 introduces feature class attachments, which provide a flexible way to manage additional
information that is related to your features. Attachments allow you to add files to individual features and can
be images, PDFs, text documents, or any other type of file. For example, if you have a feature representing
a building, you could use attachments to add multiple photographs of the building taken from several angles,
along with PDF files containing the building's deed and tax information.

Attachments are similar to hyperlinks but allow you to associate multiple files with a feature, store the
attached files in the geodatabase, and access the files in more ways. You can view attachments from the
Identify window, from the Attributes window (when editing), in the attribute table window, and through
HTML pop-ups.

Learn more about using attachments
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What's new for CAD integration in ArcGIS 10
At ArcGIS 10, new functionality for CAD data includes streamlined access to conversion tools, a new tool for
bulk loading CAD datasets, simplified field display in ArcMap, and support for spline geometry.

CAD conversion menu in ArcMap

CAD conversion tools can be opened by right-clicking the ArcMap table of contents. The shortcut menu
displays choices based on the type of CAD feature layer you have selected:

• Convert CAD Feature Layer opens the Copy Features tool.

• Convert CAD Feature Dataset opens the CAD To Geodatabase tool.

• Convert to Geodatabase Annotation opens the Import CAD Annotation tool.

Bulk loading CAD datasets

The CAD To Geodatabase tool is a new tool that bulk loads entire CAD datasets to an existing
geodatabase. This tool automates a series of conversion procedures that includes importing CAD
annotation and merging identical feature class names, types, and attribution. The tool accepts multiple CAD
files as input in mixed DWG and DGN formats.

The output annotation feature class is automatically created with an annotation subclass for each text layer
in the CAD file and requires only that you specify a reference scale. If the tool is opened from the Catalog
window in ArcMap, the results are also added as a group layer.

Simplified CAD field display

Now when you add CAD data to ArcMap, CAD property fields that are nonessential for rendering or query
operations are turned off by default. You can turn them on using the Fields tab on the Layer Properties
dialog box.

CAD spline geometry

CAD spline geometry is now supported by direct-read and CAD conversion tools.

Deprecated geoprocessing tools

The following CAD tools that were available in the geoprocessing toolsets prior to ArcGIS 10 have been
deprecated and replaced with better alternatives. The tools remain in the system so your existing 9.3 models
and scripts will continue to work, but no further development will be performed in future releases.

For more information about deprecated tools, see What is a deprecated tool.
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To CAD toolset

Create CAD XData

Using xdata for attaching attribute information to AutoCAD entities has been replaced with an
automated implementation of AutoCAD xrecords that is integrated with the Export To CAD tool for
supported direct-read DWG formats. AutoCAD xrecords are similar to xdata but not limited by size or
order.

The Export To CAD tool provides the following out-of-the-box functionality:

By default, output to DWG formats (version 2007 or higher) includes CAD-defined feature class
schemas and attributes attached to AutoCAD entities.

For each input feature class, the Export To CAD tool embeds a feature class definition in the AutoCAD
drawing file, comprising the default AutoCAD entities that are generated for the feature. All feature
attributes are exported as AutoCAD xrecords and linked to the appropriate entities. Similarly, the
coordinate system is also exported and embedded in the DWG file.

CAD-defined feature classes are directly usable by ArcGIS, and they can be edited in the AutoCAD
application using ArcGIS for AutoCAD. You can also export empty feature classes to generate schema-
only DWG files.

This geodata is nongraphic and does not interfere with standard AutoCAD geometry or native
functionality. The AutoCAD xrecord objects that define the feature classes and coordinate system are
stored in a standardized framework of AutoCAD object dictionaries. Similarly, entity-linked attributes are
stored in the AutoCAD extension dictionary referenced by each entity.

For detailed information about how this data is structured, reference the ESRI document Mapping
Specification for CAD available on the ArcGIS for AutoCAD Resource Center.

Set CAD Alias

A feature class field alias can be changed in the Catalog window or in the ArcCatalog application with
the Feature Class Properties dialog box. An alternate workflow is to add a reserved CAD field using
the Add Field tool, then use the Calculate Field tool to populate its records with values from an existing
field.

To Geodatabase toolset

Import from CAD

CAD data can be imported with standard geoprocessing tools that accept feature classes or layers as
input. The ArcMap shortcut menu from the table of contents provides quick access to the Copy
Features tool, the Import CAD Annotation tool, and the CAD To Geodatabase tool.
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What's new for metadata in ArcGIS 10
Item Description

All items in ArcGIS now have a simple, standardized core description—the Item Description—comprising a
title, summary, description, tags, credits, restrictions, and a preview thumbnail. You can view and edit the
Item Description for any item in ArcCatalog, the new Catalog window, and the new Search window. You can
also access the Item Description for a layer's underlying data from the Table of Contents. The information in
the Item Description is automatically used when you search for data or share it using ArcGIS online.

You can also choose to create formal metadata. The Item Description is a small subset of the complete
formal metadata you can create to describe an item.

Metadata styles

Metadata styles let you set all your preferences for working with metadata at once. They control how you
view, edit, export, and validate an item's description. The default metadata style supports creating and
maintaining the Item Description. Additional metadata styles provided with ArcGIS let you create formal
metadata that complies with a metadata standard.

Choose the style of metadata you want to use in the Options dialog box on the Metadata tab from any of the
ArcGIS Desktop applications. If you choose a metadata style that supports formal metadata, the item's
complete metadata appears below the Item Description, and when you edit the description the built-in editor
lets you create a complete metadata record.

Beginning with ArcGIS 10.0 SP1, a new metadata style is available that lets you create metadata in the
Description tab that complies with the Federal Geographic Data Committee's (FGDC) Content Standard for
Digital Geospatial Metadata (CSDGM). With this style, the ArcGIS metadata you create can be exported to
an XML file that can be validated against an FGDC CSDGM XML schema. When needed, these exported
files can be used outside of ArcGIS, for example, to publish information to a metadata catalog that only
accepts metadata in the FGDC XML format. This is the recommended way to create and maintain FGDC
CSDGM metadata in ArcGIS 10.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 70



New geoprocessing tools for managing metadata

Tasks for managing metadata are accomplished using geoprocessing tools. Several new geoprocessing
tools are available in the Conversion toolbox, including: Export Metadata, Import Metadata, Synchronize
Metadata, Validate Metadata, and Upgrade Metadata.

Learn more about metadata
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What's new in ESRI Data and Maps in ArcGIS 10
There have been many changes in ESRI Data & Maps 10. This includes both the data content and new
delivery methods.

The big news in content is that we have added DeLorme mapping company as our new data source for
worldwide datasets including roads, airports, hydrology, cities, and contours. The datasets include most of the
key features and attributes from DeLorme's commercial basemap product and retains all the source detail to
support high-quality display down to 1:250,000. This release of Data & Maps is the first to include the new
DeLorme data, and ESRI looks forward to providing even more in the future.

Many other datasets were updated to the most current versions available. This includes all Tele Atlas Census
boundary and landmark layers, as well as all GNIS cultural points. This is the first year the new Data & Maps
census and landmark datasets are built from Tele Atlas MultiNet. Existing attribute content has remained,
along with the new MultiNet coding attributes.

Even bigger changes can be found in the way ESRI provides data to the user community. For those users that
choose to simply download the new ArcGIS Desktop 10 software, the new Data & Maps will be available as a
separate download. The Data & Maps DVD continues to be included in the Desktop software box and is
updated regularly.

A wide range of individual data layers for easy download from ArcGIS.com are also offered. ESRI has
published many of the most popular data layers as layer packages that you can download and display in
ArcGIS Desktop applications. This allows you to access the latest versions of these data layers as they are
updated and get just the layers you need. Visit the ESRI Data & Maps group at ArcGIS.com for a full list of
available layers.

New datasets in Data & Maps

World

• Airports

• Contours

• Linear Water

• Water Bodies

• Populated Places

• Railroads

• Roads

• Urban Areas

Updated datasets in Data & Maps

World

• Cities
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United States

• Telephone Area Code Boundaries

• Census Block Groups

• Census Block Centroid Populations

• Core-Based Statistical Areas

• Counties

• Counties (generalized)

• County Boundaries

• States

• States (generalized)

• State Boundaries

• Populated Place Areas

• Census Tracts

• ZIP Code Areas (three-digit)

• ZIP Code Areas (five-digit)

• ZIP Code Points

• Institutions

• Large Area Landmarks

• Parks

• Recreation Areas

• Geographic Names Information System—Buildings

• Geographic Names Information System—Cemeteries

• Geographic Names Information System—Churches

• Geographic Names Information System—Golf Locales

• Geographic Names Information System—Hospitals

• Geographic Names Information System—Locales

• Geographic Names Information System—Populated Places

• Geographic Names Information System—Schools

• Geographic Names Information System—Summits

• Airports

• Major Roads

• Transportation Terminals

• USGS 1:24,000 Topographic Quad Sheet Index
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Europe

• NUTS Level 0

• NUTS Level 1

• NUTS Level 2

• NUTS Level 3

Related Topics
Redistribution rights
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What's new in ArcMap 10 basics
Updated icons and pull-down menus

In ArcGIS 10, all the icons have been re-created to take advantage of more colors and make them more
attractive. The symbols used in the icons are the same, though, so you'll still be able to recognize them.

The pull-down menus are generally the same, so you don't have to relearn your workflows when you migrate
to ArcGIS 10. There are some small changes that have been made:

• The Tools pull-down menu has been removed and replaced with a Customize pull-down menu that
contains just those commands that you use to customize the application, such as the ArcMap
Options dialog box, Extensions, and the Customize dialog box. The command used to launch the
Customize dialog box has been renamed Customize Mode to help indicate that when the Customize
dialog box is open, you are in a mode in which you can drag and drop controls directly between
menus and toolbars to customize the application—you don't need to interact with the Customize
dialog box itself when you do that. Going into the Customize dialog box enables you to find any
control, command, or geoprocessing tool and drag it onto a toolbar or menu. But if you just want to
reorganize controls on a toolbar, you can do that directly while you are in Customize mode.

• The commands for geocoding, adding XY data, and adding linear referencing route events that used
to be in the Tools pull-down menu have been moved into the File pull-down menu in a new pull-right
menu called Add Data. In this way, the File > Add Data pull-right menu centralizes the commands
for adding data into your map in one convenient place.

• The commands for working with graphs and reports that used to be in the Tools pull-down menu
have been moved into the View pull-down menu. Think of graphs and reports as being additional
views of your GIS data.

• The My Places command that used to be in the Tools pull-down menu has been moved onto the
Data Frame Tools toolbar.

• There's a new Geoprocessing pull-down menu that centralizes all the geoprocessing commands in
one convenient location. This menu is your starting point for all geoprocessing functionality. The
menu includes a set of commonly used tools, like Buffer, Clip, and Intersect, so you can use these
immediately without having to find them first. Using the Customize > Customize Mode menu, you
can add your own favorite geoprocessing tools into this menu. In ArcGIS 10, you can also add
geoprocessing tools onto toolbars while you are in Customize Mode.

Easy to access great-looking basemaps for your map

The Add Data button on the Standard toolbar is now a menu button that includes two new commands for
adding online content to your map:
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The Add Basemap command lets you choose an online basemap for your map. The gallery of basemaps
includes the key ArcGIS Online basemaps, such as World Imagery, World Streets, and the World
Topographic Map, as well as the Bing Maps services. These basemaps all require an Internet connection for
them to draw in your map. This makes it quick and easy to immediately add great basemaps to your own
map without having to download or manage the data locally. The content in these services is frequently
updated, too:

Tip: If you have not upgraded to ArcGIS 10 yet, don't forget that you can access
these basemaps and use them in your current version of the software. In
9.3, launch the File > Add Data From Resource Center command. In
9.3.1, launch the File > Add Data > Add Data From ArcGIS Online
command .
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New dockable window controls make it easy to arrange and organize your display

With ArcGIS 10, you can arrange the windows in your map display any way you want so you can see more
of your map and reduce clutter. Dockable windows, such as the table of contents, the ArcToolbox window,
the new Catalog window, and the new Search window, are easier to work with.

A new pin control on every dockable window lets you unpin it to autohide it. An autohidden window is shown
as a tab in the display, which you can pause over or click to make the window expand whenever you want to
use it. After you expand an autohidden window, it will automatically hide itself again when you click
somewhere else, such as choosing a tool from a toolbar, or click on the map display. At any time, you can
click the pin control again to dock the window so it remains in place.

To move a docked window to a new location, drag its title bar. When you do this, blue targets appear
representing the different locations where the window can be docked. Drop the window onto the target of
your choice. Pause over a target to get a preview of where the window will be located if you drop it on that
target. If you want the window to float over the display instead of being docked, don't drop it onto one of the
blue targets.
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In addition to being able to dock a window to the left or right or above or below another docked window, you
can also stack windows on top of each other so they appear as tabs. This is a convenient way to work with
multiple dockable windows. Simply drag one dockable window over another, and you'll see an extra target
appear that enables you to stack them together. In the graphic example below, the Catalog window is being
stacked with the Table Of Contents window:
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You can double-click the title bar of a window to quickly toggle it between docked and undocked. If you've
stacked two or more windows together, you can also double-click the tabs with which they are shown to
toggle between their being docked and undocked. This is useful, for example, if you normally work with a
particular window docked but want to quickly pop it out to be a larger, floating window.

More windows are now dockable

GIS is about working with maps and their attributes together. ArcGIS 10 allows you to dock windows that
show the attributes of your layers next to your map so that they don't cover up your map. Table windows,
the Identify window, and the Attributes window (launched from the Editor toolbar) are now dockable. If you
open multiple tables, they are all automatically displayed inside the same Table window, making it easier
to manage them together in your display. Each table is shown as a tab at the bottom of the Table window,
and you can also drag and drop these tabs so you can view the tables side by side.

Learn more about working with tables in ArcGIS 10

Table of contents

In ArcGIS 10, the table of contents has been enhanced to add two additional views for working with your
data. These two new views are in addition to the existing display and source views. You choose the table of
contents view you want to work with using the new buttons at the top of the Table Of Contents window
instead of tabs at the bottom of the window, like in previous versions.

• List by Visibility: This groups layers based on whether they are currently visible, out of scale
range, or not visible (turned off). This view shows you the data type of each layer via an icon next to
each layer. You can click this icon to turn the layer on or off.
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• List by Selection: This groups layers based on whether they have features currently selected,
selectable but have no feature currently selected, and not selectable. It replaces the Selection tab in
previous releases. This view shows you the data type of each layer via an icon next to each layer.
You can click this icon to make the layer selectable.

Learn more about working with the table of contents in ArcGIS 10
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What's new for accessing your data in ArcGIS 10
Catalog window

When you work with ArcGIS, you work with a catalog of data. In ArcGIS 10, the catalog is now integrated
into ArcMap as a dockable window. If you have the 3D Analyst extension, you'll also see the Catalog
window in ArcGlobe and ArcScene. The Catalog window provides most of the functionality of the separate
ArcCatalog application but in a compact, convenient window. The ArcCatalog application is still included in
ArcGIS 10 if you want to use it, but for most data management and access tasks, using the Catalog window
instead is a huge time saver.

Using the new window, you can browse your catalog, drag data into your map, manage data, create data,
and so on. Using the Catalog window to add or browse to data and drag it into your map is faster than using
the Add Data dialog box, and using the window for data management eliminates many of the issues that
have been experienced in previous releases when trying to modify data in ArcCatalog that is being used in
ArcMap.

Easy access to your project workspaces

When you do a GIS project, you assemble spatial data, map documents, layer files, toolboxes containing
models, and other supporting files into a folder, often known as a project workspace or home folder. When
you work with a map in ArcGIS 10, it is easy to get to the project workspace the map belongs to, because
that folder is always shown at the top of the Catalog tree as an entry called Home. The project workspace
for any map document in ArcGIS 10 is regarded as simply the folder in which that map document is
located, so you'll always have immediate access to that folder in the Catalog window. When you look at
the Home folder in the Catalog window, the current map document you are working with is shown in bold.
If you browse to a different folder in the Catalog window or connect to a database or server, you can
always get directly back to the Home folder your map belongs to by clicking the Home button. This makes
it much easier to access the data and other files related to your map than in previous versions. You'll also
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see this Home button on the dialog boxes used to open or save data, so that you can quickly get to
your map's home folder.

Clicking this button will navigate the Catalog window to the map's Home
folder.

Default geodatabase

In addition to the Home folder, which is the GIS workspace your map document belongs to, every map
document in ArcGIS 10 also now has a default geodatabase. The default geodatabase is simply one that
is specified as the default for the map document. It is easy to access this default geodatabase, because
there is a button at the top of the Catalog window and in the dialog boxes for adding and saving data
that you can click to go directly to that geodatabase. The default geodatabase is also used as the default
output target for many operations that create data. You can specify the default geodatabase when you
create a new map document. You can also set the default geodatabase for an existing map via the File >
Map Document Properties dialog box or by opening the map in ArcMap, right-clicking the geodatabase
in the Catalog window, then choosing the Make Default Geodatabase command.

Default ready-to-use project workspace created in Documents\ArcGIS

When you use ArcGIS 10, it creates a default ready-to-use project workspace in your Documents >
ArcGIS or My Documents > ArcGIS folder (depending on which version of Windows you are using). This
gives you an immediate default location in which to do GIS work without having to manually create a
project workspace elsewhere. This default project workspace contains an empty file geodatabase,
Default, that is used as the default geodatabase for new and existing map documents (unless you specify
a different default geodatabase). It also contains an empty toolbox ready for you to save geoprocessing
models or custom geoprocessing tools into. Of course, you can do your work in any folder in any location
on your system when you work with ArcGIS 10, but the default project workspace provides a convenient
default in an obvious and easily portable location.

Learn more about the Catalog window
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Simplified layer file icons

In ArcGIS 10, the way layer (.lyr) files appear in the Catalog window has changed. In previous releases,
layer files were shown using a set of icons that reflected the data type of the data source, such as point,
line, polygon, group, raster, or service. At ArcGIS 10, all .lyr files are shown with a single generic yellow
icon in the Catalog tree, regardless of their data type. A benefit of this change is that you see fewer
different icons when browsing the Catalog tree, and layer files are always shown with the same generic
icon in the Catalog window, Windows Explorer, Outlook e-mails, and the ArcGIS.com Web site.

Search window

The Catalog window is great if you know where your data is located, but what if you don't? Previous
versions of ArcGIS had a search function in ArcCatalog, but it was slow, wasn't very convenient, and
couldn't handle large volumes of data. In ArcGIS 10, there's a new Search window in ArcMap and
ArcCatalog and, if you have the 3D Analyst extension, ArcGlobe and ArcScene. The Search window puts all
your GIS resources instantly at your fingertips via a fast, Web like, and highly scalable search. You can
search for maps, data, and tools on your local machine, drives on your network, and enterprise databases.
You can also search enterprise search services. These search services, which are introduced at ArcGIS 10,
enable organizations using ArcGIS Server 10 to serve a complete enterprise catalog of data throughout the
organization. You can also extend your search outside the enterprise by searching ArcGIS.com online maps
and data published by Esri and the GIS community. All this is possible from a convenient compact window
you can expand or permanently dock inside the application.

Pausing on the map document displays its item description.

Searches can be refined progressively. For example, you might first search for all feature data, then restrict
the search just to polygon data, then shapefile data, then data for a particular location, so your resulting
search string feature polygon shapefile lets you focus quickly on a specific set of data. You can immediately
drag search results into your map or a model. You can also click the path shown in the search results to be
taken to the location of the data in the Catalog window.

Configurable indexing lets you choose exactly what is searched and automatically assemble and prepare
the metadata used in the search. You can search based on name, path, smart built-in keywords, and
descriptive metadata. You can also immediately edit the descriptive metadata for items you find to, for
example, add tags to make them easier to find next time.

Learn more about the Search window
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What’s new for map templates in ArcGIS 10
Beginning with ArcGIS 10, ESRI no longer supports map templates (.mxt) files for use with the Select
Template and Getting Started dialog boxes. These dialog boxes have been updated to work with map
document (.mxd) files in place of .mxt files.

The Getting Started dialog box

When the application is first opened, you can open a recently used document, a blank document, or create a
new document from a template. To create a new, blank map, select New Maps, and select the Blank Map
item listed on the right. Select your default geodatabase for the map and click OK.

Alternatively, create a new map from a map template. A map template is a map document (.mxd) from which
new documents can be created. Templates may contain basemap layers or be a variety of commonly used
page layouts. When you create a new document from a template, an untitled map is opened based on the
selected template. These templates are listed under the My Templates node under New Maps. You can
create new templates by saving map documents in your user profile that only you will see. Add user-defined
categories (folders) and map document templates to the following location:

C:\Users\<user>\AppData\Roaming\ESRI\Desktop10.0\ArcMap\Templates
Alternatively, you can create templates for all users of the system listed under the Templates node under
New Maps. By default, system templates are located in the ArcGIS installation directory; however, the
ArcMapAdvancedSettings.exe can be used to change the default location. This application is located in the
Utilities folder of your ArcGIS installation directory. System templates are initially located in the following
location by default:

C:\Program Files\ArcGIS\Desktop10.0\bin\Templates

Open existing maps, or create new maps from the Getting Started dialog box.
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New categories for templates are made available by creating folders beneath the templates folder locations.
Categories will only appear in the Getting Started, New Map, and Select Template dialog boxes if a map
document is present in the folder under the Templates or My Templates locations.

Tip: To create multiple System template locations, you can modify the following
registry key, separating folders with a semicolon (;).
HKEY_LOCAL_MACHINE\SOFTWARE\ESRI\Desktop10.0\ArcMap\Settings\TemplateDir
C:\Program Files
(x86)\ArcGIS\Desktop10.0\Bin\Templates;E:\More System
Templates

The Select Template dialog box

The Select Template dialog box has been updated to work with map document templates. Similar to the
Getting Started dialog box, user and system templates are available when changing your page layout. New
templates are available in the Select Template dialog box from the same user profile and system location
used by the Getting Started dialog box.

Change your page layout with a user-defined template under My Templates or a system template from Templates.

Customizing the user interface

With ArcGIS 10, map documents referencing map templates (.mxt) files for configuring user interfaces is no
longer supported. ArcGIS 9.3.1 map documents referencing .mxt will continue to work at ArcGIS 10;
however, you cannot create new .mxt files or modify existing .mxt files for saving user interface
customizations.

See About customizing the user interface for more information.
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Converting existing map templates (.mxts) to map documents

To convert your .mxt files, open the file from the Catalog window as an untitled map document and save it
to the file system.
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What's new for sharing maps and data in ArcGIS 10
Easy access to maps and data from ESRI and the GIS community

ArcGIS.com is ESRI's online repository for GIS data. It includes maps and data published both by ESRI and
the GIS community. Using ArcGIS.com is free. You can access online basemaps and downloadable data.
You can also use ArcGIS.com as a repository for maps and data that you want to share with others. You
can upload and share your maps and data with everyone, or just with the members of private groups.

ArcGIS.com is built into ArcGIS 10. You can access maps and data in ArcGIS.com, upload maps and data
to it, and manage your ArcGIS.com account entirely from within ArcGIS Desktop without having to launch a
Web browser or know which Web sites to visit. You can launch the new ArcGIS Online dialog box in ArcMap
with the File > ArcGIS Online command. You can also launch this dialog box using the new Add Data From
ArcGIS Online command with the Add Data menu button on the Standard toolbar:

This dialog box lets you browse and search for maps and data. In ArcGIS.com, you can find map services
(live maps being served via ArcGIS Server); layer packages (LPK files); and map packages (MPK files),
which are new in ArcGIS 10. You can also search for groups, which are collections of items, and browse
their content. ArcGIS.com groups are created by particular organizations, project teams, or interest groups.
The data in groups may be accessible to all or restricted to members of the group.
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You can sign in to your ArcGIS.com account, or create an account, using the File > Sign In command or the
Sign-In link on the ArcGIS.com dialog box. By signing in, you'll be able to create and join groups and access
maps and data in any private groups you belong to. You'll also be able to upload your own data into
ArcGIS.com and share it with others. For example, suppose your agency is involved in a project with several
other agencies. You can create an ArcGIS.com group for this project and invite people from those agencies
to join it. All members of the group can upload data into it and choose whether their data will be available
publically or only to other members of the group.

In addition to being able to search ArcGIS.com via the dialog box shown above, you can also search
ArcGIS.com using the new Search window in ArcGIS Desktop. The Search window, described in What's
new in ArcMap basics at 10, puts all of ArcGIS.com at your fingertips in a convenient dockable window. For
example, you can use it to search for particular data on your local system, then extend that search out to
ArcGIS.com.

Improved layer packages

Layer packages (LPK files) were introduced in ArcGIS 9.3.1 to make it easy to share data with others. A
layer package combines a layer file and the data source it references in one easy-to-use file. Layer
packages have been improved in ArcGIS 10 including more complete validation of layers that you package
to ensure that they work correctly when they are unpacked. Layer packages created in ArcGIS 10 can be
shared with people using 9.3.1 or 10. You can also create layer packages that just contain the schema of
the data they reference, which can then be used by others as templates for creating new datasets using the
layer properties, such as symbology, and schema of your original layer.

When you right-click a layer, group layer, or set of selected layers and choose Create Layer Package, you
get the option to immediately upload the package into your ArcGIS.com account and choose how it will be
shared.

Learn more about creating layer packages

New map packages

Map packages (MPK files) make it easy to share complete map documents with others. A map package
contains a map document (MXD file) and the data referenced by the layers it contains, packaged into one
convenient, portable file. Map packages can be used for easy sharing of maps between colleagues in a
work group, across departments in an organization, or with any other ArcGIS users via ArcGIS.com. Map
packages have other uses, too, such as the ability to create an archive of a particular map that contains a
snapshot of the current state of the data used in the map. To create a map package, use the new File >
Create Map Package command in ArcMap. Before packaging a map, be sure to enter descriptive
information about it in the File > Map Document Properties dialog box. This information is built into the
package and is accessible to others when you upload your map package into ArcGIS.com.

Learn more about creating map packages
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What's new for symbols and styles in ArcGIS 10
Finding appropriate symbols to apply to your features and graphics is easy in ArcGIS 10 because you can
search for symbols without knowing in which style files they are stored. You can search from within all the
styles that are installed with ArcGIS 10, or you can limit search results by referencing just the styles you want
to work with.

Each symbol now has searchable tags that describe its graphic characteristics, such as its color or type.
These tags can be modified in your own custom styles to describe any relevant aspect of the symbol, such as
a related project, map, layer, scale, or specification.

Learn more about searching for symbols

You can arrange the way that symbols are organized in the Symbol Selector dialog box. You can group
symbols by the style file in which they are contained or by their category. You can emphasize the appearance
or the title of a symbol by choosing icon view or list view, respectively. Pausing the pointer over a symbol on
the Symbol Selector dialog box opens a pop-up that lists relevant information for each symbol. You can
resize the Symbol Selector dialog box to see more symbols at once.

Symbol tags

To return useful search results, each symbol contains descriptive tags. Tags are strings that identify key
information about each symbol. They can include references to the appearance of a symbol, its origin, its
usage, or any combination of those. Tags contain ASCII characters and can be up to 255 characters long.

The styles that are installed with ArcGIS 10 are read-only; they cannot be modified from within ArcMap,
ArcGlobe, or ArcScene. The tags on the symbols in these styles are prepopulated to reflect the graphic
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properties of the symbols, such as the primary color, the symbol type, and the font that it was built from in
the case of a character marker.

When custom styles are created or referenced in ArcGIS 10, tags are added to the symbols within the style.
These can be edited as necessary on the Style Manager dialog box. Tags can be entered directly when you
save a new symbol from within the Symbol Selector dialog box using the Save As button. Here, you can
also choose a specific style to save the symbol into.

You can also add or modify symbol tags from the report view of the Style Manager dialog box:

Referencing styles

Map documents reference one or more styles. By default, your personal style and ESRI.style are
referenced, but you can change this set by referencing other styles. You manage the referenced set from
the Style References dialog box, accessible from both the Symbol Selector dialog box and the Style
Manager dialog box. The Style References dialog box lists all the styles that are in the current style
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directory (by default at <installation path>\ArcGIS\Desktop10.0\Styles). You can browse to a
custom style to reference it, or create a new style from this dialog box.

If you want to define exactly which styles are referenced each time you open a new map document, choose
those styles on the Style References dialog box, then click the Set as Default List button. New map
documents will open referencing this set of styles.

Learn more about referencing styles in a map document

Style management

The Style Manager dialog box is now accessible directly from the Customize menu.

The Style References command that was accessible from the Tools > Styles menu in previous releases
has been superseded by the Style References dialog box accessible from the Symbol Selector dialog box
and the Style Manager dialog box. The Export Map Styles command is no longer available directly in the
user interface. You can access it from Customize > Customize Mode > Commands > Tools.

Like the Symbol Selector dialog box, the Style Manager dialog box is now resizable, making it easier to
view many symbols at once. The report view has an additional column when a symbol (marker, line, fill, or
text) table is selected, allowing you to view the tags of each symbol and modify them if the style is not read-
only. ESRI-provided styles are read-only, but you can copy symbols from them to paste into other styles.
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Learn more about managing style contents
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What's new for map display and navigation in ArcGIS
10

Basemap layers

Basemap layers are a kind of map layer that provides a framework onto which you display your dynamic
operational information. Basemap display performance is very fast. Since basemap layers are relatively
static and do not change frequently, their display can be computed once and reused many times. The first
time you visit an area at a particular map scale, basemap layer display is computed. The display is recalled
on return visits to that area and map scale.

This static nature can be advantageous enabling basemap layers to use optimized map display. For
example, ArcMap can compute the map display once and then re-use it each time you pan and zoom your
map.

Learn more about basemap layers

Creating a basemap layer

First, design your basemap layers. Identify layers that are a relatively static part of your map display. Also,
think about using scale-dependent drawing. This requires a map design that considers how the map is to
be portrayed at each map scale.

1. Once you have your map design, create each map layer in ArcMap following the normal steps.

2. Add a new basemap layer to your map. Right-click the data frame name in the table of contents
and click New Basemap Layer.

This adds a new basemap layer in your table of contents. The basemap layer behaves much like
a group layer in that you can drag content into it.
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3. Select the layers that will comprise your basemap and drag them into the basemap layer.

4. Rename your new basemap layer.

Once you have set this up, each time you display your map, the basemap layers are drawn using
optimized map display logic. Other layers are drawn dynamically to access the latest updates from their
data sources.

Basemap layers and accelerated raster layers can be used in concert with hardware acceleration to
enable very high performance, continuous, smooth display as you pan and zoom your map. Turning on
hardware acceleration in your ArcMap session takes advantage of your graphics card processing to
further enhance performance. Hardware acceleration will not have any effect on your map if you are not
using basemap or accelerated raster layers. You can turn hardware acceleration on and off on the
ArcMap Options dialog box.

QuickPan mode

You can continuously pan and zoom maps that contain basemap layers and accelerated raster layers using
special mouse movements as follows:

1. Place the pointer anywhere in the data frame.

2. Press and hold the middle mouse button or the Q key. Initially, the pointer appears as the active pan
icon . After a few seconds, the pointer changes to the continuous pan cursor .

3. Continue to hold down the middle button and navigate the map by dragging in the direction that you
want to pan your map. The map continuously pans in that direction. As you pan, the pointer changes
to an arrow pointing in the panning direction .

Tip: Press the CTRL key to speed up map panning and the SHIFT key to slow
panning down.

The basemap layers pan continuously and relatively smoothly while you are panning the map. The rest of
the map layers are redrawn once you release the middle mouse button.
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Scale settings

The Scale Settings dialog box now gives you the ability to limit the scales displayed while navigating the
map. It also contains presets for common Web map schemas such as ArcGIS.com, Bing Maps, and Google
Maps.

Learn more about scale settings

Less redrawing in data view

In previous versions of ArcMap, if you changed the size of the ArcMap display while working in data view,
either by resizing the ArcMap window or by docking/undocking/resizing a dockable window, by default your
map was completely redrawn to fit inside the available display area. So the scale changed and the extent
stayed the same (although you may have seen some extra geographic coverage based on how well the
extent fit inside the new shape of the display area). At version 10, the default drawing behavior in data view
has been changed so that when the display size is changed, your map is no longer completely redrawn to fit
inside the display. Instead, the scale stays the same and the extent will change. If you make the display
bigger, you'll see a larger geographic extent, and vice versa.

This has the performance advantage that the portion of the display unaffected by resizing doesn't need to be
redrawn at all. For example, if you close a docked window, only the portion of the display that was obscured
by the window needs to be redrawn. It is also easier to work with the display because geographic features
on your map don't move around as you dock and undock windows. Features on your map remain in the
same location in the display until you manually pan or zoom the map.

In previous releases, the Data View tab on the ArcMap Options dialog box contained an option that let you
choose the redrawing behavior for your map document when the size of the display area changed. This
option has been removed at 10 to ensure that all map documents opened or created in 10 benefit from the
enhanced performance of the new default, irrespective of how this option was set in your map in previous
versions.
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What's new for representations in ArcGIS 10
New geometric effects

There are two new geometric effects for modifying line geometry.

Learn more about geometric effects.

Jog Effect

The Jog effect creates a dynamic line with a jog of specified angle, position, and width in the line.

Arrow Effect

The Arrow effect creates a dynamic line along a line feature with an arrow of a specified style and width.

Position property

The Position property is new for the Dashes geometric effect and the Along Line, Randomly Along Line,
Along Outline, and Randomly Along Outline marker placement styles. Currently, all repeating patterns
start at unit zero, and the position property gives you a mechanism to indicate where a pattern should begin
to be displayed for a feature. This is especially important for synchronizing the placement of markers in
relation to dashed lines.

Learn more about geometric effects.

Learn more about marker placement styles.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 96

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//008t0000002r000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//008t0000002r000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//008t0000002n000000


Representation layer enhancements

When a feature class that has a representation is added to a map in ArcMap, the layer is automatically
symbolized with that representation. If more than one representation is available on the feature class, the
first is used. You can choose to display layers using any of the display options using the Layer Properties
dialog box, however.

When a layer is displayed with a representation, you can show the integer value of the Rule ID, or you can
now show the number of features in the layer that are following that rule by checking Show Feature
Countfrom the Rule Options menu.

Learn more about working with representation rule settings.

Representation editing enhancements

You can now move selected feature representations a set distance at a given angle using the Distance
option on the Move dialog box accessed from the shortcut menu ofMove tool tool.
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Learn more about moving feature representations

Similarly, selected elements in representation markers can be sized specifically from the Set Size dialog box
which is accessible from the shortcut menu of the canvas on the Marker Editor dialog box.

Learn more about the Marker Editor.

Improved warning messages for customization

Representation rules can include geometric effects and marker placement styles. Many are provided with
ArcMap, but custom versions can easily be created as well. In the event that a representation rule is
referencing a custom component that is not currently accessible, you will now be shown the name of the
missing component in order to help you find the missing component.

Learn more about geometric effects.

Learn more about marker placement styles.
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What's new for page layouts and data frames in
ArcGIS 10

Data Driven Pages

Data Driven Pages give you the ability to generate multiple pages by taking a single layout and iterating over
a set of map extents. The extents are defined by the features in an index feature layer. This can be any
feature layer, point, line, or polygon. Attributes from the index layer can be used to define page names, page
numbers, scale, rotation angle, and coordinate system. Print and export now includes the ability to print your
data-driven pages and export to a multipage PDF document. Geoprocessing tools are provided to automate
the generation of an index layer, either as a rectangular grid or as a strip map, following a linear feature.
Geoprocessing tools are also provided to calculate coordinate system information, such as central meridians
and UTM zones; to populate neighboring page fields; and to calculate the true north rotation angle for each
feature in the index layer.

Learn more about Data Driven Pages

Dynamic text

The layout text element has been enhanced to recognize dynamic tags for system properties such as date
or time; map properties, such as document path or date saved; data frame properties, such as coordinate
system or rotation angle; and data-driven page properties, such as page number or page name. Common
Dynamic Text properties are available through the Insert menu, and additional tags are available for more
properties and formatting options and can be simply entered in a layout text element.

Learn more about dynamic text
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Data frame options

Several data frame property enhancements have been made to support data-driven page workflows. The
Extent Rectangle has been updated to the Extent Indicator. In overview diagrams, in addition to the simple
rectangular geometry, the Extent Indicator can use the shape of your data-driven page index feature to
highlight the current page extent.

Learn more about using extent indicators
Clip to Shape has a new option to allow you to exclude individual layers. This allows you to only clip the
layers you specify while the excluded layers will continue to draw over the entire extent. Clip to Shape also
includes a new option for clipping the data frame grids to the extent of your feature. Grid features are clipped
to the extent, and grid labels follow the outer extent of the feature.

Learn more about clipping the Data Frame
New data frame extent options make it possible to synchronize the extent of additional data frames with the
extent of a data frame setup with data-driven pages. This makes it possible to have overview diagrams or
adjoining page diagrams that follow the extent of the data-driven pages. This makes it possible to have
multiple data frames that maintain a synchronized extent, so you can set up maps with more than one data
frame—one with imagery, for example, and one with vector data—and the extent can be set to the current
extent in both data frames simultaneously.

Learn more about customizing your map extent
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What's new for automating map workflows in ArcGIS
10

Map automation with Python and arcpy.mapping

Geoprocessing has been extended to take into account maps, layouts, and layers through Python scripting.
By combining this new scripting functionality with the new Data Driven Pages support, you can use ArcGIS
10 to automate many of your common map and output related workflows. For example, you can create a
complete PDF map book by combining a title page, multiple map pages, tabular reports, contact lists, or
other information. Because you can access the layout elements and properties via a script, you can author a
map in ArcMap, write your own production applications for making changes to the text and placement of
page elements, then automate the output (exporting or printing). And because it is part of the geoprocessing
framework, you can even deploy your script as an ArcGIS Server geoprocessing service, allowing any user
in your organization or over the Web to produce maps or map books.

Through Python, you also can interact with map documents in batch, which allows you to perform a wide
variety of map and layer management tasks. Some examples include updating symbology and layer
properties on a group of maps, creating a list of maps that have layers referencing a certain data source,
updating and repairing layer data sources, and saving map documents to prior versions. All these operations
can be performed in batch for a large number of files, automating tedious tasks and allowing you to focus on
your important creative and analytic work.

Learn more about automating map workflows
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What's new for temporal data in ArcGIS 10
ArcGIS 10 has a new experience for working with temporal data. Temporal data is data that represents a state
in time, such as the land-use patterns of Hong Kong in 1990, or total rainfall in Honolulu on July 1, 2009.
Temporal data is collected to analyze weather patterns and other environmental variables, monitor traffic
conditions, study demographic trends, and so on.

Learn more about temporal data

In ArcGIS 10, you can visualize your temporal data using a simple workflow of authoring time properties on a
layer and visualizing the data over time using a simple and easy-to-use time slider. Besides visualizing these
temporal maps, you can also publish these maps to ArcGIS Server.

Enabling time on data

Once you have added your temporal dataset in one of the ArcGIS Desktop applications (ArcMap, ArcGlobe,
or ArcScene), the time properties of the data must be set on the Time tab of the Layer Properties dialog
box. Time properties can be enabled on the layer by checking Enable time on this layer on the Time tab of
the Layer Properties dialog box. The time properties are set based on how the time information is stored in
the data.

Learn more about the supported temporal data

Learn more about setting time properties on a layer
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Visualizing temporal data using the Time Slider

The Time Slider window provides controls that allow you to visualize your temporal data in the ArcGIS
Desktop applications (ArcMap, ArcGlobe, and ArcScene). You can open the Time Slider window by clicking
the Open Time Slider Window button on the Tools toolbar. The button is unavailable if you do not have a
time-enabled dataset in your map, globe, or scene.

Learn more about using the time slider

Serving time-enabled data

Layers authored with time information can be published to ArcGIS Server. These time-enabled map services
can then be consumed by client applications, such as ArcMap, or in Web applications.

Learn more about serving time-enabled data

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 104

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//005z0000000z000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00530000003v000000


What's new for animations in ArcGIS 10
Animations make your documents come alive by storing actions so they can be replayed as you choose. They
can help you visualize changes in perspective, changes in the document's properties, and geographic
movements. Use animations to understand patterns in data and to automate the processes that would be
undertaken to demonstrate points that can only be made through visual dynamics.

Time animations

Visualizing temporal data over time allows you to observe patterns or trends that emerge in your data as
time passes. For example, you can visualize how the ocean temperature varies over time or observe the
patterns in population growth over time. In ArcGIS 10, a time animation allows you to visualize such
changes in your temporal data over time. Time animations control the time of the display (map, scene, or
globe) based on which features, table rows, or rasters in a time-enabled layer are drawn.

Time animations can be played along other tracks, such as the camera track, to create dynamic visual
effects. For example, if you want to create a camera flyby while visualizing your data over time, you should
create a Time animation track to alter the time of the display (map, scene, or globe) and a Camera
animation track to move the camera. These two tracks can then be played together using the animation
controls.

Caution: • A time animation is very similar to what you can achieve using the
new Time Slider tool on the Tools toolbar. If you are strictly
interested in visualizing temporal data, you should use the new Time
Slider tool. However, if you want to create a dynamic animation
wherein you are moving the camera while the temporal data is being
updated, you should consider creating a time animation.

• The Time Layer Animations supported in ArcGIS 9.x are no longer
supported. If you open a map, scene, or globe document containing
Time Layer Animation tracks, these tracks are automatically
converted into the new Time Animation tracks.

Learn more about creating a time animation
Learn more about using the time slider

Exporting animations as sequential images

In ArcGIS 10, you can export an animation as sequential images. Sequential images are a series of
animation stills. Imagine it as undoing your animation into a comic book of one-by-one images. The
supported output image formats to which you can export your animations are Windows Bitmap (*.bmp) and
JPEG (*.jpg).

The output sequential images can then be used as input frames to create videos (AVI or QuickTime format)
using the Raster To Video geoprocessing tool. Also, you can use the output images to other video formats
(not supported in ArcGIS) in third-party video creation software. The exported sequential images can be
edited before being processed as videos. For example, you can add titles or captions to the images.
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Learn more about exporting an animation as sequential images
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What's new for selection tools in ArcGIS 10
Selection tools

In addition to the Select By Rectangle tool, four new tools have been added at ArcGIS 10 for working with
selections. You can now select by polygon, lasso, circle, and line. When using the Select By Line and
Select By Polygon tools, you must double-click or use the ENTER key to apply the selection. For the
Select By Lasso and Select By Circle tools, you click and drag the tool to define the size of the selection
extent.

In ArcGIS 10, the selection tools also respect the snapping environment. This can be particularly helpful
when using the Select By Circle tool to create a selection at a specified distance around a point. To specify
a selection distance, click and drag out a circle and press the R key to bring up the radius dialog box. Enter
a radius value and press the ENTER key.

Learn more about selecting features interactively
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What's new for graphing in ArcGIS 10
You can create graphs in ArcGIS Desktop applications to visualize and explore data. With a graph, it is easy to
quickly compare features and gain insight into the functional relationship between the features, thereby
visualizing the distribution, trends, and patterns in the data that otherwise would be difficult to see.

Graphs menu

The Graphs menu is accessed from the View menu on the Main Menu bar.

New graph types

In ArcGIS 10, three new graph types are supported for creating graphs.

Bubble graphs

Bubble graphs are like scatterplot graphs, except that they allow an additional size variable to be
incorporated into the graph. Essentially, this is like charting three variables in two dimensions. The
bubbles are represented by markers that vary in size, indicating relative importance. In the example
below, three variables—Total Population (y-axis), Percentage of Urban population (x-axis), and
Population with AIDS (size of bubble)—are graphed.

Learn more about creating Bubble graphs
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Polar graph

A polar graph is essentially a line graph drawn on a circular form that can show trends in data values by
means of angles. Polar graphs are useful primarily in mathematical and statistical applications. These
graphs are used to display variables that vary based on direction. You can plot multiple datasets on the
polar graph, where each dataset is represented by a single line. In the example below, the total area in
each flow direction of water has been represented on a polar graph. In this case, most of the area has a
slope from west to east, which means that in case of a rainfall event water will tend to flow east.

Learn more about creating Polar graphs

Bar min and max graph

Bar min and max graphs are used to display the minimum and maximum values associated with your
geographic data. For example, you can display the minimum and maximum streamflow discharge values
at different gauging stations at a particular point in time along a stream or river. Like a bar graph, the bar
min and max graph is used to display discrete data in separate columns, except that the columns are not
grounded on the x-axis but rather start at the minimum value and end at the maximum value. Bar min and
max graphs compare amounts to each other but add the ability to visualize the minimum and maximum
value of the series.

Learn more about creating Bar Min and Max graphs

Geoprocessing tools for creating and saving graphs

In ArcGIS 10, you can create graphs using geoprocessing tools found in the Graph toolset in the Data
Management toolbox. These tools (Make Graph and Save Graph) can be used one at a time or chained
together in a model or script to create a graph of the desired type.

Learn more about creating graphs using geoprocessing tools
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Graphs in ArcGlobe and ArcScene

In ArcGIS 10, graphs can be created in the ArcGlobe and ArcScene applications. Graphs can be saved
within the 3D documents or saved as graph files. You can also use the Graph Manager to manage the
graphs in these applications.

Learn more about creating graphs in ArcGlobe and ArcScene
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What's new for reporting in ArcGIS 10
Reports menu

The Reports menu is accessed from the View menu on the main menu bar.

Note: Starting at ArcGIS 10, the Crystal Reports Wizard is no longer included in
ArcMap.

Report wizard

The Report Wizard steps you through the report creation process. Within the wizard, you have the ability to
set the major properties of the report, like choosing the fields, grouping, sorting, orientation, and style. To
launch the Report Wizard, click Create Report from the Reports menu.

The wizard includes new graphics and a new user interface, making it easier to create reports in ArcGIS.
New in ArcGIS 10 is the option to choose the layout or style of the report from a preset list. When working
with fields, there is no limitation to the number of fields you can sort.

Report viewer

The Report Viewer allows you to preview your report. The viewer generates the entire report and includes
buttons and a contents view of the report for easy exploration and navigation of the report by page. You can
also save, export, and add the report to the layout of your map from the Report Viewer.

The viewer is new to ArcGIS reporting and includes a number of commands for easily searching and
navigating through the pages of your report. You can draw annotation or graphics on the report to highlight
some aspect of the report. Reports can be exported to more formats than ever before, including PDF, HTM,
RTF, TIFF, XLS, and TXT.

Report designer

The Report Designer allows you to modify the properties of your existing report. In the Designer, you can
change properties of the report, like style or printer settings, along with the individual properties of specific
design elements, like font color and size of a footnote.
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The Report Designer is a new user interface that allows you to modify and customize every detail of the
report. You can access the Style Manager from the main toolbar so that you can create custom styles. You
can save report layout files when using the designer. These files can be used to rerun the report or use an
existing report as a template for new reports.
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What's new for geoprocessing in ArcGIS 10
Background processing

Geoprocessing tools now execute in a background process, allowing you to continue working with the
application (ArcMap, ArcCatalog, ArcScene or ArcGlobe) as the tool executes.

Learn more about background processing

Search and Catalog window

ArcToolbox functionality has been replaced by the Search window, the Catalog window, and the Results
window. The ArcToolbox window is still available in ArcGIS 10 but the primary method for finding and
running tools is with the Search window which is an index of geoprocessing tools developed at ESRI as well
as your own custom tools.

Learn more about using the Search and Catalog window to find tools

Geoprocessing menu

A new Geoprocessing menu has been introduced to the standard toolbar. This menu contains all the
options for configuring the geoprocessing system as well as six commonly used tools.

Tools can be added to menus

You can easily add tools to the Geoprocessing menu or any menu or toolbar to quickly access your favorite
tools. You can even add your own Models and Script tools to the application user interface through this new
functionality.

Learn more about adding tools to menus and toolbars

Python window replaces the Command Line window

The Python window is where you can execute tools in command line style environment. The Python
window replaces the Command Line window from previous releases. The Command Line window allowed
you to run geoprocessing tools and modify geoprocessing environment setting. The Python window can be
used to run tools and set environments like the Command Line did, but it also allows you to access the
arcpy scripting functionality (list functions, describe data properties, cursors and more), as well as other
useful functionality available in the python language.

Learn more about the Python window

Python and ArcPy

ArcGIS installs Python version 2.6.

All geoprocessing tools, as well as a wide variety of useful functions for interrogating GIS data are available
in the ArcPy site-package. A site-package is Python's term for a library that extends the Python language
with additional functionality. The ArcPy site-package is how ArcGIS delivers GIS functionality to Python. The
ArcPy site-package is installed with ArcGIS automatically. You can think of ArcPy as replacing
arcgisscripting in your Python code.
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ArcPy contains two important modules: the mapping module (arcpy.mapping) for interacting with ArcMap
and creating map books, and the spatial analyst module (arcpy.sa) for performing map algebra. A third
module, geostatistical analyst, contains classes for setting up complex neighborhood searches.

Learn more about ArcPy

Password protection for model and script tools

With ArcGIS 10, you can protect your models and scripts—your intellectual property—with a password. This
prevents the recipients from editing your model and script tool while still allowing them to run it. A password-
protected model or script cannot be viewed. When copying it, the password protection stays intact.

In addition, you can import your .py file into the tool (in fact, you must do this to password protect a script
tool). This means you don't have to deliver a separate .py file for your script tool to work, the .py will be
saved within the toolbox. Once the .py file is imported, you can export it again (as long as you know the
password) in order to modify it.

Related Topics
A quick tour of what's new in ArcGIS 10
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New and improved geoprocessing tools in ArcGIS 10
About this page

This list of new and improved tools excludes those tools which are licensed with an ArcGIS extension.
See What's is new in ArcGIS > ArcGIS extensions book for new and improved geoprocessing tools
found in those extension's toolboxes.

Analysis toolbox

Improved tools
Tool Improvement

Clip
Identity

These tools now support point on point, and line on line overlay.

Buffer These tools now support line features with vertical line segments. For more information, see
Geoprocessing considerations for vertical line segments

Clip

Erase

Identity

Spatial
Join

The tool is able to process much larger datasets and most operations will complete in shorter amount
of time.

Cartography toolbox

Toolset changes

• Annotation toolset: this new toolset contain tools to create and update annotation data.

• Cartographic Refinement toolset: this toolset toolset was named the Symbolization Refinement
toolset in previous releases. The tools remain the same except that the Calculate Geodesic Angle
tool has been deprecated at ArcGIS 10. It has been replaced by the Calculate Grid Convergence
Angle tool in the Data Driven Pages toolset. The Calculate Grid Convergence Angle tool uses an
improved mathematical algorithm for defining this angle. Existing scripts and models that
reference Calculate Geodesic Angle will continue to work, but you should consider modifying your
workflows to take advantage of the Calculate Grid Convergence Angle tool's improved algorithm
instead.

• Data Driven Pages toolset: this new toolset contain tools to create and prepare layers for use in
data driven pages.

• Generalization toolset: this new toolset contains tools that are used to simplify and refine
features for display at smaller scales. This toolset contains three new tools as well as seven tools
that were in the Data Management toolbox prior to the ArcGIS 10 release (Aggregate Polygons,
Collapse Dual Lines To Centerline, Simplify Building, Simplify Line, Simplify Polygon, Smooth
Line, Smooth Polygon).

• Graphic Conflicts toolset: this toolset was named Graphic Quality toolset in previous releases.

• Grids and Graticules toolset: this new toolset contain tools to create and maintain grid and
graticule layers.
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New tools
Toolset Tool Description

Annotation
toolset

Contour Annotation Creates annotation for contour features.

Map Server
Cache Tiling
Scheme To
Polygons

Creates a new polygon feature class from an
existing tiling scheme.

Tiled Labels
To Annotation

Converts labels to annotation for layers in a
map document based on a polygon index
layer.

Data Driven
Pages toolset
(New)

Calculate Adjacent Fields The most common use case for using this
tool is to populate fields that can be used to
label the adjacent pages in a map book.
This tool appends eight new fields (each
field representing one of the eight points of
the compass: North, Northeast, East,
Southeast, South, Southwest, West and
Northwest) to the input feature class and
calculates values that identify the adjacent
(neighboring) polygons, in each cardinal
direction, for each feature in the input
feature class.

Calculate
Central
Meridian And
Parallels

Calculates the central meridian and optional
standard parallels based on the center point of
a feature's extent; stores this coordinate
system as a spatial reference string in a
specified text field and repeats this for a set,
or subset, of features.

Calculate Grid
Convergence
Angle

Calculates the rotation angle for true north
based on the center point of each feature in a
feature class and populates this value in a
specified field. This field can be used in
conjunction with Data Driven Pages to rotate
each map to true north.

Calculate
UTM Zone

Calculates a UTM zone of each feature based
on the center point and stores this spatial
reference string in a specified field. This field
can be used in conjunction with Data Driven
Pages to update the spatial reference to the
correct UTM zone for each map.

Grid Index
Features

Creates a grid of rectangular of polygon
features that can be used as an index to
specify pages for a map book using Data
Driven Pages. A grid can be created that only
includes polygon features that intersect
another feature layer.

Strip Map
Index
Features

Creates a series of rectangular polygons, or
index features, that follow a single linear
feature or a group of linear features. These
index features can be used with Data Driven
Pages to define pages within a strip map, or
set of maps that follow a linear feature. The
resulting index features contain attributes that
can be used to rotate and orient the map on
the page and determine which index features,
or pages, are next to the current page (to the
left and right or to the top and bottom).

Generalization
toolset

Aggregate Points Creates polygon features around clusters of
proximate point features.

Merge Divided
Roads

Generates single line road features in place of
matched pairs of divided road lanes.
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Thin Road
Network

Generates a simplified road network that
retains connectivity and general character to
display at a smaller scale.

Graphic
Conflicts
toolset

Propagate Displacement Propagates the displacement resulting from
road adjustment in the Resolve Road
Conflicts and Merge Divided Roads tools to
adjacent features.

Resolve
Building
Conflicts

Resolves symbol conflicts among buildings
and with respect to linear barrier features by
moving or hiding buildings.

Resolve Road
Conflicts

Resolves graphic conflicts among symbolized
road features by adjusting portions of line
segments.

Grids and
Graticules
toolset (New)

Delete Grids and Graticules Deletes all the features associated with one
or more selected grid and graticule layers
from a feature dataset.

Make Grids
and Graticules
Layer

Creates a grouped layer of feature classes
depicting grid, graticule, and border features
using predefined cartographic specifications.
Grid layers are ideal for advanced grid
definitions which are scale and extent specific.

Improved tools
Tool Improvement

Detect Graphic
Conflict

Layers drawn with standard symbology can now be used as an inputs. Layers drawn with
representations are still supported.

Simplify
Building

The values of the BLD_STATUS field now indicate the following simplification results:

• 1 = a single building has been simplified (no change from ArcGIS 9.3.1)
• 2 = a single building has been simplified to its minimum bounding rectangle (new in

ArcGIS 10)
• 3 = a building smaller than the tolerance squared has been simplified to its minimum

bounding rectangle (changed in ArcGIS 10)
• 4 = [no longer used at ArcGIS 10]
• 5 = a building that has not been simplified (no change from ArcGIS 9.3.1)

Conversion toolbox

Toolset changes

• From KML toolset: this new toolset contains a tool to import data from Keyhole Markup Language
(KML).

• To Collada toolset: this new toolset contains a tool to export to the Collada format.

New tools
Toolset Tool Description

From KML
toolset (New)

KML To Layer Converts a KML or KMZ file into a feature class along with a layer file
derived from the source renderer information inside the KML/KMZ.

From Raster
toolset

Raster To Video Creates a video file from a set of images.
Valid input image formats are Windows Bitmap and JPEG.

Metadata
toolset

Export Metadata Translates ArcGIS metadata to a standard metadata format and saves it as
an XML file
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Export
Metadata
Multiple

Exports
metadata for
many ArcGIS
items.

Import
Metadata

Imports
metadata to an
ArcGIS item,
translating it to
ArcGIS
metadata if
necessary

Synchronize
Metadata

Updates values
in the metadata
to reflect the
current
properties of the
ArcGIS item it
describes

Upgrade
Metadata

Upgrades
metadata
created before
ArcGIS 10 to
ArcGIS
metadata

XML Schema
Validation

Validates an
XML file using
an XML schema

Validate
Metadata

Exports
metadata for an
ArcGIS item,
then validates
the exported
XML file using
an XML schema

Validate
Metadata
Multiple

Validates
metadata for
many ArcGIS
items

To Collada
toolset (New)

Multipatch To
Collada

Converts one or more multipatch features into a collection of COLLADA
files and referenced texture image files in an output folder. The inputs can
be a layer or a feature class.

To Coverage
toolset

Import from E00 Imports an ArcInfo interchange file (.e00). An interchange file is used to
transport coverages, INFO tables, text files such as AML macros, and other
ArcInfo files. For coverages, grids, and tins, it contains all information,
including appropriate INFO table information. Interchange files are
designated with the .e00 file suffix. This is the ArcView 3.x version of the
utility for importing .e00 files.

To
Geodatabase
toolset

CAD To
Geodatabase

Reads a CAD dataset and creates feature classes of the drawing. The
feature classes are written to a geodatabase feature dataset.

Improved tools
Toolset Tool Name Description

Metadata
toolset

ESRI Metadata Translator Many improvements have been made
in how ArcGIS metadata is
transformed to and from the ISO
19139 XML format.

XSLT
Transformation

An optional parameter was added to this tool that
lets you pass a parameter value to the XSLT style
sheet, which can then be used when transforming an
XML file.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 118

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000011000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000011000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000012000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000012000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000016000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000016000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000014000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000014000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000015000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000015000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000015000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000048000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000048000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000049000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000049000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001q000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001q000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000046000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001w000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001z000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000001z000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000r000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000r000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00120000000s000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000017000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001200000017000000


Data Management toolbox

Toolset changes

• Graph toolset: this new toolset contains tools to create and save graphs.

• Package toolset: this new toolset contains tools to package and consolidate layers and maps.

• Raster toolset: new toolsets have been added inside the raster toolset. Many new tools can be
found within those toolsets. Also existing tools that used to be in the Raster toolset have been
moved down into the new toolsets. The new toolsets are Mosaic Dataset, Raster Catalog, Raster
Dataset, Raster Processing and Raster Properties

Improved tools
Toolset Tool Description

Disconnected
Editing
toolset

Create Replica A new parameter has been added to define the
area to replicate based on geometry. Using
this parameter, you can define boundary of the
replica based on a non-rectangular shape such
as a country or state border.
Another new parameter has been added to
can be used where creating a 1 way replica.
Another new parameter has been added to
specify if archiving will be used instead of
versions to determine the changes to send
when synchronizing.

Feature
Class toolset

Create Fishnet A parameter has been added to control if the
output will be polygon or polylines.

Features
toolset

Feature Vertices To Points The point type parameter has a new
DANGLES option. This new option means only
vertices at end of dangling line segments will
be written to the output feature class.

Polygon To
Line

A new parameter was added control if the
output will have unique lines at coindicent
boundaries and left-right neighborhood
attributes OR if the output lines will simply
be individual polygon feature's boundaries
with all attributes.

Layers and
Table Views
toolset

Make XY Event Layer A new parameter was added specify a Z field
from the input table which will be assigned as
Z coordinates to the output points.

Select Layer
By Location

Two new spatial relationships have been
added: INTERSECT_3D and
WITHIN_A_DISTANCE_3D. Also the
algorithm has been improved to process
much larger data and complete these
operations in shorter amount of time.

Save To
Layer File

A new parameter has been added to control
if the lyr file will store a relative path or
absolute path to the source dataset.

Raster\Raster
dataset
toolset

Workspace To Raster Dataset A new parameter has been added to convert
the colormap to a RGB on the output dataset.

Raster\Raster
Properties
toolset

Add Colormap Can now use a CLR (colormap) or ACT
(Adobe color table) file to specify the colormap.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 119

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000000v000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000016000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000028000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000028000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000002q000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000031000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000031000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000003p000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000003t000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000003t000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000006m000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000006m000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000006m000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000006z000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000072000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000072000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000070000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000070000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000009m000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//001700000084000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000009w000000


Workspace
toolset

Create File GDB A new parameter controls which version of
geodatabase will be created, either the current
or a geodatabase from a previous version such
at 9.3 or 9.2.

Create
Personal
GDB

New tools
Toolset Tool Description

Database
toolset

Register With Geodatabase Registers feature classes, tables, and raster
layers that were created outside of the
geodatabase with the geodatabase in order for
them to fully participate in geodatabase
functionality.

Upgrade
Geodatabase

Upgrades a geodatabase to the latest
release to take advantage of new
functionality available in the latest release
of ArcGIS. Valid input is a personal or file
geodatabase or an sde connection file or
connection information for an ArcSDE
geodatabase.

Features toolset Bearing Distance To Line This tool converts a table to two-point lines
based on an x-coordinate field, y-coordinate
field, bearing field, and distance field.

Dice Splits extremely long lines or large
polygons into smaller, more manageable
features.

Minimum
Bounding
Geometry

Creates a the minimum rectangle, circle,
convex hull that will cover the input
feature (or group of input features).

Points To Line Creates line features from points.

Split Line at
Point

Splits line features based on intersection
or proximity to point features.

Table To Ellipse Converts a table containing coordinate
and other required fields to elliptical
polygons

Unsplit Line Merges lines that have coincident
endpoints and, optionally, common
attribute values.

XY To Line Creates a new feature class containing
geodetic two-point polyline features from
a table of start and end points.

Fields toolset Calculate End Time Calculates the end time of features based on
the time values stored in another field.

Convert Time
Field

Converts time values stored in a string or
numeric field to a date field.

Convert Time
Zone

Converts time values recorded in a date
field from one time zone to another time
zone.

Transpose
Fields

Shifts data entered in fields or columns
into rows in a table or feature class.

General toolset Delete Identical Deletes records in a feature class or table
which have identical values in a list of fields. If
the field 'Shape' is selected, feature geometries
are compared.
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Find Identical Reports any records in a feature class or
table that have identical values in a list of
fields, and generates a table listing these
identical records. If the field 'Shape' is
selected, feature geometries are
compared.

Sort This tool reorders, in ascending or
descending order, records in a feature
class or table based on field values. The
reordered result is copied to a new
dataset.

Generalization
toolset

Eliminate Polygon Part Creates a new output feature class containing
the features from the input polygons with some
parts or holes of a specified size deleted.

Graph toolset
(New)

Make Graph Creates a graph as a visual output using a
graph template or an existing graph.

Save Graph Saves a graph to an image, vector, or
graph file.

Layers and
Table Views
toolset

Make Mosaic Layer Creates a temporary mosaic layer from an
mosaic dataset or layer file. The layer that is
created by the tool is temporary and will not
persist after the session ends unless the layer
is saved to disk or the map document is saved.

Package toolset
(New)

Consolidate Layer Consolidates one or more layers by copying all
data and referenced data sources into a single
folder.

Consolidate
Map

Consolidates a map document and all
referenced data sources to a specified
output folder.

Extract
Package

Extracts the contents of a layer or map
package to a specified folder. The
contents of the output folder is updated
with the contents of the input package.

Package Layer Packages one or more layers and all
referenced data sources to create a
single compressed .lpk file.

Package Map Packages a map document and all
referenced data sources to create a
single compressed .mpk file.

Share Package Shares a layer or map package by
publishing to ArcGIS online.

Projections and
Transformations
toolset

Convert Coordinate Notation Converts a table containing point coordinate
fields to a point feature class. The input table's
coordinate fields can be in a variety of
notations, such as GARS, UTM, and MGRS.
The output point feature class also contains
point coordinate fields in a coordinate notation
of your choosing.

Raster\Mosaic
Dataset toolset
(New)

Add Rasters to Mosaic Dataset Adds raster datasets to a mosaic dataset from
many sources, including a file, folder, raster
catalog, table, or Web service.

Build Boundary Generates the boundary polygon for a
mosaic dataset. By default, the boundary
merges all the footprint polygons to
create a single boundary representing the
extent of the valid pixels.

Build Footprints Computes the footprints for each raster
dataset in a mosaic dataset.

Build Overviews Defines and generates overviews for a
mosaic dataset.
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Build Seamlines Automatically generates seamlines for
your mosaic dataset.

Calculate Cell
Size Ranges

Computes the minimum and maximum
cell sizes for the rasters in a mosaic
dataset.

Color Balance
Mosaic Dataset

Color balances a mosaic dataset so that
the tiles appear seamless.

Compute Dirty
Area

Identifies an area within a mosaic dataset
that has changed since a specified point
in time.

Create Mosaic
Dataset

Makes an empty mosaic dataset in a
geodatabase.

Create
Referenced
Mosaic Dataset

Creates a new mosaic dataset from an
existing raster catalog, a selection set
from a raster catalog, or a mosaic
dataset.

Define Mosaic
Dataset NoData

Allows you to specify one or more
NoData values for a mosaic dataset.

Generate
Exclude Area

Allows you to set the exclude area, based
on color mask or histogram percentage.
The output of this tool can then be used
within the Color Balance Mosaic Dataset
tool.

Import Mosaic
Dataset
Geometry

Modifies the feature geometry for
footprints, the boundary, or seamlines in
a mosaic dataset to match those in a
polygon feature class.

Remove
Rasters from
Mosaic Dataset

Removes rasters from a mosaic dataset.

Synchronize
Mosaic Dataset

Rebuilds the raster item and updates
affected fields in the mosaic dataset
using the raster type and options that
were used when it was originally added.

Raster\Raster
Processing
toolset (New)

Raster To DTED Splits a raster dataset into files based on the
DTED tiling structure.

Split Raster Creates a tiled output from an input raster
dataset.

Raster\Raster
Properties
toolset (New)

Build Pyramids and Statistics Traverses a folder structure, building pyramids
and calculating statistics for all the raster
datasets it contains. It can also build pyramids
and calculate statistics for all the items in a
raster catalog or mosaic dataset.

Versions toolset Change Version Changes the version that an input feature layer
or table view is connected to. This tool only
changes the version for the input layer or table
view - other layers or table views are not
affected. The tool has no effect on the version
you are connected to if using feature classes or
tables.

Workspace
toolset

Create ArcSDE Connection File Creates an ArcSDE connection file for use in
connecting to ArcSDE geodatabases.

Editing toolbox (New)

This is a new toolbox contains 7 new geoprocessing tools to do bulk editing and data cleanup.

New tools
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Tool Description

Densify Inserts vertices along line or polygon features. Also replaces curve segments (bezier, circular
arcs, elliptical arcs) with densified line segments.

Erase
Point

Deletes points from the input that are either inside or outside the Remove Features, depending
on the Operation Type.

Extend
Line

This tool extends line segments to the first intersecting feature within a specified distance. If no
intersecting feature is within the specified distance, the line segment will not be extended. Tool
use is intended for quality control tasks such as cleaning up topology errors in features that were
digitized without having set proper snapping environments.

Flip Line Reverses the from-to direction of line features.

Generalize Simplifies the input features using the Douglas-Peucker simplification algorithm with a specified
maximum offset tolerance. The output features will contain a subset of the original input vertices.

Snap Moves points or vertices to coincide exactly with the vertices, edges, or end points of other
features. Snapping rules can be specified to control whether the input vertices are snapped to the
nearest vertex, edge, or endpoint within a specified distance.

Trim Line Removes portions of a line that extend a specified distance past a line intersection (dangles). Any
line that does not touch another line at both endpoints can be trimmed, but only the portion of the
line that extends past the intersection by the specified distance will be removed.

Geocoding toolbox

New tools
Tool Description

Create
Composite
Address
Locator

Creates a composite address locator. A composite address locator consists of two or more
individual address locators that allow addresses to be matched against the multiple address
locators.

Reverse
Geocode

Creates addresses from point locations in a feature class. The reverse geocoding process
searches for the nearest address or intersection for the point location based on the specified
search distance.

Linear Referencing toolbox

Improved tool
Tool Description

Locate Features
Along Routes

A new parameter has been added to specify wheather the offset distance should be
based on the M direction or the digitized direction

Parcel Fabric toolbox (New)

New tools
Toolset Tool Description

Data
Migration
Toolset

Load Topology Loads polygon and line features that participate in a topology into a
target parcel fabric.

Layers and
TableViews
toolset

Make Parcel Fabric
layer

Creates a parcel fabric layer from an input parcel fabric. The parcel
fabric layer that is created by the tool is temporary and will not
persist after the session ends unless the document is saved. This
tool is needed if you would like a parcel fabric sublayer to participate
in a geoprocessing model.
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Make Parcel
Fabric Table
View

The Layers and Table
Views toolset creates
and manipulates parcel
fabric layers, layer file,
and table views.

Parcel
Fabric
Management
toolset

Upgrade Parcel Fabric Upgrades an existing parcel fabric to the latest released version of
ArcGIS. An existing parcel fabric is upgraded to take advantage of
the new parcel editing functionality available in the latest released
version of ArcGIS.

Server toolbox

Improved tool
Toolset Tool Description

Caching
toolset

Create Map
Server Cache

A new parameter has been added to control if the tiles will be stored in
compact or exploded storage format.

New Tools
Toolset Tool Description

Caching
toolset

Convert Map Server Cache Storage Format Converts the storage of a map service cache
between the exploded (pre-10.0) format and
the compact format. The tool converts the
format "in place", meaning it does not make a
copy of the existing format. Instead, it creates
the new format cache in the same cache
folder and deletes the old format.

Export
Map
Server
Cache

Exports tiles from a map cache to a folder on
disk. The tiles can either be imported into other
caches or they can be accessed from ArcGIS
Desktop as a raster dataset, independent from
their parent service.

Import Map
Server
Cache

Imports tiles from a folder on disk into a map
cache. The source folder can be a child of a
registered server cache directory or it can be
some other folder into which tiles have been
previously exported. The target map service
must have the same tiling scheme and the
storage format as the source map cache.

Data
Extraction
toolset

Extract Data Extracts selected layers in the specified area
of interest to a specific format and spatial
reference. The extracted data is then written
to a zip file.

Extract
Data and
Email Task

Extracts the data in the specified layers and
area of interest to the selected format and
spatial reference, zips the data, and emails it to
the specified address. This tool can be used to
create a Data Extraction geoprocessing service.

Extract
Data Task

Extracts the selected layers in the specified
area of interest to the selected formats and
spatial reference, then returns all the data in a
zip file.

Send
Email with
Zip File
Attachment

Emails a file to an email address using an
SMTP email server.

Spatial Statistics toolbox

Improved tools
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Toolset Tool Description

Analyzing Patterns toolset Average Nearest Neighbor The derived
output variables
now include both
the observed and
expected average
nearest neighbor
distances:
NNExpected and
NNObserved.

Multi Distance Spatial Cluster Analysis The optional graphic display has been created as
a line graph file giving users full control to change
graph settings. This graph file is temporary until
saved by right-clicking on the graph and selecting
the Save option.

Average Nearest Neighbor The Display Results Graphically parameter has
been changed to Generate Report to reflect the
new HTML format for graphical output. The
HTML file does not automatically display.
Double-click on the HTML entry in the Results
window, to open the HTML file in the default
Internet browser. Right-click on the Messages
entry in the Results window and select View to
display the results in a Message dialog box.
These changes make it easier to incorporate
analysis results into reports.

High Low Clustering

Spatial Autocorrelation

Modeling Spatial Relationships toolset Ordinary_Least_Squares Summary reports
and diagnostics
are written to the
Results window.
Right-click on the
Messages entry
and select View
to display the
results in a
Message dialog
box. Results can
also be copied
and pasted into
other text
documents.

Geographically_Weighted_Regression

Utilities toolset Calculate_Distance_Band_from_Neighbor_Count Tool results are
written to the
Results window.
Right-click on the
Messages entry
and select View
to display the
results in a
Message dialog
box.

New tools
Toolset Tool Description

Measuring Geographic
Distributions toolset

Median
Center

Identifies the location that minimizes overall Euclidean distance
to the features in a dataset.
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What's new in ModelBuilder in ArcGIS 10
Many enhancements have been made to ModelBuilder.

• The ModelBuilder toolbar and menus have been updated.

• Undo and redo are now supported.

• Model elements now have ToolTips. You can pause your mouse cursor over any model element and
see its parameter values.

• There are new tools specifically designed for ModelBuilder. These tools fall into two basic categories:
Iterators and Model Only tools. See the next two sections for more information about these tools.

• The default spacing between elements has changed from 30 to 15.

Iterators

• Twelve new Iterators have been added to be used for iteration or for repetitive tasks in a model. Ten
of these iterators are implemented as geoprocessing tools.

• Iterators replace the series option in Model Properties available in ArcGIS versions prior to 10.

• Using an Iterator in a model disables the 9.3 Iteration options in Model Properties and sets a default
value of -1, which simply means that the model will run for unlimited times or based on the number
of inputs in an Iterator, and not on a set number.

• If a model containing an iterator is exported to a Python script, the script will not include the iteration
logic.

The new Iterators are
• For iterates over a starting and ending value by a given value. It works exactly like For in any

scripting/programming language, executing through a set number of items.

• While works exactly like While in any scripting/programming language, executing while a condition
is true.

• Iterate Feature Selection tool iterates over features in a feature class.

• Iterate Row Selection tool iterates on rows in a table.

• Iterate Field Value tool iterates over each value in a field.

• Iterate Multivalue tool takes a list of inputs and runs the model for each value.

• Iterate Datasets tool iterates over datasets in a Workspace or Feature Dataset.

• Iterate Feature Classes tool iterates over feature classes in a Workspace or Feature Dataset.

• Iterate Files tool iterates files in a folder.

• Iterate Rasters tool iterates over Rasters in a Workspace or a Raster Catalog.

• Iterate Tables tool iterates over tables in a workspace.

• Iterate Workspace tool iterates over workspaces in a folder.
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Model Only tools

Model Only tools only work in ModelBuilder and not as stand-alone tools or in scripting. There are seven
Model Only tools, of which four (Collect Values, Get Field Value, Parse Path, and Stop) have been added at
10.

• Calculate Value returns a value based on a user-specified Python expression in a tool dialog box.

• Collect Values is designed to collect the output values of an Iterator. If you are not iterating the
model, collect values can be used to convert a list to a multivalue in cases where it does not make
sense to use the single output as input to a tool like merge, append, mosaic, intersect, and union.

• Get Field Value gets the field value from any input. This tool differs from the Iterate Field Value tool,
as it gets only a single value from a field or the first value from a field of a table with many records.

• Merge Branch merges two or more logical branches into a single output.

• Parse Path parses the input into its File, Path, Name, or Extension. The output could be used as in-
line variables in the output name of other tools.

• Select Data selects an element in a parent data element. The Select Data tool is used with tools
that output a folder, geodatabase, feature dataset, or coverage. Select Data allows access to the
data stored inside, such as feature classes or tables.

• The Stop tool exits the model out of an iteration loop if the input value is set to True or False. It is
functionally similar to the While Iterator, but is useful to stop a model in the case where While
Iterator in the model and additional Iterators cannot be added.

Save dialog box has a create new toolbox button

For new models created using the ModelBuilder button, the Save dialog box now has a create new toolbox
button.

Functionality removed

The functionality to export a model to JavaScript and VBScript has been removed from ArcGIS 10.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 128



What's new in ArcGIS Server 10
ArcGIS Server 10 includes a number of improvements to performance, data access, editing, search, map
cache management, and more. Some of the highlights are listed below along with links that will lead you to
more information.

General

This section lists general changes and improvements to ArcGIS Server at version 10.

Data extraction tools

The Server toolbox has been expanded with a Data Extraction toolset. These tools help you expose
interactive data downloads, and are primarily intended to be published as ArcGIS Server geoprocessing
services. They are similar to the various "clip, zip, and ship" examples that have been documented in
previous versions of ArcGIS Server. Some of the tools can even e-mail the data to the recipient.

Increased monitoring of SOC processes

A new process, ArcSOCMon.exe, runs on each server object container (SOC) machine, monitoring the
state of the SOC processes. This increased monitoring results in faster recovery when the SOM comes
back online after unplanned downtime.

Logging offloaded to SOCs

Log files are now kept on each SOC machine by the ArcSOCMon process. Offloading the logging to the
individual SOCs is a more scalable approach than was used in previous versions, in which the SOM kept
one log file for all messages. You can use Manager or the ArcObjects Server API to generate a
chronological list of log messages compiled from all SOC machines.

Option for log file cleanup

A new property for log files allows you to specify the maximum number of logs that are allowed to exist in
your log directory. When the limit is exceeded, the server removes the oldest log. This prevents your log
directory from becoming too big.

Checks for invalid data connections

You can now optionally configure your services to be checked periodically for invalid connections when
the services sit idle. If you have configured these checks and a broken connection to ArcSDE is detected
while the service is idle, the server will repair the problem immediately. This prevents users from
encountering unresponsive services if the connection to the database is interrupted overnight or during
other periods of downtime.

Improved help search

The Search tab of the help now uses ranking logic to list the most relevant topics at the top of the results.
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Services

This section lists the new services available with ArcGIS Server 10 and some of the changes to existing
services.

Feature service added

ArcGIS Server 10 introduces feature services, which expose access to vector feature geometries and
attributes. A great benefit of feature services is the ability to expose feature editing through JavaScript,
Flex, and Silverlight applications. Feature services are published from map documents, and the source
datasets are required to reside in a single ArcSDE geodatabase.

Search service added

Search services allow you to index GIS content and folders throughout your enterprise and make them
easily findable by users. Your intranet clients can then use the updated search interface in ArcGIS
Desktop to connect to your search service and find useful content. They can then drag the results into
their maps.

Search services are most useful for scenarios where browsing to the data would be cumbersome because
of the sheer volume of the data or the distribution of the data through many folders and geodatabases.

Geometry service expanded to facilitate Web editing

The geometry service exposes a number of new methods to help with geographic feature editing. These
are especially useful in Web editing scenarios. Some of the editing widgets exposed in the Web APIs
require a reference to a geometry service for this reason. New operations include:

• Auto complete

• Convex hull

• Cut

• Densify (was not available in REST at 9.3.1)

• Difference

• Distance

• Generalize

• Intersect

• Offset

• Reshape

• Trim / Extend

• Union
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MSD-based services support Maplex, cartographic representations, and new layer
types

The map service definition (MSD) is a type of file that can be used to publish a map for fast dynamic
drawing by ArcGIS Server. MSDs support a subset of ArcGIS mapping features that is growing with each
release. ArcGIS 10 adds support for cartographic representations and the Maplex labeling engine in MSD-
based services.

These features are computationally intensive by nature and are only recommended when using MSD-
based services to create map cache tiles. However, judicious use of cartographic representations and
Maplex can contribute to an effective, visually-appealing map cache.

Several new map layer types in ArcGIS 10 are available through MSD-based services, including query
layers, parcel fabric layers, and mosaic layers. Stand-alone tables are also accessible through MSD-
based services.

Map services support time-aware layers

ArcGIS offers time-aware layers that store information about the state of a dataset over periods of time.
You can make many of your layers time aware using ArcMap. When you publish your map to ArcGIS
Server, the time-aware information is preserved and is accessible through the map service. You can use
this information to change the display of your maps or perform temporal queries.

Map services expose feature attachments

ArcGIS 10 introduces feature attachments, which is a way to upload and associate files with certain
geographic features in your map. Examples of attachments could include TXT, PDF, or image files that
contain supplemental information about the feature. When you publish your map as a service, clients can
see and download the attachments.

Clients can also upload and delete attachments if you enable the Feature Access capability on the map
service.

Map services expose symbology information

Map services now contain information about the renderers and symbology used for drawing vector
features in your map. This information is especially helpful when displaying layers in a Web client that you
might build with the ArcGIS APIs for JavaScript, Flex, or Silverlight. You can assign client-side graphics
the symbology that you retrieve from the map service, instead of fabricating your own symbology for the
graphics.

Map services expose subtypes and domains

Enforcing data integrity when working with map services is now easier because of added support for
subtypes and domains. Subtypes and domains offer a way to organize your data so that certain
operations, such as editing, become more efficient while the integrity of the attributes is maintained. For
instance, if you are performing a Web editing session on a county zoning infrastructure database, you
could choose the desired subtype, such as City, then choose from the appropriate domain, such as
Residential, Commercial, or Industrial. The domain description Residential is available for display instead
of the coded value R.
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An overview of subtypes
An overview of attribute domains

Map services expose relates and stand-alone tables

Map services now expose information about relates and stand-alone tables. Relates simply define a
relationship between two tables without appending the associated data in each table. In many cases, the
relates point toward stand-alone tables, which lack geometry but often contain valuable attribute
information. For example, if you published a map that contained relates between city parcels and a stand-
alone table of parcel owners, you could utilize search, query, and identify tasks to return the owners and
locations of the parcels.

For a complete list of supported stand-alone table types, see the data types section of the help topic
Supported functionality in MSD-based map services.

Map services support querying of raster fields

Map services now support querying of raster fields. Suppose you maintain a vector dataset of street lights
in your city. On this dataset, you've created a field of type Raster to store a picture for each street light.
Through the map service's new method QueryRasterValue, you can retrieve the picture to display in your
client.

Maximum record count property increased and exposed in ArcCatalog and Manager

The default number of records ArcGIS Server allows a service to return in response to a query has been
raised to 1,000. Previously, the only way to change this number was to manually edit the service
configuration file. Now, this property is exposed in the service properties in ArcCatalog and Manager.

Serve mosaic datasets

Mosaic datasets are a new dataset that can be served as an image service or inside a globe or map
service. There are also additional capabilities to query and interact with image services derived from
mosaic datasets.

Querying an image service layer
Previewing each raster dataset in an image service
Downloading selected raster datasets from image services

Enhanced image service parameters

The image service properties page now allows you to control a greater number of default service
parameters. This gives you more control over the amount of data a user can request, the type of
information that can be requested, and the allowable mosaic and compression methods.

• Maximum image size per request

• Maximum number of rasters per mosaic

• Default resampling method

• Allowed compressions
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• Allowed mosaic methods

• Maximum number of records returned per request

• Metadata level

• Allowed fields

• Maximum number of downloads per request

New supported operations for image services

Images services have been expanded to allow more operations. Export Image has been improved to
allow you to specify mosaic rules and properties. Additionally, Query, Identify, and Download have been
added.

Network analysis services expose three new solvers

Three new Network Analyst solvers are exposed through the SOAP API, Web ADF, and ArcObjects APIs.
These are:

• OD cost matrix solver

• Vehicle routing problem solver

• Location-allocation solver

Geocode services support single-line address format

ArcGIS geocoding now allows users to enter an address in a single-line string such as "300 peachtree st
nw atlanta ga". This enhancement is exposed through the geocode service, including through the REST
API.

Other OGC service enhancements

Following are some ways that support for Open Geospatial Consortium (OGC) services (WMS, WFS, and
WCS) has been extended in ArcGIS Server 10.

• Specific style templates can be applied to the information returned from a WMS getfeatureinfo
request.

• Publishers can now add more CRS information to the service configuration file, which is then read
by the server and displayed as part of the "capabilities" response.

• WMS layers can now be referenced using name strings. The string must match the layer name
used in the map's table of contents. Previously, layers in WMS services published by ArcGIS
Server were only accessible through zero-based integers representing the layers' positions in the
table of contents.

• A style can now be specified in the WMS getmap request. This allows users to "dynamically" send
SLD information rather than persisting that information in an SLD file.

• When image services are based on a mosaic dataset, it is possible to access individual images
using WCS/WMS. ArcGIS allows users to enter URLs that append the base WMS URL with the
/RasterID of an individual image and get a WMS/WCS service of only that image. This enables
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access to the individual images in a large catalog. The big advantage of this is that a catalog of
the images can return separate URLs for each image. There are many use cases for this. For
example in a service of Landsat image, a user may want to have a WMS/WCS of only one image.

• WFS services now respect any aliases, definition queries, and field visibility settings from the
source MXD.

• SLD support is available for raster symbolizers.

Map caching

This section lists improvements to map caching, which is the process of pregenerating large banks of tiled
map images for rapid display of Web maps.

Compact cache storage

You can now choose to use a compact cache format that groups tiles into large bundle files instead of
storing each tile as a separate file. Compact caches consist of a smaller number of overall files and use
less space on disk than traditional exploded caches. Compact caches can be moved much more quickly
from one machine to another, which is helpful when copying caches between staging and production
environments.

Mixed mode caches

A mixed mode cache allows you to use tiles of different image formats in the same cache. This is helpful
when displaying a raster cache on top of another raster cache. You can use JPEG for the tiles in the
middle of the cache to keep your relative file size low while using PNG32 on the periphery of the cache
where part of the tile needs to be transparent.

Caches can be treated as a raster dataset

Caches can be added directly to ArcMap or ArcGlobe as a raster dataset using the Add Data button. Just
browse to the location of your cache directory on disk and add the cache like any other dataset. This
option removes the dependency of the cache on a parent map service.

Collaborative cache building tools added

New tools have been added for importing and exporting cache tiles to and from the cache directory. This
makes it easier to collaboratively build a cache among a network of organizations and departments that
are using the same tiling scheme.

Faster caching on distributed deployments of ArcGIS Server

If you have many SOC machines working on a map cache in the compact storage format, you can choose
a new option to write tiles to a local cache directory on the server. This improves performance by first
writing the tiles (in the compact .bundle format) locally, then copying the bundles into a shared cache
directory as they are completed. This approach is faster than all machines writing the tiles directly into the
shared cache directory.
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Default tile size changed to 256 x 256

The default tile size is now 256 x 256. This corresponds to the tile size used by Google Maps and Bing
Maps.

Direct drawing of map caches by ArcGIS Explorer and ArcGlobe

When you build a 2D cache with the ArcGIS Online/Google Maps/Bing Maps tiling scheme, the cache can
be drawn directly in 3D by ArcGIS Explorer and ArcGlobe at a speed faster than you would see if you
were to use a globe cache. This allows you to expose your service to ArcGIS Explorer users in 2D and 3D
mode while only maintaining one cache.

REST API

This section contains some of the highlights of new features in the REST API. Many of these changes are
accessible in the ArcGIS APIs for JavaScript, Flex, and Silverlight. For the full list of new features, see the
online What's New page for the REST API, or open the ArcGIS Services Directory and click API Reference
in the upper right corner, followed by What's New.

AMF a supported output format

The ArcGIS 10 REST API supports Action Message Format (AMF) as an output format. AMF is a binary
format that can be directly read by Flash clients. Using AMF can improve performance when interpreting
query and geoprocessing results.

Closest facility and service area network analysis support

You can now use ArcGIS Server network analysis services to perform closest facility and service area
analysis through REST.

Server object extensions available for map services in REST

Server object extensions allow you to add to the base functionality of a service through custom
ArcObjects code. Using ArcGIS 10, you can now expose your server object extension functionality
through REST. This is available for map services only. To build server object extensions, you need to
install the ArcObjects SDK.

Well-known text support for coordinate systems

Well-known text is now supported as a valid format for specifying coordinate systems. Previously,
coordinate systems could only be specified in the REST API through a numerical ID. Now you can use a
specially formatted text string to denote the coordinate system, allowing for customized properties such as
central meridian and standard parallels.

REST admin cache can be cleared programmatically

ArcGIS Server maintains a cache of service information to improve performance when using the REST
API. This cache must be cleared occasionally to detect changes such as new or deleted services. The
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REST API now provides developers a way to programmatically clear the cache, allowing for an immediate
refresh when services are updated.

Web ADFs

This section lists improvements in the Web Application Developer Framework (ADF), including
improvements to the default Web Mapping Application that you can customize with Manager.

Print task preserves either scale or extent

New options have been added to the .NET Web ADF Print task to allow the person printing the page to
choose whether to preserve the scale of the map or the extent of the map. The Print task requests a
higher-resolution version of the map for printing so it's not always possible to preserve both scale and
extent.

Deployment on Amazon EC2

ArcGIS Server is available from ESRI as an Amazon Machine Image (AMI), allowing you to deploy ArcGIS
Server in the Amazon Elastic Compute Cloud (EC2). When you deploy ArcGIS Server in the cloud, the
installation and postinstallation are done for you, taking much of the work out of the setup. You can choose
from the different virtual machine specifications available from Amazon, allowing you to pay for only the
hardware you need. Finally, when working in the cloud, you can resize your deployment in response to
demand relatively quickly.

Better integration with SharePoint

The release of ArcGIS Server 10 will be shortly followed by version 2.0 of ArcGIS Mapping for SharePoint,
which includes Web Parts that use ArcGIS Server mapping, geocoding, and geoprocessing. Version 2.0 is a
major release which will introduce the following:

• New look and feel—A new look and feel integrated with the SharePoint 2010 ribbon maximizes the
screen area available for your map.

• Geoprocessing—Geoprocessing services can be used to perform advanced spatial analysis on
layers in the Map Web Part.

• ArcGIS.com integration—A new Map Center for the Map Web part allows you to discover, open,
and save maps from ArcGIS.com.

• Geocoding enhancements—A new Locate Addresses workflow provides an easy way to geocode
addresses stored in a SharePoint list. The workflow architecture allows for automatic geocoding
when a list item is changed or added. At 2.0, users also have the option to select the best address
match candidate for each list item interactively with the Location Field, and can track the status of
candidate selection with SharePoint tasks that are automatically generated and maintained.

• Web Part connections—The 2.0 Map Web Part supports SharePoint Web Part connections. This
means that users can connect the Web Part to SharePoint's out-of-the-box list and filter Web Parts
to view and manipulate layers in the map. Also, SharePoint developers can leverage the
connections infrastructure to write custom components that display and filter map data.
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• Theming—The Map Web Part is themable. Users have the option of using their site's theme to
determine the color scheme for pop-ups and dialogs, or they can define a custom scheme.

• GeoRSS layers—The Map Web Part supports GeoRSS feeds as a data source for layers.

• Basemap gallery—Users of the Map Web Part can now switch basemaps by selecting from a
configurable basemap gallery. This gallery includes basemaps from ArcGIS.com and Bing Maps by
default, but can be configured to include any number of ArcGIS Server, ArcGIS.com, or Bing Maps
base maps.
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What's new in ArcGIS 3D Analyst 10
The ArcGIS 3D Analyst extension provides tools for creating, visualizing, and analyzing GIS data in a three-
dimensional (3D) context. ArcGIS 3D Analyst 10 brings significant improvements in 3D display performance,
3D data management, and 3D vector analysis.

Learn more about 3D Analyst
See a quick tour of 3D Analyst

Display performance enhancements

High-quality 3D data visualization and fast rendering speed are essential when it comes to interactive 3D
GIS software. The quality of the user experience depends on fast, interactive 3D display of GIS and CAD
data.

To enhance the 3D visualization user experience, the release of ArcGIS 3D Analyst 10 offers the following:
• Faster rendering of 2D map caches in ArcGlobe, reducing the need to create both 2D and 3D

caches for sharing content.

• Improved display performance of 3D text through built-in conflict detection to ensure overlapping text
is not displayed.
Learn more about displaying annotation features in ArcGlobe

• Improved display performance of textured multipatches through automatic texture management.

• Improved display performance of 3D vectors, using OpenGL stencil buffers for surface-hugging
vectors.
Learn more about digitizing 3D line graphics in ArcGlobe

• Improved memory allocation settings stored within ArcGlobe documents. This changes the
persistence of the .3dd file and allows you to configure each 3D map differently so it will consume
the right amount of memory for the layers within it.

Learn more about working with ArcGlobe and ArcScene

Creating and managing 3D data enhancements

The standard editing environment is now available inside both ArcGlobe and ArcScene, enabling the
creation and maintenance of z-aware GIS features. Editing in 3D offers the following:

• Start editing, stop editing, save edits, use undo and redo functions, and do other standard edit
management tasks in 3D. The classic snapping environment is also supported, as are precision-
creation options such as parallel, perpendicular, duplicate vertical, and absolute XYZ.

• Create and delete individual features. This includes the creation and storage of vertical lines in the
geodatabase and shapefiles.

• Move, rotate, scale, and replace feature geometry (higher-level geometry edits to features). This
includes the ability to place 3D models (for example, COLLADA files) directly into the 3D view as
new multipatch features, then move/scale/rotate them on the landscape.

There are also additional tools for creating and maintaining terrain datasets (particularly when working with
lidar data sources) and editing TIN datasets using the TIN editing toolbar in ArcMap.
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Analysis enhancements

High-quality 3D data visualization is mainstream now thanks to Google Earth and Bing Maps (Virtual Earth).
Users expect to see geospatial data in 3D. However 3D GIS users are now beginning to move beyond just
visualization. A major focus of ArcGIS 3D Analyst 10 is on analysis of 3D vector features.

New functionality includes the following:
• A suite of 3D set operators, including Intersect 3D, Union 3D, Inside 3D, Is Closed 3D, and

Difference 3D, perform geoprocessing tasks using closed multipatches and 3D features.
Learn more about working with 3D set operators

• Geoprocessing tools that expose 3D vector analysis specifically for virtual city workflows, such as
Skyline and Skyline Barrier.

• Enhancement of existing geoprocessing tools to work better with 3D. For example, the Select by
Location dialog box uses 3D distances, and multipatch objects can participate in the Line Of Sight
tool.

• Network datasets with full 3D connectivity.
Learn more about analysis on 3D network datasets

• Interactively measure in 3D using the Measure tool to display distance along a surface, height of 3D
object, distance between two points in 3D, and distance from observer (that is, how far away is an
object?).

3D Analyst Geoprocessing enhancements

New geoprocessing tools in the 3D Features toolset
Geoprocessing
tool

Description

Add Z
Information

Examines each 3D shape and adds selected properties as attributes to the input feature class.
The output options vary based on the input shape type.

Construct
Sight Lines

Constructs lines between each of the observer points and each of the target features.

Feature To 3D
By Attribute

Adds a height dimension based on one or two attributes. The height (z-value) of the shape of
each feature in the input feature class is set to the value found in the user-specified height
field in that feature class.

Difference 3D Computes the geometric intersection of two volumes defined by closed multipatch features,
based upon the geometric intersection of their patches. Subtracts all the volumes of one
feature class from the other and writes the result to a new output feature class.

Inside 3D Tests each feature to determine if it falls inside a multipatch. If it falls inside a multipatch
feature, it writes an entry to a new table indicating which feature it fell within.

Intersect 3D Computes the geometric intersection of two volumes defined by closed multipatch features,
based upon the geometric intersection of their patches. Features or portions of features which
overlap in the two layers and/or feature classes will be written to the Output Feature Class.

Intersect 3D
Line With
Multipatch

Computes a geometric intersection of the input line and multipatch features, and returns the
number of points of intersection. Points (of intersection) and/or lines (resulting from input lines
being broken at intersection points) can optionally be written to output feature class(es).

Is Closed Tests each multipatch to see if it completely encloses a volume. Then adds a new field with a
flag for each multipatch feature in the input layer or feature class indicating if that feature is
closed or not.

Near 3D Determines the distance from each feature in the input features to the nearest features in the
near features, within the search radius.
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Skyline Generates a line or multipatch feature class containing the results from a skyline silhouette
analysis. The analysis is conducted from observer points above a functional or virtual surface
and will also consider features that are encountered during the analysis. When used in
conjunction with other tools, especially the Skyline Barrier tool, shadow volumes and other
such features can be created.

Skyline
Barrier

Generates a multipatch feature class representing a skyline barrier or shadow volume. The
barrier is in a sense a surface, and looks similar to a triangle fan formed by drawing a line from
the observer point to the first vertex of the skyline, then sweeping the line through all of the
vertices of the skyline. A skirt and base can optionally be added to form a closed multipatch,
giving the appearance of a solid. It is possible to create this closed multipatch so that it can
serve as a shadow volume. If the input is a silhouette (a multipatch feature class) rather than a
skyline (a polyline feature class), then the multipatch is extruded into a shadow volume.

Skyline Graph Calculates sky visibility, and optionally generates a table and a polar graph. The table and
graph represent the horizontal and vertical angles going from the observer point to each of the
vertices on the skyline.

Union 3D Computes the geometric intersection of the patches of overlapping multipatches, then
aggregates the multipatches together. How many features are created as output depends on
the tool's settings.

New geoprocessing tools in the 3D Features toolset

New geoprocessing tools in the Conversion toolset
Geoprocessing
tool

Description

LandXML To
TIN

This tool imports one or more triangulated irregular network (TIN) surfaces from a LandXML
file and writes the TIN(s) to location on disk.

Raster To
Multipoint

This tool converts a raster into a new multipoint feature class.

Terrain To
Points

This tool converts a terrain dataset into a new point or multipoint feature class.

New geoprocessing tools in the Conversion toolset

New geoprocessing tools in the Functional Surface toolset
Geoprocessing
tool

Description

Add Surface
Information

Add Surface Information uses a surface to interpolate heights for features, converting them to
3D in the background, calculates 3D properties for these features, then writes the property
values as attributes to the input feature class. The output z information options vary depending
on shape type of the input feature class.

New geoprocessing tools in the Functional Surface toolset

New geoprocessing tools in the Terrain and TIN Surface toolset
Geoprocessing
tool

Description

Locate
Outliers

Locates points which appear to be anomalies when compared to a surface. These points
represent points that may be blunders and may need to be eliminated from the creation of the
surface.

Surface
Aspect

This tool extracts aspect information from an input TIN or terrain dataset into an output feature
class. It produces a polygon feature class whose polygons are categorized by the input
surface triangle aspect values.

Surface
Contour

Creates a feature class containing a set of contours generated from a terrain dataset or TIN
surface. The output feature class is 2D and contains an attribute with contour values.

Surface
Difference

This tool calculates the volumetric difference between two triangulated irregular networks
(TIN), or terrain datasets.
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Surface Slope Extracts slope information from an input TIN or terrain dataset into an output feature class.

New geoprocessing tools in the Terrain and TIN Surface toolset

New geoprocessing tools in the Terrain Management toolset
Geoprocessing tool Description

Append Terrain Points Adds points or multipoints to a terrain dataset.

Change Terrain
Resolution Bounds

Changes the pyramid level resolution bounds for a given feature class contributing to
the surface of the terrain dataset.

Delete Terrain Points Deletes points from a terrain dataset within an area of interest from one or more
feature classes.

Replace Terrain Points Adds points and multipoints to the collection of data used by the terrain dataset,
replacing data that had previously been used.

New geoprocessing tools in the Terrain Management toolset

New geoprocessing tools in the TIN Management toolset
Geoprocessing
tool

Description

Copy TIN This tool copies a triangulated irregular network (TIN) in a specified version to another
location.

New geoprocessing tools in the TIN Management toolset

Enhanced 3D Analyst geoprocessing tools

Conversion toolset

• The Point File Information tool has a new summarize by class code option when generating a
new output feature class containing statistical information about one or more point files.

• The LAS to Multipoint tool has added support for LAS version 1.2 file format.

Functional Surface toolset

• The Line Of Sight tool has included support for multipatches when conducting a line-of-sight
analysis.

• The Interpolate Shape tool has new conflation options when conducting analysis.

Terrain and TIN Surface toolset

• The Interpolate Polygon To Multipatch tool now supports terrain datasets.

• The Polygon Volume tool now supports terrain datasets.

• The Extrude Between tool now supports points in addition to lines and polygons.

Deprecated 3D Analyst geoprocessing tools

The following tools have been deprecated, and their functionality has been added to new tools as
indicated here:

• Surface Spot—Functionality has been added to the Add Surface Information tool.
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• Surface Length—Functionality has been added to the Add Surface Information tool.

• TIN Contour—Functionality has been added to the Surface Contour tool.

• TIN Polygon Volume—Functionality has been added to the Polygon Volume tool.

• TIN Aspect—Functionality has been added to the Surface Aspect tool.

• TIN Slope—Functionality has been added to the Surface Slope tool.

• TIN Difference—Functionality has been added to the Surface Difference tool.

• Add Terrain Points—Functionality has been added to the Append Terrain Points tool.

• Remove Terrain Points—Functionality has been added to the Delete Terrain Points tool.

Terrain dataset and TIN enhancements

Terrain dataset

In ArcGIS 3D Analyst 10, you can more easily interact with, manage, and visualize your terrain datasets.
The major changes include the following:

• A tighter integration with lidar source points and their attributes. For example, the added ability to
display and analyze lidar points as attributes, or using the Point To Raster geoprocessing tool to
generate an intensity image.

• Additional tools for finding and eliminating data errors. For example, Locate Outliers will determine
which lidar points may be anomalies in the data so that they can be removed from the terrain
surface.

• The ability to run analytic operators directly on terrain datasets. These operators include both new
and improved geoprocessing tools specific to surface analysis, such as Surface Difference,
Surface Contour, and Line Of Sight tools.

• Added support to import layer symbology for terrain datasets.

• Improved display options for terrain datasets including new contour and point symbology
renderers such as Contour with the same symbol, Terrain point attribute grouped with unique
symbol, Terrain point attribute with graduated color ramp, and Terrain point elevation with
graduated color ramp.

• New profile options for terrain points: If your terrain is symbolized with points, you can conduct a
profile graph analysis from the symbolized nodes of the terrain dataset surface.

• Added support to reset elevation range classes based on current display extent: Now when you
zoom to an area of interest of the same elevation range class of your legend, you can redefine the
class breaks using the context menu so that you get the full range of colors for that area.

• Added support for anchor points: These are critical points such as control points or navigation
hazards, and they will not be thinned from higher pyramid levels.

• Terrain overviews have been optimized to allow large terrain datasets to be opened and viewed
more quickly.
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TIN dataset

New and improved functionality for TIN datasets at ArcGIS 10 includes the following:
• Additional support for: constrained Delaunay triangulations, ArcGIS spatial reference, edge tag

persistence, and node source persistence.

• Added support to import layer symbology for TIN surfaces.

• Improved display options for TIN surfaces including a new TIN contour renderer called Contour
with the same symbol.

• Added support to reset elevation range classes based on current display extent. As with terrains,
when zooming to a TIN area of interest of the same elevation range class of your legend, you can
redefine the class breaks using the context menu so that you get the full range of colors for that
area.

Other 3D Analyst enhancements

• Point feature symbology by size and full 3D rotation can be driven directly by feature attributes.

• Ability to create graphs in ArcGlobe and ArcScene.

• Video layers: Prior to ArcGIS 3D Analyst 10, the video layer type did not exist. Now you can
successfully drape georeferenced, full-motion video layers on the surface of ArcGlobe. The video is
not shown in a separate window but actually draped on the surface.

• Animation: The exporting experience has been expanded to allow users to export sequential frames
to a folder, which can be converted into a single video file as a second process (engine service).
See What's New in Animation at 10.

• Added support to visualize temporal data using a simple time slider so you can see patterns or
trends emerge over time. Layers with supported time data can be time enabled using the Layer
Properties dialog box.
Learn more about What's new with Time in ArcGIS at 10

• The navigation model has been redesigned, which simplifies the experience navigating around the
3D view.

• Styles: 3D styles have been updated to have better names and description tags, which leads to
significantly improved results when using Search from the Symbol Selection dialog box.

• Improved user experience for setting the two most common 3D properties, Base Heights and
Extrusion. It is now easier to complete these settings with built-in graphics that demonstrate the
effect of the property change being made.

• Extensive documentation on the best ways to author and interact with 3D views of GIS data. This
includes best practices and recommended workflows for creating a 3D virtual city from 2D and 3D
data, importing data from a variety of 2D and 3D sources, editing 3D data, publishing 3D data, and
consuming data such as non-ESRI formats like BIM/IFC sources (using the Data Interoperability
extension).

• The 3D Analyst toolbar commands were incompatible in geoprocessing workflows and were made
obsolete with the introduction of the geoprocessing framework. The full set of functionality, and
more, is available in the 3D Analyst geoprocessing toolbox. Also, you can customize the 3D Analyst
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toolbar by dragging and dropping geoprocessing tools of choice onto it using the Customize dialog
box.

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcGIS Geostatistical Analyst 10
The ArcGIS Geostatistical Analyst extension provides a broad range of powerful spatial modeling and analysis
capabilities. With version 10, Geostatistical Analyst provides improvements in performance and new tools.

New geoprocessing tools

There are 11 new geoprocessing tools for Geostatistical Analyst in ArcGIS 10.

Of these tools, 4 are new functionality, and the remaining 7 were previously only available through the
Geostatistical Wizard or from the Geostatistical Analyst toolbar.

Diffusion Interpolation With Barriers

Diffusion Interpolation With Barriers uses a kernel that is based on the heat equation and allows you to
use a combination of raster and feature datasets to act as barriers.

Kernel Interpolation With Barriers

Kernel Interpolation With Barriers is a moving window predictor that uses the shortest distance between
points. The illustration below shows the paths from the data locations (black circles) to the location where
a prediction (red square) is required.

Global Polynomial Interpolation

Global Polynomial Interpolation is like taking a piece of paper and fitting it between the raised points
(raised to the height of value). It is also often referred to as Trend Surface Analysis.

Local Polynomial Interpolation

Local Polynomial Interpolation fits many polynomials, each within specified overlapping neighborhoods.
New functionality for this tool includes the ability to create a Prediction Standard Error surface and also
the inclusion of optimization and diagnostic routines.

IDW

IDW interpolation explicitly implements the assumption that things that are close to one another are more
alike than those that are farther apart. It weights the points closer to the prediction location greater than
those farther away—hence, the name inverse distance weighted.

Radial Basis Functions

Radial Basis Functions methods are a series of exact interpolation techniques; that is, the surface must
go through each measured sample value.

Create Spatially Balanced Points

Create Spatially Balanced Points generates a set of sample points based on a priori inclusion
probabilities. The resulting sample design is spatially balanced, meaning that the spatial independence
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between samples is maximized, making the design more efficient than sampling the study area at
random.

Densify Sampling Network

Densify Sampling Network is based on a predefined geostatistical kriging layer. It uses, inter alia, the
Standard Error of Prediction surface, to determine where new locations are required or which can be
removed.

Extract Values To Table

Extract Values to Table extracts the cell values from a set of rasters, based on a point or polygon feature
class, to a table. If a point feature class is used, the output table has a record for each point and each
raster that has data. Polygonal data is treated as point data; the cell center of the input rasters determines
the number of points and is used to decide whether the cell is contained within the polygon or not. This
tool can be used to further analyze the results from the Gaussian Geostatistical Simulations tool.

Cross Validation

Cross Validation uses the idea of removing one data location and predicting the associated data using the
data at the rest of the locations, then repeating this for the remaining locations. In this way, you can
compare the predicted value to the observed value and obtain useful information about some of your
decisions on the model.

Subset Features

Subset Features employs one of the most rigorous ways to assess the quality of an output surface by
comparing the predicted values with those measured in the field. One solution is to divide the original
dataset into two parts. One part can be used to model the spatial structure and produce a surface, and the
other part can be used to compare and validate the output surface.

Improvements to the Wizard

The Geostatistical Wizard is a dynamic set of pages that are designed to guide you through the process of
constructing and evaluating the performance of an interpolation model.

Resizable windows

• The overall window can be resized.

• Individual panels can be resized.

New dialog box layout and functionality

• Many of the model parameters can be optimized using cross validation.

• Parameter help is available on the dialog box and from the compiled help when additional help is
required.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 146

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//0031000000m0000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//0031000000pt000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00300000000z000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00310000009m000000


Geostatistical Analyst Wizard

Visualization of the semivariogram

• Views include the original binned values, one averaged value per bin, and a smoothed line that
shows the data correlation in different directions.

Surface Preview

• The surface preview is changed so that the dataset preview and the surface preview can be
turned on and off.

New Interpolation Methods

• Diffusion Interpolation With Barriers and Kernel Interpolation With Barriers are two new
interpolation methods available in the Wizard and also as individual geoprocessing tools. The
illustration below is of silt depth in a lake, and the boundary of the lake constrains the searching
neighborhood.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 147



Example of interpolation methods in the wizard

Local Polynomial Interpolation is enhanced to include inter alia

• Prediction standard errors indicate the uncertainty associated with the value predicted for each
location.

• Condition numbers shows variation in the numerical model stability and provides additional
information on the prediction uncertainty, since the prediction standard error surface is created
assuming that the model is correct, so that there is no reason for the model instability.

• Optimize Model modifies the Bandwidth, Spatial Condition Number, and Neighborhood values;
then the cross validation statistics are used to optimize the model.

Further enhancements

A new Conditioning measurement error field

A new Conditioning measurement error field is added to the Gaussian Geostatistical Simulations tool. It is
used when a constant measurement error for all input data can be specified in the input semivariogram
model. However, if the measurement error values are not the same at each sampling location, they can
be specified using this field.

Large dataset handling

• Some of the interpolation methods can now manage very large input datasets.

• IDW with roughly 2 billion input points (contained in more than 400,000 multipoints) produced an
output raster of 250 by 250 columns and rows in about 20 hours.

New and updated help

For example, A quick tour of Geostatistical Analyst has been added.

New tutorials

Introduction to the ArcGIS Geostatistical Analyst Tutorial has been updated.
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Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in Maplex for ArcGIS 10
General

Read-only support

Read-only support for documents that use Maplex has been added at ArcGIS 10. Read-only map
documents retain all the rich Maplex label properties without reverting to the ESRI standard label engine
when opened on a machine without the Maplex extension.

Learn more about the new read-only support

Maplex supported in optimized map services

Maplex labeling is now supported in optimized map services. Maplex support in optimized map services is
primarily intended for cached map services. Maps using Maplex can now benefit from the increased
performance from the drawing engine used by optimized map services.

Label Placement options

Repeat label parameter

The Repeat label parameter has been expanded to allow you to repeat a label within the same polygon.
This is useful for geology and soil maps or other maps where polygons often have many fingers, inlets, or
tributaries.

Learn more about the Repeat label parameter

Boundary Placement style

Options have been added to the Boundary Placement style to support labeling polygons along the side
of a boundary that does not have a polygon directly opposite. When labeling these boundaries, the label
can be placed adjacent to the polygon boundary by using the Allow single sided boundary labeling
option or centered on the linear boundary by using the Centered position on line option along with the
Allow single sided boundary labeling option. To label polygon holes with a boundary label, the Allow
boundary labeling of polygon holes option must be checked.

Learn more about the new Boundary Placement style options
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Labeling polygon holes

An additional polygon placement option has been added to support labeling polygons that contain holes.
The Avoid holes in polygons option allows you to specify whether you want to label over the top of
polygon holes or avoid them.

Learn more about the Avoid holes in polygons option

Contour Placement and River Placement styles

Improvements have been made to the overall label placement quality for both the Contour Placement
and River Placement styles.

Learn more about labeling using the Contour Placement style
Learn more about labeling using the River Placement style for line features
Learn more about labeling using the River Placement style for polygon features

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcGIS Network Analyst at 10
Location-allocation solver

Location-allocation helps you choose which facilities from a set of facilities to operate based on their
potential interaction with demand points. It can help you answer questions like the following:

• Given a set of existing fire stations, which site for a new fire station would provide the best response
times for the community?

• If a retail company has to downsize, which stores should it close to maintain the most overall
demand?

• Where should a factory be built to minimize the distance to distribution centers?

Learn more about the location-allocation solver

Point, line, and polygon barriers

Prior to ArcGIS Network Analyst 10, barriers were limited to points that restricted the entire network element
they were located on. In ArcGIS 10, you can create point, line, and polygon barriers. You can also restrict
travel through barriers or use them to temporarily change the cost of the underlying network elements.

• Point barriers: Using a restriction point barrier, you can choose to completely restrict the edge the
barrier is located on or only restrict travel through the point barrier. Alternatively, you can create an
added-cost barrier and incur a cost that you specify whenever the barrier is crossed.

• Line barriers: A restriction line barrier prohibits travel anywhere the line intersects the network. A
scaled-cost line barrier increases or decreases the underlying cost of traversing the edges it covers
by a factor that you specify.

• Polygon barriers: Like line barriers, polygon barriers restrict travel on the underlying edges or scale
them by a factor that you specify.

Learn more about barriers

Vehicle routing problem enhancements

Multiple breaks

The vehicle routing problem lets you add multiple breaks to each route. So, instead of only modeling a
driver's lunch break, you can include a morning and afternoon break as well. Moreover, there are three
break types designed to fit different break policies: time-window breaks, which are taken within a specified
period of the day (for example, 10:00 a.m. to 11:00 a.m.); max-travel-time breaks, which occur before
accumulating a specified amount of travel time; and max-work-time breaks, which occur before
accumulating a specified amount of travel and service time.

Arrive and depart delays

A new field on the routes class of the VRP, ArriveDepartDelay, allows you to avoid having multiple
vehicles stop at coincident orders.

Learn more about the vehicle routing problem
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No U-turns at network locations

Network locations, such as a stop on a route or an order on a vehicle routing problem, have a property for
curb approach, which specifies the direction from which a vehicle may arrive and depart relative to the
network location. A new option, No U-turn, was added. When this is chosen, a vehicle can approach the
network location from either direction, but when it departs, the vehicle must continue in the same direction it
was traveling when it arrived. This is especially useful when routing large vehicles that can approach the
stop from either direction but can't turn around there.

The allowed arrival and departure combinations for the No U-Turn curb
approach

Learn more about U-turn policies

Exclude restricted portions of the network when loading locations

By checking this option, which is a new property of network analysis layers, you can make sure that network
locations are only placed on traversable portions of the network. This prevents placing network locations on
elements that you can't reach due to restrictions or barriers.

Learn more about network analysis layers

New options for driving directions

The Inset Maps tab on the Directions Options dialog box has two new check boxes.

Rotate in Direction of Travel check box

Previously, the inset maps of driving directions were always oriented to the north. Now you can check this
option to orient each inset map in the direction drivers will be facing when they begin the maneuver. This
helps drivers understand maneuvers like left and right turns more quickly, since they don't have to
mentally reorient the maps.

Show Maneuver Highlight Arrow check box

Choose this option to see arrows on inset maps.

The green lines represent a route that doubles back on itself several times.
The arrow highlights one maneuver in the driving directions.
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Historical traffic

Traffic affects travel times and varies by time of day and day of week. Moreover, traffic can change the path
of the quickest route between two points. For example, if one route becomes clogged by rush-hour traffic, it
may be quicker to take an alternate path that avoids the congestion. In ArcGIS 10, network datasets are
able to model variable travel times based on historical traffic. As a result, the two analyses that support
historical traffic (route and vehicle routing problem analyses) can produce more accurate travel times and
determine the best routes for a given time of day and day of week.

Learn more about historical traffic data

Three-dimensional network datasets

Network datasets are now 3D enabled, which allows you to model and perform network analyses on interior
pathways of buildings. In the graphic below, a route connects an office on the first floor of a building to an
office on the third floor.

Using restrictions, you can perform analyses that avoid staircases for wheelchair-accessible routes or
elevators for evacuation planning.

By connecting indoor pathways with z-aware street and sidewalk features, you can answer questions like
the following:

• What floors of a high-rise building cannot be reached by a fire department within eight minutes?

• What is the shortest wheelchair-accessible route between rooms in different buildings?

Learn more about analysis on 3D network datasets

Incremental rebuilds

When you create, edit, or delete any feature that participates in a network dataset, the network needs to be
rebuilt to capture the changes. Previously, the entire network dataset would be rebuilt regardless of how
small the changes were. Now the rebuilding process only rebuilds the network in dirty areas, which are
areas immediately surrounding the edited features. This drastically reduces the time it takes to rebuild large
networks.

Note, however, that when properties of the network dataset are edited, the entire network will still be rebuilt.

Learn more about building a network dataset
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Modifying network dataset properties in ArcMap

Whenever you modify a network dataset using ArcCatalog, you need to close any ArcMap documents that
are referencing the network dataset to remove schema locks. This is still true; however, since ArcMap has
the new Catalog window, now you can use the network dataset and modify its properties from within
ArcMap. It is not necessary to open and close ArcGIS applications to modify the network anymore.

Upgrade Network geoprocessing tool

If you have a network dataset from earlier ArcGIS releases, you will need to run this tool on the network to
take advantage of the new functionality in the current release. If the network dataset is in a geodatabase,
the geodatabase must be upgraded before the network can be upgraded.

Learn more about upgrading a network dataset

Dissolve Network geoprocessing tool

The Dissolve Network geoprocessing tool creates a network dataset with fewer line features than the input
network dataset.

Network datasets with fewer line features have more efficient traversals, which results in faster network
analyses. The results of the analyses also contain fewer network elements, which also means that
generating route geometries and driving directions are faster.

Learn more about dissolving a network dataset

ArcGIS Server Network extension

Vehicle routing problem, location-allocation, and origin-destination cost matrix
support

There are now server parameter coclasses and server results coclasses, available in SOAP and the GIS
Server API, that work with the VRP, location-allocation, and OD cost matrix solvers in ArcGIS Server, to
go along with the previously supported route, closest facility, and service area solvers.

Closest facility and service area support in REST

REST endpoints were introduced for closest facility and service area solvers.

Save layer on server

You can save the results of an analysis on the server and reuse the layer in subsequent requests to build
on existing solutions.

Learn more about the ArcGIS Server Network extension

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcGIS Schematics 10
ArcGIS 10 brings big changes for Schematics. The old core of Schematics has been completely removed and
replaced by core ArcGIS functionality.

By making this architectural change, the top user complaints for Schematics have been solved.

The major changes are
• Diagrams are now stored as features.

▪ This allows the ArcMap user to apply core symbology and labeling directly to the schematic
diagram.

▪ No more hard coding in the configuration is required.

▪ The server story is simplified. In previous versions, you needed to export a schematic diagram
back as features and expose those features to the server.

• Changes have been made to Start/Stop Editing on Schematic diagrams. In the past, two users could
both edit a diagram at the same time, but the last one to hit the save button was the winner. Now when
a user starts editing, the diagram is locked to other users.

• Better management of diagrams that are related to versioned data has been implemented.
▪ End users can now easily change the version that a diagram is referencing.

▪ Administrators can bulk update diagrams to point to a different version.

• You can easily see what is new after updating a diagram.
▪ A new UpdateStatus field exists so an end user can symbolize on this field to see things that

were just added to a diagram because of an update.

• Configuration is made easier.
▪ There is a completely new user interface for the configuration tool.

▪ Due to diagrams being stored as features, there is no longer a need to configure schematic
properties to handle symbology and labeling. This greatly reduces the initial configuration and
implementation time.

• There is a new algorithm for Geo-Compression. This is useful in situations where items on the diagram
are very far apart in the real world. You want to try to maintain relative position between things
(North–South, East–West) but squeeze everything toward the center to bring more clarity and allow
plotting on a smaller piece of paper.

• Several rules allow using Attributes now. An example is the Route Node Reduction rule. Previously, if
you wanted to only reduce network junctions where the street name on both sides of the junction was
the same, you had to code a custom rule. In ArcGIS 10, you just use the By Attribute option, and no
coding is required.

• Hierarchical layouts can have multiple roots. In ArcGIS 10, you can set more than one node to be the
root of a hierarchical tree.

Related Topics
A quick tour of what's new in ArcGIS 10

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 156



What's new in ArcGIS Spatial Analyst 10
The ArcGIS Spatial Analyst extension provides a broad range of powerful spatial modeling and analysis
capabilities. With ArcGIS 10, Spatial Analyst provides improvements in performance and new tools.

Learn more about Spatial Analyst
A quick tour of Spatial Analyst

New geoprocessing tools

Extraction

The new Extract Multi Values to Points tool allows you to extract values from several input rasters,
including multiband raster, based on a set of input points. The respective raster values are added to the
input feature class as attributes, and you have the option to provide the output name. The similar Extract
Values To Points tool available prior to ArcGIS 10 only extracts values from one raster at a time and
creates a new output feature class.

Multivariate

A new multivariate analysis tool, Iso Cluster Unsupervised Classification, is introduced for the purpose of
performing unsupervised classification.

Overlay

Two new tools for performing overlay analysis for multi criteria decision making using fuzzy logic are
Fuzzy Membership and Fuzzy Overlay. Fuzzy logic is based on set theory and is an alternative to the
Weighted Overlay and Weighted Sum methods currently available in Spatial Analyst, but all approaches
are particularly well suited to perform suitability modeling.

As in most overlay analyses, the significant layers are reclassed or transformed into a common scale,
then added together or combined to identify the optimal locations for the phenomena being studied.

The Fuzzy Membership tool is used to scale (reclassify or transform) the input data into membership
values ranging from 0 to 1 using a specified fuzzy function. The membership values represent subjectively
defined degree of belonging to a set, where values that are closer to 1 are deemed as being more
suitable.

The Fuzzy Overlay tool is used to combine two or more fuzzy membership results using fuzzy operators
to create, for example, an output suitability raster dataset. The tool identifies those locations that are most
likely to belong to the most preferred combination of sets; in the case of a suitability model, being the most
suitable.

Raster Calculator

The new Raster Calculator tool is designed to replace both the previous Raster Calculator from the
Spatial Analyst toolbar and the Single Output Map Algebra tool. The new Raster Calculator executes Map
Algebra expressions using Python syntax. When used in ModelBuilder, the Raster Calculator supports
variables in the expression.
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Zonal

The new Zonal Histogram tool is a replacement for the original functionality from the Spatial Analyst
toolbar. The new tool allows you more control over the output and easy inclusion into your geoprocessing
workflows.

The Zonal Statistics as Table tool was updated with a new parameter to give you more control over which
statistics types are to be calculated.

Map Algebra

At ArcGIS 10, Map Algebra has been seamlessly integrated into the Python environment, providing you with
a more powerful analysis and modeling experience.

The Map Algebra syntax itself is basically the same, maintaining its familiarity and ease of use. In general,
any changes to the syntax allow you to take advantage of the greater capabilities afforded by Python.

Some points and benefits of integrating Map Algebra with Python are:

• It can be accessed from the integrated Python Interactive Window or through your own favorite
Python scripting Interactive Development Environment (IDE).

Full autocomplete capabilities ease the construction of expressions, particularly for complicated
ones.

• All Spatial Analyst tools are available in Map Algebra.

• It supports a comprehensive set of mathematical and logical operators.

• Individual tools and operators can be strung together to create single complex statements.

• Local (per-cell) expressions have been optimized to increase performance.

• Python classes are available for certain parameter collections, which allows autocompletion and
programmatic access to individual parameters. Following is a general list of the Spatial Analyst
classes:

▪ Neighborhoods, Remap tables, Weighted Overlay and Weighted Sum tables, Vertical and
Horizontal Factors, Topo To Raster input, and Fuzzy membership.
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Spatial Analyst Toolbar

With all the benefits provided by geoprocessing, the limited selection of functionality available in the
previous Spatial Analyst toolbar is removed at ArcGIS 10. The Create Contour and Histogram interactive
tools remain on the toolbar as before.

In place of the ArcGIS 9.3 and earlier Raster Calculator dialog box, Map Algebra expressions can be
entered into the new Raster Calculator tool or directly in the Python window.

Native Data Read/Write

Raster operations in Spatial Analyst were traditionally performed only on ESRI GRID datasets. Other
specified input or output formats were internally converted from/to GRIDs as needed. Similarly, feature data
was internally converted to the Shapefile format.

For ArcGIS 10, changes have been made to provide native format read and write capability to the Spatial
Analyst engine, allowing faster and more robust processing of your data. The reduction in processing time
and disk space consumption is made possible by avoiding the creation and internal management of
temporary scratch files. Other benefits include:

• Any field name and path length limitations imposed by the ESRI GRID format are overcome.

• The 2.1 GB shapefile size limit is avoided by writing outputs to file GDB or SDE.

• If supported by the specified input and output formats, time values in the date fields are preserved,
and nulls are treated as such and no longer being converted to zeros.

On a more technical level,

• Two new interfaces, IRasterAnalysisGlobalEnvironment and IRasterOpBase, are introduced with
ArcGIS 10 to allow the processing of raster data in Spatial Analyst using ArcObjects without the
need to convert to ESRI GRID format

• The default setting of False for IRasterAnalysisGlobalEnvironment::AvoidDataConversion ensures
that the execution path is the same as in versions of ArcGIS prior to 10.

• Setting IRasterAnalysisGlobalEnvironment::AvoidDataConversion to True ensures that all
processing is performed natively on raster and feature data.

• The IRasterOpBase interface provides a mechanism to specify the name of the output data and its
workspace before the operation is performed. This results in the output being directly written
permanently to the required format.

Performance Improvements

The Focal Statistics tool has a new algorithm that significantly improves its performance, particularly when
using large neighborhoods such as rectangular neighborhoods of 12 x 12 or larger, and circular
neighborhoods with a radius of 5 or greater. The improvements apply to all but one of the Neighborhood
types and most of the Statistics types. The other Statistics types have the same performance as before.

When non-GRID rasters and non-Shapefile feature data is used as input or output, Spatial Analyst tools
generally execute faster than they did in 9.3.1. This is a result of adding native format read and write
capabilities to the Spatial Analyst engine. See the preceding Native Data Read/Write section for more
details.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 159

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z000000z7000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z000000qs000000


Image Classification

A new toolbar for image classification is introduced in ArcGIS 10. With the Image Classification toolbar, you
can perform classification of multiband raster datasets with both interactive and geoprocessing tools.

The Image Classification toolbar is a single location to perform image classification. It provides interactive
and easy-to-use tools for creating and evaluating the training samples needed for supervised classification.
You can also access several geoprocessing tools for multivariate analysis.

This toolbar makes image classification tasks both faster and easier.

The Training Sample Manager provides the following functionalities that assist in performing classification:
• Lists of classes represented by the training samples

• Tools to manage the training samples

• Several training sample evaluation tools to create and display histograms, scatterplots, and statistics
of the classes

• Allows you to create a signature file to use for classification

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcGIS Tracking Analyst 10
Service actions

E-mail alert service action

The new e-mail alert service action allows you to automatically send a customizable e-mail message to
selected recipients when the trigger conditions of the action are met.

Learn more about the e-mail alert service action

Data modification service action

The new data modification service action allows you to modify data values in an incoming data message
using custom functions when the trigger conditions of the action are met.

Learn more about the data modification service action

Data summary service action

The new data summary service action allows you to automatically generate data summary reports for your
real-time tracking data at a configurable time interval.

Learn more about the data summary service action

Triggers

Arriving trigger

This trigger allows you to execute an action when a tracked object arrives at a location represented by a
polygon.

Learn more about the arriving trigger
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Departing trigger

This trigger allows you to execute an action when a tracked object departs from a location represented by
a polygon.

Learn more about the departing trigger

Track Crosses trigger

This trigger allows you to execute an action when a tracked object arrives at, departs from, or appears to
cross a location represented by a polygon.

Learn more about the Track Crosses trigger

Tracking layers

New storage policy for tracking layers

Tracking Analyst has a new storage policy for tracking layers at version 10. Traditionally, data from
tracking layers has been stored in memory (cached) by Tracking Analyst. The new storage policy allows
tracking layers to be stored on disk (noncached). This allows Tracking Analyst to handle large datasets
that are too large to be cached.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 162

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00630000003t000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00630000003t000000


Tracking layers in ArcGIS Server

Map documents containing tracking layers can now be published to ArcGIS Server.

Integration with new ArcGIS time framework

New functionality is added to ArcGIS Desktop to support the concept of time for an entire map. The Tracking
Analyst functionality will continue to exist independently of this new concept as it has in the past. However, if
you choose to utilize the new ArcGIS time framework to control the time in your map document, your
tracking layers will still update properly.

Learn more about temporal data management and visualization in ArcGIS

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcScan for ArcGIS 10
ArcScan provides tools that allow you to convert scanned images into vector-based feature layers. The
process of converting raster data to vector features is known as vectorization. Vectorization can be performed
manually by interactively tracing raster cells or automatically using the automatic mode.

Using feature templates with ArcScan

The main enhancement for ArcScan is the integration with the new editing experience using feature
templates, which are introduced in ArcGIS 10. Feature templates define all the information required to
create a feature: the layer where a feature will be stored, the attributes a feature is created with, and the
default tool used to create that feature. When performing interactive vectorization with ArcScan, you first
need to choose a feature template on the Create Features window. With automatic vectorization, you
choose a feature template directly on dialog boxes such as Generate Features.

Snapping with ArcScan

While ArcGIS 10 introduces new tools for snapping through the functionality on the Snapping toolbar,
ArcScan uses the classic editing snapping environment rather than the settings on the Snapping toolbar. To
perform raster snapping with ArcScan, you must enable classic snapping on the Editing Options dialog box.
Classic snapping resembles the snapping experience that was available while editing in previous releases.

When you enable classic snapping, editing tools only use the classic snapping environment. However,
georeferencing tools, the Measure tool, and other non-editing tools continue to use the snap settings on the
Snapping toolbar. Therefore, once you have completed your work with ArcScan, you should disable classic
snapping so the editing tools can take advantage of the Snapping toolbar.

Related Topics
A quick tour of what's new in ArcGIS 10
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What's new in ArcGIS Mobile 10
At the ArcGIS 10 release, ArcGIS Mobile development focuses on the following key themes:

• Improving the usability of the handheld application

• Expanding application platform support to include touch screen Microsoft Windows devices

• Opening the field applications for developers

• Simplified project management using a new application called the Mobile Project Center

Application usability improvements

At the 9.3 release, ArcGIS Mobile introduced a new, ready-to-deploy application for Windows Mobile. The
ArcGIS Mobile application is a task-driven application that can be configured to complete a variety of field
projects. In the ArcGIS 10 release, the user experience has been significantly enhanced for touch screen
access with larger, more readable text and menu options, lists that scroll using gestures, and improved
workflows that are more intuitive and flexible.

In addition, the ArcGIS 10 version of the application includes several new capabilities. The View Map task
has been enhanced with new functionality for measuring lines, areas, and features. Support for new types of
connected and disconnected basemaps has also been added.

The Collect Features task workflow has been enhanced and streamlined. GPS data collection has a
simplified user experience that provides a simple push button start and stop for averaging GPS positions
while providing the flexibility for you to view the map or GPS status while in the process of collecting
positions.

There is a new GPS Streaming method for constructing polylines and polygons that can filter positions by
distance or time interval and place the shape at a lateral offset from the actual captured location. When
collecting attributes, each field is presented in a full-page view that makes capture much easier. You can
repeat or copy attribute values from one feature to another to simplify the process, and when specifying
attributes, you are notified of required values that need to be set.

Using the Search task, you can now save your search criteria, and it will be stored with your project so that
the next time you open the project, you can simply execute your saved search.
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The Synchronize task now has options for automatically posting edits to the server. You can post changes
whenever features are collected or updated, at a set time interval or when the device is cradled.

A new task called View Field Crew enables field collaboration between field-workers. Using the Field Crew
task, you can see where other field-workers are on the map and contact them by e-mail or SMS or by calling
them directly. Combined with the field crew logging extension that maintains a log of where each field crew
member traveled each day, you can locate, track, and collaborate with other field-workers.

ArcGIS Mobile for Windows application

The ArcGIS Mobile application is now supported on Windows devices as well as Windows Mobile devices.
The Windows version has been optimized for ruggedized touch screen devices that are often mounted in a
vehicle. The Windows application contains all the feature functionality of the Windows Mobile application but
is designed specifically for the Windows form factor and in-vehicle use. Features unique to the Windows
application include an integrated touch screen keyboard, day- and nighttime skins, and the ability to adjust
the brightness of the application itself. In addition, you can dim basemap layers so that operational map
layer content stands out from basemap content, providing visual contrast between layers.

Extending the ArcGIS Mobile applications using .NET

The ArcGIS Mobile applications for Windows and Windows Mobile can be configured without any
programming. You can add or remove tasks from the application, change the behavior and capabilities of
existing tasks, and choose what map layer content is provided in the applications.

However, it may often be necessary to extend the core application functionality to fit your own business
workflows, tasks, and data. Using the applications as a framework, you can reduce the amount of custom
development you need to provide, focus on adding business-specific value, and leverage existing core GIS
application functionality at the same time.

Using the applications as a framework, you can create new tasks that are specific to your business
workflows for field data management, alter existing ESRI tasks to provide additional capabilities, or extend
the application as a whole.

What's new in ArcGIS 10

Copyright © 1995-2010 Esri. All rights reserved. 166



Simplified project management using the Mobile Project Center

The Mobile Project Center is a new application for the ArcGIS 10 release that focuses on creating and
managing field projects. Field projects define the map, tasks, and capabilities used to complete a variety of
field workflows.

At the 9.3 release, this ability to create and manage projects was embedded within the ArcGIS Server
manager application that was also used to administer the GIS server and create Web applications.

Using the Mobile Project Center, you can create field projects that are stored locally on your desktop, inside
your on-premise ArcGIS Server (.NET or Java edition), or on arcgis.com. Depending on your field workforce
deployment strategy, you can use simple file transfer, your on-premise Web server, or ESRI's cloud server
(known as arcgis.com). Each installation of ArcGIS Server on a corporate Web server includes a content
Web service and virtual directory that can store projects. The Mobile Project Center can save projects to this
Web service, and the ArcGIS Mobile field applications can query the content Web service for projects and
pull them to a device.

The Mobile Project Center lets you define the contents of your field map. The field map consists of a set of
map layers that are either operational map layers or basemap layers. At the ArcGIS 10 release, your field
project can now contain multiple operational layers or mobile services provided that their spatial references
match. This lets you isolate the list of transactional map layers by service. For example, you may want to
organize editable layers (such as observations or inspections) into one service and read-only transactional
layers (facility networks such as water valves and pipes) into a second service that can be queried but not
edited.

In addition to operational layer sources, you have a number of choices when specifying basemap layers as
well. A basemap can be composed of one of four different types of map: Street Map, cached map service,
ArcGIS.com basemaps, or ArcGIS Server Tiled Service map layers.

Street Map is a new data product for ArcGIS Mobile that includes street centerlines and points of interest
data. You can extract a portion of the dataset, copy to your mobile device, and use when disconnected in
the field.

Cached map service layers can be used in a similar fashion. You can create a cached map service,
disconnect the map cache, and copy to your mobile device for direct file read. Cached map services can
include both orthoimagery and cartographic basemaps.
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In addition to local basemaps, you can leverage connected basemaps at ArcGIS 10. These include both
ArcGIS.com basemap services and your own published tile map services.

Tasks and extensions that you create using the application framework are exposed to field projects using
the Mobile Project Center. By placing your custom task or extension in a well-known folder location,
additional capabilities and tasks will appear when creating mobile projects.

For more information regarding ArcGIS Mobile, please refer to the Mobile GIS chapter inside the
Professional Library of the Desktop Help.
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What's new for defense and intelligence in ArcGIS 10
Service Pack 1 and ArcGIS 10

Version 10 Service Pack 1

• The style files that are installed with this service pack contain new marker symbols that do the
following:

▪ Support additional affiliations for military features

▪ Better support MIL-STD-2525B Change 2

• The Military Overlay layer package and defense templates available at the ArcGIS 10 release have
been moved from the Defense Resource Center's template gallery to ArcGIS.com. In addition, new
layer packages have been added, such as the Hostile Operations layer package. New templates
have also been added, including the Topographic Basemap Template for NSG Entity Catalog Data
and the Imagery Basemap Template for Controlled Image Base (CIB) data. To view all defense
layer packages and templates released by Esri, follow these steps:

• In a Web browser, such as Internet Explorer, access ArcGIS.com at http://www.arcgis.com.

• Click the Show drop-down arrow (near the top of the window) and click All Content (the
default is to show Web content only).

• In the search text box, enter ArcGIS for Defense. All the layer packages, templates, and
basemaps produced by Esri for the defense and intelligence communities are displayed.

Version 10

ArcGIS has changed significantly in this release to better accommodate the defense and intelligence user
communities. Although the Military Analyst and MOLE extensions are still available at version 10, much of
their functionality is now native to ArcGIS. You no longer need to download, install, or learn separate
extensions to accomplish your defense and intelligence tasks in ArcGIS; you now only need to know
ArcGIS.

If you used Military Analyst and MOLE prior to version 10, review this migration document to help you learn
the new ways to do your tasks.

Below is a list of changes in ArcGIS 10 that affect the defense and intelligence communities:

• You can use feature templates to add military features (military symbology) to your map. For details,
see Adding military features to a map.

• You can download, from ArcGIS.com, predefined layer packages that contain military features. The
default military layer package for ArcGIS, MilitaryOverlay.lpk, contains feature templates for the
following military features (military symbols):

▪ All C2 military operations features in the supported specifications, such as main attack
arrows.

▪ Some units, equipment, and installations (UEI) features, such as a generic infantry platoon
unit. You can create any military feature that isn't provided as a feature template in the layer
packages available to you. For details, see Define new types of military features.
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▪ Features from other categories in the supported specifications, such as meteorological and
oceanographic (METOC), emergency management, signals intelligence, and stability
operations features.

For details on the default layer package, see The Military Overlay layer package.

• You can add geodetic features on a map by drawing them or typing their location and measurement
values. For details, see Creating geodetic features.

• Additional support for the Military Grid Reference System (MGRS) has been added, including an
MGRS locator. For details, see Support for MGRS in ArcGIS.

• Four of the new ArcGIS geoprocessing tools have a defense/intelligence focus:
▪ Bearing Distance To Line—Converts a table containing information for constructing lines to

a geodesic line feature class

▪ Table To Ellipse—Converts a table containing ellipse definitions to a feature class of
geodetic ellipses

▪ XY To Line—Converts a table containing from- and to-points (as x,y pairs) to a geodesic line
feature class

▪ Convert Coordinate Notation—Converts a table or feature class from one coordinate format
(DD, DMS, UTM, MGRS, and so on) to another coordinate format

• The Raster Type drop-down menu on the new Add Rasters To Mosaic Dataset geoprocessing
tool dialog box allows you to select a raster type designed specifically for the type of military raster
data you want to add to the mosaic dataset. The military raster types you can select are CADRG,
CIB, DTED, and NITF. Advantages of using these military raster types (selecting them in the Raster
Type drop-down menu) include these:

▪ The logic the military raster types use to add military data to a mosaic dataset is specific to
the military data type you are adding. For details on the way duplicates are handled, see
Updating mosaic datasets containing military data.

▪ The military raster types extract image metadata and write it to the mosaic dataset attribute
table. For details and a list of fields extracted for each raster type, see Supported raster
types.

• A new window, the Image Analysis window, was added to ArcMap to improve support for the
analysis and exploitation of image and raster data.

For help getting started, see Getting started with defense in ArcGIS.
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What's new for route finding in ArcGIS 10
The Find Route dialog box, which allows you to calculate point-to-point routes and driving directions in
ArcMap, is now positioned on the Tools toolbar.

It has been enhanced to support non-SDC network datasets, use the ArcGIS online routing and geocoding
services directly, and includes other useful functionality as well.

Routing Services

In addition to the SDC network datasets included with StreetMap data, the Find Route dialog box now
supports routing against shapefile and geodatabase network datasets, as well as ArcGIS Server routing
services. This allows you to solve routes using network datasets that have custom attributes and
impedances. It also gives you the ability to provide your entire organization, and others outside your
organization, with access to a routing solution by creating an ArcGIS Server routing service using any
network dataset you choose.

Learn more about network datasets
Learn more about ArcGIS Server routing services

Using ArcGIS Online

ArcGIS Online (ArcGIS.com) provides several free routing and geocoding services that users can access
dynamically over the Web. These services are available by default in the Find Route dialog box, and they
allow you to geocode your stops and calculate high-quality routes in ArcMap even if you don't have your
own data. The ArcGIS Online routing services are available in the Routing Services drop-down list on the
Options tab of the Find Route dialog box.
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The ArcGIS Online geocoding services are available in the Choose an address locator drop-down list on
the Options tab.

Other routing functionality

Impedances

Because Find Route now supports custom network datasets, it also supports routing against custom
impedances, or network costs, defined in the network dataset. Whenever an agent traverses a network
element, it is charged some amount, which is the network cost. For example, a path from one city to
another might have a network cost of 45 miles. Previously, Find Route only supported the impedances
Time and Length, but it now supports any that are defined in the network.

Learn more about impedances in the network dataset

Time windows

A time window is the period between a start and end time in which a stop should be visited by a route.
Time windows can be used to simulate a delivery scenario, where each stop has a time range within
which the delivery needs to take place, and there is a certain amount of time that needs to be spent at
each stop. If arrival does not take place at the stop within the allotted time window, a time window
violation is reported in the driving directions. Time windows are defined for individual stops on the Stop
Properties dialog box.

Learn more about time windows
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What's new for geocoding in ArcGIS 10
Geocoding engine

The geocoding engine has been redesigned to include the following new features:

• Addresses can be inputted in a single-line format.

Learn more about finding an address

• Input addresses with spatial offset and locations in latitude-longitude are supported.

Learn more about finding an address

• The number of address locator styles is reduced. Locators can be created with or without zone
information using the same locator style. Locator styles available in ArcGIS prior to version 10 are
replaced with styles designed to work with the new geocoding engine.

Learn more about address locator styles

• The new Gazetteer locator style is provided. The Single Field and Gazetteer locator styles support
flexible search and handling of names.

• Each locator style is specified in a single XML file. All geocoding properties and address parsing
grammars are defined in the file.

• Locators support Unicode characters. Customized address locator styles can be created for
geocoding international addresses.
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Geocoding toolbar

The Geocoding toolbar in ArcMap includes the new Manage Address Locators list and the Address
Input box for single-line address matching.

Learn more about finding an address with the Geocoding toolbar

Default locators

Default locators are locators that are loaded automatically to the map when you start ArcMap or open a new
map document. Default locators are available on the Geocoding toolbar and Find dialog box, and you can
use them to find addresses right away. By default, a few geocode services from ArcGIS Online and the
Military Grid Reference System (MGRS) locator are available as default locators.

Learn more about setting default locators in ArcMap

Locations tab in Find dialog box

The Locations tab in the Find dialog box replaces the previous Places and Addresses tabs in ArcGIS
9.3.1. The Locations tab supports finding locations for addresses, places, landmarks, or coordinates.
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Learn more about finding an address on Find dialog box

Menu options for creating new address locators

Address locators or composite address locators can be created by selecting New from the context menu of
any workspace. Then click either Address Locator or Composite Address Locator to open the dialog box
for creating the corresponding type of address locator.

Note: In addition to file folders and file and personal geodatabases, composite
address locators can be created in ArcSDE geodatabases with ArcGIS 10.

Geocoding geoprocessing tools

Two new geocoding tools are added to the Geocoding toolbox:

• Create Composite Address Locator tool for creating a composite locator that references multiple
address locators
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• Reverse Geocode tool for getting addresses for point locations in a feature class

Learn more about the Geocoding toolbox
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